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About This Guide
Apttus X-Author Contracts gives Legal teams the best of both worlds—the familiarity of Microsoft Word, and the 
enterprise performance of Salesforce Apttus X-Author Contracts is fully integrated with the Apttus Omni: Intelligent 
Middle Office Platform™. Apttus X-Author Contracts enables Legal to execute an entire contract lifecycle inside 
Microsoft Word while complying with Salesforce approval workflows and pulling the latest terms and clauses from 
your legal playbook. With Apttus X-Author Contracts, Legal can improve contract visibility,  and control 
and accountability, while working inside a system they already know and like.

Topic Description

What's Covered This guide walks the Contracts Administrator or Template Designer through 
the setup of the entire contract lifecycle within the scope of X-Author 
Contracts. It contains information, step-by-step instructions, and use cases 
for the features provided by X-Author Contracts.

Primary Audience Contract Negotiator
Contracts Facilitator
Legal Team
Contracts Administrator
Template Administrator
Template Designer

IT Environment Refer to the latest X-Author Contracts on Salesforce Release Notes for 
information on System Requirements and Supported Platforms.

Updates For a comprehensive list of updates to this guide for each release, see the 
What's New topic.

Other Resources Contract Management on Salesforce Administrator Guide: Refer to 
this guide when you need to configure settings for the features 
available in X-Author Contracts.
Contract Management on Salesforce Release Notes: Refer to this 
guide when you need to keep track of a dependent feature in 
Contract Management.
CPQ on Salesforce Administrator Guide: Refer to this guide when 
you need to create a proposal template using X-Author Contracts 
and need to refer CPQ terminology.

This guide describes the following tasks:

To create customized templates for generating agreements, clauses, proposals, or billing memos.
To publish templates.
To create conditional segments or clauses in a template that are generated in the agreement document if 
those criteria are met.
To check out and edit a contract, and negotiate a contract using redlining.
To send an agreement for review to one or several parties and finish the reviewing cycle by incorporating the 
changes and merging versions of the agreement.
To perform reconciliation on agreement documents and clauses.
To import third part documents, use intelligent import to map clauses and fields with Apttus library, and check 
in the document to Apttus repository.
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Before using X-Author Contracts, you must be familiar with the following:

Basic Apttus Salesforce Administration
Apttus Contract Management Administration
Apttus terms and definitions
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What's New
The following table lists changes in the documentation to support each release. 

Document Topic Description

Winter 2019 Tracking Clauses in 
your Agreement

Modified topic.

Winter 2019 Rev B Making Clauses 
Read-Only in a 
Template

Modified topic.  Added a link to the Unlocking Read-Only Clauses 
topic. 

Comparing and 
Merging Versions

Modified topic. Updated the topic for language and style changes.

Comparing 
Agreement Versions

Modified topic. Updated the topic for language and style changes.

Reconciling 
Comments on Smart 
Clauses

Modified topic. Updated the description of the topic.

Tracking Parallel 
Review Status

Modified topic. Updated the description for Completed Review 
Status.

Winter 2019 Rev A Checking in 
Agreements in FX2 
Format

Modified topic. Updated the topic with information about the 
agreement related list in which the document is stored after check 
in. 
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Document Topic Description

Winter 2019 Tracking Clauses in 
your Agreement

Modified topic.

Added a description for Original and Final action on 
checking in a clause.
Updated to add content for tracking changes to a smart field 
within a smart clause and plain-text clause.
Updated to add content for tracking clauses inserted as text.

Tracking Agreement 
Clause Activity

Removed topic. The content was not directly relevant to X-Author 
Contracts. The content is covered in the Contract Management 
Administrator Guide, in Tracking Agreement Clause Activity.

Tracking Agreement 
Clause Versions

Removed topic. The content was not directly relevant to X-Author 
Contracts. The content is covered in the Contract Management 
Administrator Guide, in Tracking Agreement Clause Activity.

Intelligent Import Modified topic. Content added for enhancement to intelligent 
import's review result feature.

Using the Playbook Modified topic. Updated to add content for new default filter 
feature in Playbook.
Added content to update the procedure.

Inserting Clause as 
Text

New topic.

Changing Field 
Format by Locale

Modified topic. Updated to remove a prerequisite that was no 
longer applicable and updated content to remove references to 
percent. 

Defining Template 
Locale

Modified topic. Updated to add content for user-defined locale 
features.

Comparing and 
Merging Versions

Modified topic. Topic restructured to only keep conceptual 
information

Comparing 
Agreement Versions

New topic. The content is copied from 'comparing and merging 
versions' topic. Has new content for compare agreements.

Merging Agreement 
Versions

New topic. Content restructured.

Checking In 
Agreements in FX2 
Format

Modified topic. Content update for enhancement to check-in 
options feature.

https://documentation.apttus.com/display/XACSFWIN19UGRES/Tracking+Clauses+in+your+Agreement
https://documentation.apttus.com/display/XACSFWIN19UGRES/Tracking+Clauses+in+your+Agreement
https://documentation.apttus.com/display/XACSFWIN19UGRES/Intelligent+Import
https://documentation.apttus.com/display/XACSFWIN19UGRES/Using+the+Playbook
https://documentation.apttus.com/display/XACSFWIN19UGRES/Inserting+Clause+as+Text
https://documentation.apttus.com/display/XACSFWIN19UGRES/Inserting+Clause+as+Text
https://documentation.apttus.com/display/XACSFWIN19UGRES/Changing+Field+Format+by+Locale
https://documentation.apttus.com/display/XACSFWIN19UGRES/Changing+Field+Format+by+Locale
https://documentation.apttus.com/display/XACSFWIN19UGRES/Defining+Template+Locale
https://documentation.apttus.com/display/XACSFWIN19UGRES/Defining+Template+Locale
https://documentation.apttus.com/display/XACSFWIN19UGRES/Comparing+and+Merging+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Comparing+and+Merging+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Comparing+Agreement+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Comparing+Agreement+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Merging+Agreement+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Merging+Agreement+Versions
https://documentation.apttus.com/display/XACSFWIN19UGRES/Checking+In+Agreements+in+FX2+Format
https://documentation.apttus.com/display/XACSFWIN19UGRES/Checking+In+Agreements+in+FX2+Format
https://documentation.apttus.com/display/XACSFWIN19UGRES/Checking+In+Agreements+in+FX2+Format
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Document Topic Description

Tracking Parallel 
Review Status

New topic.

Using the Playbook 
for Agreement 
Documents

Modified topic. Updated content for agreement protection.

Marking Fields Modified topic. Updated content for agreement protection.

Marking a Clause in 
an Agreement

Modified topic. Updated content for agreement protection.

Promoting a Marked 
Clause to the 
Playbook

Modified topic. Updated content for agreement protection.

Hiding Smart 
Boundaries

Modified topic. Updated content for agreement protection and 
updated the legacy content.

Unprotecting 
Agreement 
Documents

New topic.

Reconciling 
Comments on Smart 
Clauses

New topic.

https://documentation.apttus.com/display/XACSFWIN19UGRES/Tracking+Parallel+Review+Status
https://documentation.apttus.com/display/XACSFWIN19UGRES/Tracking+Parallel+Review+Status
https://documentation.apttus.com/display/XACSFWIN19UGRES/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Marking+Fields
https://documentation.apttus.com/display/XACSFWIN19UGRES/Marking+a+Clause+in+an+Agreement
https://documentation.apttus.com/display/XACSFWIN19UGRES/Marking+a+Clause+in+an+Agreement
https://documentation.apttus.com/display/XACSFWIN19UGRES/Promoting+a+Marked+Clause+to+the+Playbook
https://documentation.apttus.com/display/XACSFWIN19UGRES/Promoting+a+Marked+Clause+to+the+Playbook
https://documentation.apttus.com/display/XACSFWIN19UGRES/Promoting+a+Marked+Clause+to+the+Playbook
https://documentation.apttus.com/display/XACSFWIN19UGRES/Unprotecting+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Unprotecting+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Unprotecting+Agreement+Documents
https://documentation.apttus.com/display/XACSFWIN19UGRES/Reconciling+Comments+on+Smart+Clauses
https://documentation.apttus.com/display/XACSFWIN19UGRES/Reconciling+Comments+on+Smart+Clauses
https://documentation.apttus.com/display/XACSFWIN19UGRES/Reconciling+Comments+on+Smart+Clauses
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Document Topic Description

Working with Pre-
FX2 Formatted 
Templates

Creating 
New 
Agreement 
Templates 
(Pre-FX2 
Format)
Checking 
Out a 
Template
Checking In a 
Pre-Existing 
Template
Using X-
Author to 
Insert Merge 
Fields
Using X-
Author to 
Insert Line 
Item Merge 
Fields
Using X-
Author to 
Insert Smart 
Merge Fields
Support for 
Nested Child 
Level Merge 
Fields
Working with 
Clauses in 
Pre-FX2 
Format

Removed topic. For pre-FX2 topics, refer to older versions of the X-
Author Contracts User Guide.
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Document Topic Description

Working with 
Agreements in Pre-
FX2 format

Checking in 
Versions
Creating 
Offline 
Agreements
Creating 
Sections
Highlighting 
Smart Fields 
(Pre-FX2)
Tagging 
Smart Fields
Using 
Enhanced 
Redlining
Updating 
Smart Fields 
From 
Salesforce 
(Pre-FX2)

Removed topic. For pre-FX2 topics, refer to older versions of the X-
Author Contracts User Guide.

Reconciliation in 
Pre-FX2 format

Compare & 
Reconcile 
Values
Updating 
changes to 
the Apttus 
Agreement 
Record
Restore 
Smart Fields

Removed topic. For pre-FX2 topics, refer to older versions of the X-
Author Contracts User Guide.

Summer 2019 (Rev. 
B)

Salesforce Chatter 
Integration

Modified topic. Updated the topic to add prerequisites.

Summer 2019 (Rev. 
A)

Inserting Clause as 
Text

Modified topic.

Updated the topic to remove content that was no longer 
applicable.
Update the screenshot.

https://documentation.apttus.com/display/XACSFSUM19UG/Salesforce+Chatter+Integration
https://documentation.apttus.com/display/XACSFSUM19UG/Salesforce+Chatter+Integration
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Document Topic Description

Summer 2019 Sending 
Agreements for 
Parallel Review

New topic. A new feature for this release.

Comparing and 
Merging Versions

Modified topic.

Updated the topic for enhancement to the existing merge 
feature.
Updated the screenshot.
Removed the use case and moved it to a new topic.

Use Case: Merging 
a redlined MSA with 
a regenerated 
version

New topic. The content was previously part of Comparing and 
Merging Versions topic.

Swapping Clauses New topic. A new feature for this release.

Checking in 
Agreements in FX2 
Format

Modified topic.

Updated the topic for the restrict check-in feature.
Removed legacy content.

Unlocking Read-only 
Clauses

New topic. A new feature for this release.

Making Clauses 
Read-only in a 
Template

New topic. A new feature for this release.

Reconciliation Modified topic.

Updated the topic for enhancement to the existing feature.
Updated the topic to include the UI changes.

To check-in and 
reconcile smart 
clauses in a contract

Modified topic.

Renamed to Reconciling Smart Elements in an Agreement.
Updated the content for enhancement to the reconciliation 
process.

Updating Smart 
Fields from 
Salesforce FX2

Modified topic. Updated the content for the enhancement of 
Update from Salesforce.

Creating New 
Template Versions

Modified topic. Updated the content for enhancement to template 
check-in feature.

https://documentation.apttus.com/display/XACSFSUM19UG/Sending+Agreements+for+Parallel+Review
https://documentation.apttus.com/display/XACSFSUM19UG/Sending+Agreements+for+Parallel+Review
https://documentation.apttus.com/display/XACSFSUM19UG/Sending+Agreements+for+Parallel+Review
https://documentation.apttus.com/display/XACSFSUM19UG/Comparing+and+Merging+Versions
https://documentation.apttus.com/display/XACSFSUM19UG/Comparing+and+Merging+Versions
https://documentation.apttus.com/display/XACSFSUM19UG/Use+Case%3A+Merging+a+redlined+MSA+with+a+regenerated+version
https://documentation.apttus.com/display/XACSFSUM19UG/Use+Case%3A+Merging+a+redlined+MSA+with+a+regenerated+version
https://documentation.apttus.com/display/XACSFSUM19UG/Use+Case%3A+Merging+a+redlined+MSA+with+a+regenerated+version
https://documentation.apttus.com/display/XACSFSUM19UG/Use+Case%3A+Merging+a+redlined+MSA+with+a+regenerated+version
https://documentation.apttus.com/display/XACSFSUM19UG/Swapping+Clauses
https://documentation.apttus.com/display/XACSFSUM19UG/Checking+In+Agreements+in+FX2+Format
https://documentation.apttus.com/display/XACSFSUM19UG/Checking+In+Agreements+in+FX2+Format
https://documentation.apttus.com/display/XACSFSUM19UG/Checking+In+Agreements+in+FX2+Format
https://documentation.apttus.com/display/XACSFSUM19UG/Unlocking+Read-only+Clauses
https://documentation.apttus.com/display/XACSFSUM19UG/Unlocking+Read-only+Clauses
https://documentation.apttus.com/display/XACSFSUM19UG/Making+Clauses+Read-Only+in+a+Template
https://documentation.apttus.com/display/XACSFSUM19UG/Making+Clauses+Read-Only+in+a+Template
https://documentation.apttus.com/display/XACSFSUM19UG/Making+Clauses+Read-Only+in+a+Template
https://documentation.apttus.com/display/XACSFSUM19UG/Reconciliation
https://documentation.apttus.com/display/XACSFSUM19UG/Reconciling+Smart+Elements+in+an+Agreement
https://documentation.apttus.com/pages/viewpage.action?pageId=102416068
https://documentation.apttus.com/pages/viewpage.action?pageId=102416068
https://documentation.apttus.com/pages/viewpage.action?pageId=102416068
https://documentation.apttus.com/display/XACSFSUM19UG/Creating+New+Template+Versions
https://documentation.apttus.com/display/XACSFSUM19UG/Creating+New+Template+Versions
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Document Topic Description

Checking In 
Template Versions

Modified topic.

Updated the content for enhancement to template check-in 
feature.
Language and style edits.

About X-Author 
Contracts

New topic.

Using the Playbook 
for Agreement 
Documents

Modified topic. Note added for Windows update limitation.

Working with 
Clauses

Modified topic. Added clause best practices.

Troubleshooting 
Microsoft Word 
Integration Issues

New topic. This topic collates all the existing troubleshooting topics.

Troubleshooting 
Install or Login Error 
Messages

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Troubleshooting 
Missing Add-In

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Troubleshooting 
Component 
Installation

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Enabling X-Author 
Contracts Add-in

Removed topic. Already covered in Troubleshooting Microsoft 
Word Integration Issues.

Microsoft Windows 
Text Size Support

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Troubleshooting 
Documentation 
Generation Error 
Messages

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Extracting MSI Files 
from an EXE Installer

Removed topic. Moved under Troubleshooting Microsoft Word 
Integration Issues.

Tasks and Events Removed topic. No longer relevant.

Inserting Clause as 
Text

Modified topic. Older screenshot removed.

https://documentation.apttus.com/display/XACSFSUM19UG/Checking+In+Template+Versions
https://documentation.apttus.com/display/XACSFSUM19UG/Checking+In+Template+Versions
https://documentation.apttus.com/display/XACSFSUM19UG/About+X-Author+Contracts
https://documentation.apttus.com/display/XACSFSUM19UG/About+X-Author+Contracts
https://documentation.apttus.com/display/XACSFSUM19UG/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFSUM19UG/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFSUM19UG/Using+the+Playbook+for+Agreement+Documents
https://documentation.apttus.com/display/XACSFSUM19UG/Working+with+Clauses
https://documentation.apttus.com/display/XACSFSUM19UG/Working+with+Clauses
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Troubleshooting+Microsoft+Word+Integration+Issues
https://documentation.apttus.com/display/XACSFSUM19UG/Inserting+Clause+as+Text
https://documentation.apttus.com/display/XACSFSUM19UG/Inserting+Clause+as+Text
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Document Topic Description

Updating Fields from 
Salesforce (FX2)

Modified topic. Topic renamed and content updated for support on 
read-only clause.

Spring 2019 Regenerating an 
Agreement 
Document

New topic. A new feature for this release.

Inserting Clauses 
with Merge and 
Smart Fields

Modified topic.

Updated the topic for language and style changes.
Updated the screenshot.
Added the best practices tip.

Troubleshooting 
Missing Add-In

Modified topic. Updated the topic for language and style changes.

Winter 2018 Inserting Clause as 
Text

New topic. A new feature for this release.

Intelligent Import New topic. A new feature for this release.

Summer 2018 Deleting Smart 
Elements

New topic. A new feature for this release.

Syncing Clause 
Edits

Modified topic. Updated the topic to add information about the new 
sync smart clause content feature.

Comparing and 
Merging Versions

Modified topic. Added more information about the difference 
between compare feature and merge feature.

Managing 
Agreements

Modified topic. Updated the topic to reflect the current feature 
name in the product. Previously the topic was named Managing 
Versions.

Installation 
Components

Removed topic. The installation components are covered in the 
System Requirements and Supported Platforms section in the X-
Author Contracts on Salesforce Summer 2018 Release Notes.

Installation Overview Removed topic. The 'Installation Overview' topic is covered in the 
Setting Up X-Author Contracts section.

Installing X-Author 
Contracts

Modified topic. Updated the prerequisites and updated the legacy 
content.

Post Installation 
Configuration

Modified topic. Renamed the topic and updated it to make the 
content current with the latest version of X-Author Contracts.

https://documentation.apttus.com/pages/viewpage.action?pageId=102416068
https://documentation.apttus.com/pages/viewpage.action?pageId=102416068
https://documentation.apttus.com/display/XACSFSPR19UG/Regenerating+an+Agreement+Document
https://documentation.apttus.com/display/XACSFSPR19UG/Regenerating+an+Agreement+Document
https://documentation.apttus.com/display/XACSFSPR19UG/Regenerating+an+Agreement+Document
https://documentation.apttus.com/display/XACSFSPR19UG/Inserting+Clauses+with+Merge+and+Smart+Fields
https://documentation.apttus.com/display/XACSFSPR19UG/Inserting+Clauses+with+Merge+and+Smart+Fields
https://documentation.apttus.com/display/XACSFSPR19UG/Inserting+Clauses+with+Merge+and+Smart+Fields
https://documentation.apttus.com/display/XACSFSPR19UG/Troubleshooting+Missing+Add-In
https://documentation.apttus.com/display/XACSFSPR19UG/Troubleshooting+Missing+Add-In
https://documentation.apttus.com/display/XACSFWIN18UG/Inserting+Clause+as+Text
https://documentation.apttus.com/display/XACSFWIN18UG/Inserting+Clause+as+Text
https://documentation.apttus.com/display/XACSFWIN18UG/Intelligent+Import
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Document Topic Description

Enabling Proxy 
Authentication

Modified topic. Updated the topic with details about configuring 
proxy settings and added a new screenshot to make the content 
current with the latest version of X-Author Contracts.

Check-In for 
Templates: Auto 
Publishing and 
Refresh Features

Renamed to Refreshing Clauses in a Template.

Modified Topic. Updated the topic to remove outdated legacy 
content.

Publish and Auto 
Publish Templates 
from X-Author 
Templates

Renamed to Publishing and Auto Publishing Templates.

Modified topic. Updated the topic to remove outdated legacy 
content.

Mark Clause Menu 
in X-Author 
Templates

Renamed to Marking Clauses in Templates.

Modified topic. Updated the topic to include tasks for marking and 
unmarking a clause

To mark a clause in 
a template

Removed topic. Merged with Marking Clauses in Templates.

To unmark a clause 
in a template

Removed topic. Merged with Marking Clauses in Templates.

Checking Out 
Versions

Renamed to Checking Out Agreements.

Modified topic. Updated the topic to remove outdated legacy 
content.

Checking In 
Versions in FX2 
format

Renamed to Checking In Agreements in FX2 Format

Deleting Clauses 
from an Agreement 
Record

Modified topic. Updated the topic to remove outdated screenshots.
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About X-Author Contracts
X-Author Contracts is a Microsoft Word add-in that lets you work on contracts and contract templates from X-Author 
Contracts. The X-Author Contracts Add-In helps contract administrators and/or legal users to streamline the process 
of creating and maintaining contracts and associated contract and clause templates. Using X-Author Contracts, 
contract administrators can manage complex negotiation cycles with clause and contract templates easily.

X-Author Contracts provides support for versioning of agreements, where contract administrators can save redlined, 
clean, and final versions of an agreement in a Microsoft Word document opened either from Salesforce or locally. 
When saving final versions, you can also reconcile any terms that might have changed during the negotiation process. 
You can manage Contract and Clause templates, including the ability to maintain template versions, insert, save as, 
and replace them to and from Apttus. Finally, users can compare two versions of a contract and also merge versions 
into one agreement document.

X-Author Contracts also provides support for creating conditional text within a contract or clause template. This 
allows contract administrators to create sophisticated conditional clauses that can include or exclude certain text or 
clauses depending on how a conditional expression containing valid agreement related merge fields or FX2 fields is 
evaluated.

Apttus X-Author Contracts allows a user to perform the following tasks:

Agreements
Create or update an agreement
Check-in as a redlined, clean, or final version of an agreement
Check-out an agreement
Update the current version of an agreement
Open agreements in Contract Management
Lock agreement documents for editing
Hide smart boundaries
Clauses

Playbook
Insert clauses at the bookmark positions
Insert smart clauses
Insert merge clauses
Swap clauses

Unlock read-only clauses
Mark clauses
Promote marked clauses to the playbook
Accept or reject clause changes from the control panel

Fields
Validate fields
Mark fields
Highlight fields
Update smart field values from Salesforce
Accept or reject field changes from the control panel
Delete fields from the control panel

Compare and merge agreements
Regenerate with redlines
Associate term exceptions
Mark an agreement as private
Send an agreement for review from Outlook
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Send an agreement for parallel review
Track and manage review cycle
Work with offline agreements

Create offline agreements
Import third-party papers as agreements
Intelligent import

Reconciliation
Preview reconcile
Reconcile smart fields, smart clauses, and repeat-tables

Templates
Create, update, and activate non-versioned templates
Create, update, and activate versioned templates
Check-in templates
Check-out templates
Clone templates
Open templates in Contract Management
Lock or unlock templates
Fields

Insert merge fields
Make fields smart
Make fields read-only

Clauses
Playbook
Make clauses smart
Make clauses read-only
Mark clause
Refresh clause
Insert clauses as a bookmark

Conditionals
Create conditional segments
Create conditional rows and columns in a table

Insert, update, or delete dynamic segments

Key Terminology
It is important to understand how terms are used when working with Apttus X-Author Contracts.

Term Definition

Agreements 
/ Contracts

A contract (or an agreement) is an arrangement with specific terms, enacted between two or more 
entities, in which there is a promise to perform something in return for valuable consideration or 
benefit.

Clauses Modular blocks of text that are used repeatedly. By adding these blocks to a library called a 
playbook, they can be reused continuously in multiple documents.

Document 
Assembly 
Ruleset

Document Assembly Rulesets enable you to preconfigure filter rules that drive a sequence of 
prescribed dynamic clause or attachment insertions in a generated document.
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Term Definition

Document 
Lock/ 
Unlock

Locking a document prevents others from editing the document and checking in a new version at 
the same time you are working on it. Lock or Unlock (toggle) button is available on the X-Author 
Contracts or X-Author Templates ribbon.

Documents The dynamically generated output from the merging of an agreement record’s data in the CRM with 
the static text of a template.

Dynamic 
Segments

Chunks of content that can be dynamically populated in the agreement, at the time of agreement 
generation, based on document assembly rulesets. The dynamic segments can contain content 
from clause template or attachments.

Merge Fields Static fields in a template which, at the time of agreement generation, take their value from the 
corresponding field in the Agreement record.

Offline 
Agreement 
Document

A document created directly in X-Author by taking an existing Word document that was created 
outside of Contract Management and had not previously been associated with an agreement.

Playbook A repository of templates, clauses, sections, or supporting documents, which can be inserted in 
the template as inline text or smart content-controlled text.

Reconciliatio
n

Reconciliation is a process that enables changes made to smart fields in an agreement document, 
outside of the CRM/ X-Author environment, to be reconciled with the data held in the Agreement 
record in the Contract Management.

Values of smart fields and clauses can be reconciled when you check-in the agreement document 
in X-Author Contracts.

Smart Fields Editable fields with the content control property. You can change the value of a smart field in a 
generated agreement document. These values can be reconciled with the corresponding fields on 
the agreement record in the CRM.

Template Blueprints to generate a variety of document types when merged with data from quotes or 
proposals.

Term 
Exception

A stipulated condition that may need the approval to grant or prevent certain allowances in an 
agreement or proposal. X-Author enables you to associate specific clauses in an agreement or 
proposal document with an exception clause or term exception.

For example, suppose you associate an exception clause for 'Payment Terms' in an agreement 
document. If the payment term's value is changed, and if the change is not in line with the 
company’s policy (which is usually a condition mentioned in the exception clause), then the 
agreement is sent for approvals.
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Term Definition

Read-only 
Fields

Read-only fields have content control borders (similar to smart fields) but are non-editable in a 
generated agreement document. You can update the value of an Update field in an agreement 
document only by using Update from CLM.

Functionally, these fields lie between smart fields and merge fields. Read-only fields are not inline 
like merge fields and their values cannot be edited like smart fields.

X-Author 
Contracts

A Microsoft Word plug-in that enables the legal team of an organization to execute an entire 
contract lifecycle inside Microsoft Word.
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Setting Up X-Author Contracts
To use X-Author Contracts, along with installing the Microsoft Word Add-In, system administrators may need to 
configure Salesforce objects to ensure X-Author Contracts is correctly associated with Microsoft Word.

For the X-Author Contracts Add-In to work, the Apttus Contract Management package must be installed in your 
Salesforce Org. This is required so that the various dialog boxes available in X-Author Contracts can display the 
correct fields. Once this is done by your system administrator, you will be able to install the X-Author Contracts Add-
In and begin using it.

For more information, refer to Installing the X-Author Contracts Add-In.

In This Section

Before You Install
Installing X-Author Contracts
Installing the X-Author Contracts for Outlook Add-in
Post Installation Configuration
Connecting to X-Author Contracts

Before You Install
Before installation, please check that you have the following:

ApttusInstaller_<<version>>.exe for X-Author Contracts (download from the Install Center).
You must be logged into the target machine with Administrator permissions.
You must not have any instances of Microsoft Office products running.
You must be connected to the Internet.

Setting Microsoft Word Protected View Options
Microsoft Word Trust Center/Protected View options can impact your ability to see generated Agreement documents 
and should be disabled before you begin using X-Author Contracts. Clearing the Protected View settings will remove 
the ribbon displayed when you view a document. If you do not clear these settings, when you click Enable Editing, the 
generated document closes and a new blank Word document is displayed in its place.
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To set Protected View Options
Start Microsoft Word and select File > Options to display the Microsoft Word Options dialog.
From the left navigation pane, select Trust Center > Trust Center Settings > Protected View.
Clear the three Protected View options.
Click OK for each of the two dialog boxes to complete the procedure.

The next time you open a Microsoft Word document from Salesforce, no Protected View ribbon will be displayed at 
the top of the Microsoft Word window.

Installing X-Author Contracts
X-Author Contracts is a Microsoft Word Add-In that adds two new ribbons/tabs to the application: X-Author 
Contracts and X-Author Templates. The installation process creates a folder on your computer containing the files 
required to use X-Author Contracts. The folder is created either in your Program Files or Program Files(x86) directory, 
depending on which Windows Operating System version you use.

For prerequisites, refer to Before You Install.

To install the X-Author Contracts Add-In
Double-click the ApttusInstaller_<<version>>_.exe to display the InstallShield Wizard. In certain instances, a 
restart of Windows may be required. Click Yes to confirm the restart and once you log back into Windows, the 
installer should resume automatically.
Click Next to start the wizard.
On the License Agreement screen, select I accept... and then click Next. If you do not accept the terms of the 
agreement, X-Author Contracts will not be installed on your computer.
Click Install to begin the installation process. If any components need to be installed for X-Author Contracts to 
work as expected, they will be automatically detected as missing and installed automatically.
After X-Author Contracts and any required components have been installed, click Finish to close the wizard 
and complete the installation.

The X-Author Contracts and X-Author Templates ribbon tabs are available in Microsoft Word. If the ribbon tabs are 
not displayed, you may need to enable X-Author Contracts with Microsoft Word.

Installing the X-Author Contracts for Outlook Add-in
X-Author Contracts for Outlook is a Microsoft Word Add-In that adds a new X-Author Contracts ribbon to the 
application. Unless otherwise stated, the system requirements for installing this add-in are the same as for the X-
Author Contracts add-in. The installation process installs a folder on your computer containing the files required to 
use X-Author Contracts for Outlook. The folder is installed either in your Program Files or Program Files(x86) 
directory, depending on which Windows Operating System version you use.

Prerequisites

Before installation, please check that you have the following:

ApttusXAuthorContractsforOutlook_<<version>>.exe for X-Author Contracts for Outlook (download from the 
Install Center).
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You must be logged into the target machine with Administrator permissions.
You must not have any instances of Microsoft Office products running.
You must be connected to the Internet.

To install the X-Author Contracts for Outlook Add-In
Double-click the ApttusXAuthorContractsforOutlook_<<version>>.exe to display the InstallShield Wizard. In 
certain instances, a restart of Windows may be required. Click Yes to confirm the restart and once you log 
back into Windows, the installer should resume automatically.
Click Next to start the wizard.
On the License Agreement screen, select I accept... and then click Next. If you do not accept the terms of the 
agreement, X-Author Contracts for Outlook will not be installed on your computer.
Click Install to begin the installation process. If any components need to be installed for X-Author Contracts for 
Outlook to work as expected, they will be automatically detected as missing and installed automatically.
After X-Author Contracts for Outlook and any required components have been installed, click Finish to close 
the wizard and complete the installation.

The X-Author Contracts ribbon tab will now be available in Microsoft Word. If the ribbon tab is not displayed, you may 
need to register X-Author Contracts for Outlook with Microsoft Word.

Post Installation Configuration
After installing the Apttus Contract Management package, the following configuration must be completed to ensure 
you can use all of the features of X-Author Contracts:

Enabling User Profile Permissions and Attributes for Custom Objects
Enabling Permissions to Apex Classes and Visualforce Pages
Enabling Visualforce Page for Document Finder Interface

Enabling User Profile Permissions and Attributes for Custom Objects
To assign permissions to user profiles, go to Setup > Administer > Manage Users > Profiles > System Administrator.

The following permissions must be granted to user profiles.

Permission Type Navigation

Administrative 
Permissions

System > System 
Permissions

API Enabled

Custom Object 
Permissions

Apps > Object 
Settings

Create, Read, Edit, and Delete for Agreements, Agreement 
Clauses
Both Search Filters and Templates, along with at least Read 
permission for all other custom objects.

General User 
Permissions

System settings Edit Task
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For more details on how to assign permissions to user profiles, refer Profile Settings and Security in Contract 
Management on Salesforce Administrator Guide.

To be able to use merge fields with X-Author Contracts for custom objects, such as Agreements or Agreement 
Clauses, you must enable Enable Reports and Track Activities. See the following image:

Enabling Permissions to Apex Classes and Visualforce Pages
X-Author Contracts utilizes specific Apex Web Services and Visualforce page for its processing, over and above 
those used for accessing objects from other Apttus packages. The following table lists the various classes and pages 
that need to be enabled for the user profiles or permission sets that will have access to the product.

To assign permissions to the Apex Classes, go to Setup > Build > Develop > Apex Classes.

Name Namespace Type

AuthorWebService Apttus Apex Class

To assign permissions to Visualforce Pages, go to Setup > Build > Develop > Visualforce Pages > Security.

Name Namespace Type

AuthorPing Apttus Visualforce Page

BrowseAgreements Apttus Visualforce Page

BrowseGroups Apttus Visualforce Page

BrowsePeople Apttus Visualforce Page

BrowseTemplates Apttus Visualforce Page

CreateOfflineAgreement Apttus Visualforce Page

ChatterPage Apttus Visualforce Page

ChatterUserPage Apttus Visualforce Page
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Enabling Visualforce Page for Document Finder Interface
Add the following Visualforce page to all appropriate User Profiles if your version of Apttus Contract Management is 
8.4.xxx or higher to enable Document Finder features.

Go to Setup > Develop > Visualforce Pages.
Click Security next to the DocumentFinder Visualforce page entry.
Add User Profiles as required and click Save.

Connecting to X-Author Contracts
To use X-Author Contracts, you do not need to login directly via Salesforce. You can connect from the X-Author 
Contracts ribbon tab in Microsoft Word. X-Author uses Salesforce OAuth for connecting from X-Author Contracts to 
Salesforce. By using OAuth, multiple user accounts can be set up on the same computer for logging into X-Author 
Contracts. Once added, you can simply switch from one user to the other using the Manage Connections option.

You may need to change an Administration Setup > Security Controls > Session Settings > Session Timeout setting, 
as this timeout value takes precedence over OAuth and may force you to reconnect to X-Author Contracts more 
frequently.

To handle SSO (Single Sign-On) you can also use an Admin Setting to change the default token storage location. If 
you need to have storage of the session token locally for X-Author Contracts, then set the admin property 
APTS_EnableSessionTokenStorageInAuthor to True. If this setting is not available, then you can create it; otherwise, 
the session token will not be stored locally.

Connecting to Salesforce from X-Author Contracts and X-Author Templates
Connect enables users to connect to a Salesforce Production org or Salesforce Sandbox org from Microsoft Word. 
You can still create different connections if they work for different Production and Sandbox orgs.

You can connect for the first time, from either ribbon tab by clicking Connect. If you wish to connect to a 
different Salesforce org, you can click Connect again and then select Manage Connections from the drop-
down picklist. 
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To connect to X-Author Contracts or X-Author Templates
You must have Microsoft Word open.
You must have chosen either the X-Author Contracts or X-Author Templates tab from the Microsoft ribbon.

Click Connect and select Manage Connection...
In the Create a new connection section, enter the first name and last name — as they are stored in Salesforce 
— of a user and click login.salesforce.com or test.salesforce.com. The name can also be entered by using 
someone's email or another unique way of identifying a user in the system. The test.salesforce.com is 
commonly used for sandbox testing purposes.
Click Authorize to open the Salesforce login window. Enter your credentials and click Login.
If you are connecting to Salesforce via X-Author Contracts or X-Author Templates for the first time, you may 
need to click Allow to continue.

The X-Author Contracts and X-Author Templates ribbon options are enabled and you can now login to Chatter, 
Check-In and Check-Out files, or additionally display the Translate side menu when logging into Word. Once you 
have configured connections for multiple users, you can select a different connection.

To revoke a connection
There must be an existing connection.

Select Connect > Manage Connections to display the Manage Connections window. The list of users who 
have been configured for that computer is displayed with the option for the currently logged in user disabled.
Click Revoke and then click Yes in the confirmation dialog.

That user's login credentials are removed and they cannot login to X-Author Contracts until they have a new 
connection created.

http://login.salesforce.com
http://test.salesforce.com
http://test.salesforce.com
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Managing Templates
From X-Author Contracts, you can manage existing templates and create new agreement and clause templates. You 
can create, clone, and delete templates and insert merge or smart fields in the templates. The following list describes 
the topics covered under this section:

Templates Overview: FX2 vs Pre-FX2
X-Author Contracts now uses a brand new format, FX2, within the entire X-Author Contracts and X-Author Templates 
ribbon tab functionality.

The new FX2 format is a second-generation format framework within X-Author Contracts. You can create a new 
Template that uses this new framework by selecting FX2 format option in New Template page in the X-Author 
Templates ribbon tab. FX2 Templates are more advanced than the pre-existing format for Templates, which enables 
you to create a more desirable layout and design.

Template Versioning makes notable changes to Template Management and check-in/check-out screens in X-Author. 
Follow the link given below for Template Versioning if you have Template Versioning enabled in your org. If, when 
creating a new Template, you choose not to create an FX2 Template, you can select No in the New Template dialog 
box.

Creating New Agreement Templates
To get started creating a new FX2 format Agreement or Clause template in X-Author, you must first define the basic 
properties for your template. The FX2 format is the format currently recommended by Apttus for all new templates–
improvements have been made to make features more user-friendly and accessible in FX2. If you are working with the 
pre-existing format (Pre-FX2), refer to Creating New Agreement Templates (Pre-FX2 Format).

•

•

Warning

Depending on a Template's format you open up in either X-Author Contracts or X-Author Templates, 
the corresponding version of either ribbon will open to match the correct Template format. For 
example, if you check out a Template in the pre-existing Template format, the pre-existing X-Author 
Templates ribbon tab will display the usual options.
You cannot migrate Templates from the pre-existing format to the new FX2 Template format.



 If you have Template Versioning enabled in your org, the process for creating new templates is different. 
Refer to Creating New Template Versions for step-by-step instructions.
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1.
2.
3.
4.

5.

To create a new Agreement or Clause Template in X-Author Contracts
Open Microsoft Word and connect to X-Author Contracts.
Open an existing document or create a new blank document.
Click the X-Author Templates tab and then click New.
The Specify Template Attributes dialog opens. By default, the FX2 format is selected.

 
Enter values in the fields provided as described in the following table. Fields marked with an asterisk (*) are 
required.

Field Name Description

Type Choose the template type from the picklist (Agreement, Proposal, 
Clause, etc.).

Business Object Choose the business object for your template (e.g., 
Apttus__APTS_Agreement__c for Agreement). This picklist is 
dependent on the value selected for Type.

Locale Choose an option from the list to change the default locale for the 
template.
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6.

1.
2.

3.

1.

Field Name Description

Enable Formatting Select this checkbox to enable locale formatting and choose locale at 
the template and field level for this template. This allows you to define 
locale settings for Currency, Number, Percent and Date formats. To 
learn how to define locale settings for your template, refer to Defining 
Template Locale.

Click OK to confirm template properties. You can now work with your new template.

Checking Out Templates
An FX2 template in Salesforce can be checked out for editing by clicking Check-Out. Once you click Check-Out, you 
will see a browser-based form that loads the browsing of templates Visualforce page. The user can search according 
to various parameters and choose a template to open in Microsoft Word. This process is the same for the pre-existing 
Template format and the FX2 Template format.

To check out an FX2 Template
Select the X-Author Templates ribbon tab and click Check-Out.
In the Checkout window, select the template Type you want to work on and enter any other search criteria and 
click  .
The Templates list displays the templates that match the criteria.
Click Open for the required template.

The template is opened in Microsoft Word. X-Author Contracts automatically detects the document type, Template 
format - pre-existing or FX2 - and enables corresponding X-Author Templates ribbon tab. You can now work with the 
template, such as inserting merge fields, smart fields, and making content conditional. You can also use this pre-
existing template as the basis for a new template by cloning it.

Checking In Templates
After you create a new template or make changes to an existing template, you can check-in the template to save or 
update the template record on Salesforce. This section contains instructions for checking in FX2 format templates 
without Template Versioning enabled. For instructions on checking in templates with versioning, see Checking In 
Template Versions in this guide.

To check in a template
From the X-Author Templates ribbon, click Check-In. The Check-In Template dialog is displayed.
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2. Enter values into the fields provided as described in the following table (fields marked with an asterisk (*) are 
required):

Field Description

Name Enter a new name for the template.

Category Choose an option from the list to update the template category.

Subcategory Choose an option from the list to update the template subcategory.

Language Choose an option from the list to change the default language for the 
template.

Locale Choose an option from the list to change the default locale for the 
template.

Refer to the section Changing Locale at Check-In.

For templates created prior to X-Author Contracts version 
9.0.0210, changing the value of this field will not change the 
template locale and will be treated as metadata only.
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3.

Field Description

Enable Formatting Check this box to enable locale formatting at the template and field 
level for this template. This allows you to define locale settings for 
Currency, Number, Percent and Date formats. Refer to the section
Changing Locale at Check-In in the Defining Template Locale page.

Agreement Types Add or remove Agreement Types to associate with this template.

Keywords Enter comma-separated keywords to associate with the template. Can 
be used as tags with Document Finder.

Next Revision Date Identify a new date for the next revision of the template.

Term Exception Choose an option from the list to change the term exception applied 
to this template.

Is Active? Select this option to make the template active for document 
generation. You can deselect this option to make the template 
inactive/unavailable for document generation.

Description Enter a new description or modify the existing description for the 
template. Maximum of 255 characters (an error will be thrown if this 
limit is exceeded).

Guidance Enter new guidance or modify existing guidance to help users 
determine the purpose of the template.

Click Check-In. The template is checked in to Salesforce. A new Template record is created for the template if 
this is the first check-in or modified if it already exists. A DOCX copy of the template is attached to the Notes & 
Attachments related list of the Template record in Salesforce. 

To learn more about localization, refer to Defining Template Locale.

Template Control Panel
The Control Panel can be accessed from the X-Author Templates ribbon tab. The Control Panel enables you to view 
all of the fields, clauses, and sections within an FX2 Template.

To access the Control Panel, click Control Panel in the X-Author Templates ribbon tab and a side panel in Microsoft 
Word appears. The Control Panel consists of two panes: Navigation and Properties. Navigation lists all the contexts- 

After you make a template inactive and check it in, you can 
no longer work with it in X-Author Contracts. You will have to 
reactivate the template from Contract Management in 
Salesforce, since X-Author Contracts does not list inactive 
templates for checkout.
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•
•
•
•

fields, clauses, sections, and tables - in the order they appear in the Template. The properties are context aligned with 
the element selected in the Navigation pane or selected in the document (three-way alignment).

Within the Control Panel, you can view the fields, clauses, and sections that have been tagged within an FX2 
Template.

Fields - you can view the Field Name and the previous value of that field.
Clauses - you can view the Field Name and the previous value of that field.
Sections - you can view the Field Name and the previous value of that field.
Tables - you can view the Field Name and the properties of that table, e.g. Repeating Table.
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While it is open, you can move the Control Panel to other positions within Microsoft Word. By clicking and holding 
the grey bar titled, Control Panel, you can move the Control Panel to the top, left, right, or bottom of the Microsoft 
Word window.

Filtering Template Elements in the Control Panel
Because of the way fields and other X-Author elements (clauses, sections, segments) are represented in a Word 
template as form fields and content controls within the document, it is not always easy to use the Word-native search 
functionality to locate these elements. Furthermore, conditions defined for clauses, sections, tables, and segments 
within the template use fields which are not represented in the list of elements in the Control Panel.

Using a simple, text-based search, you can filter the Navigation pane to display any element which is part of your 
agreement template, or any element which contains a field or value as part of its condition expression which matches 
the text-based search. 

You can use the text search for:
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•
•
•
•
•
•
•

1.
2.

3.

•

•

•

4.

Fields
Clauses
Sections
Tables
Segments
Fields used as conditions in other elements
Values of conditions

To filter control panel elements
Check out your template and navigate to the X-Author Templates tab.
Click Control Panel under the Intelligent Document section of the ribbon to display the Control Panel and 
Template filter.

Enter your search query in the provided field.
When you perform a text-based search, keep the following rules in mind:

search for fields, clauses, and elements inside clauses, tables, sections and segments using the field or 
clause label (e.g., "Agreement Start Date")
search for field conditions within clauses, tables, sections and segments using the API name (e.g., 
"Contract_Start_Date"). Entering just the label for fields which are part of conditions/filters will not 
display the field in the list.
search for any of the above by entering partial text which matches both the label and API name (e.g., 
"Start").

Click Go or press Enter to filter the Control Panel view to match your text search.
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Filtered results are always returned in a way which displays the hierarchy of nested elements. For example, the 
field "Device Name" is used in a table ("Service Plan Device") which is nested inside a section ("Agreement 
Service Plan"). Searching for "Device Name" returns results displaying the entire hierarchy for the field shown 
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by the filter.
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Inserting Fields in a Template
Place a cursor in the appropriate section of the document where an FX2 field is going to be inserted and select Insert 
Fields from the X-Author Templates ribbon tab. The Insert Fields dialog lists the objects and associated FX2 fields. 
Keep in mind the following points while inserting fields in a template.

•
•
•

1.
2.

3.

Example: Agreement Start Date Field
In this example, we'll show how filtering works to help locate different types of references to a single field 
(Agreement Start Date) in a document.

Twice inserted into the body of the document.
Once as a field nested inside a clause.
Once as part of a conditional expression for displaying a section. (Row condition resolves to TRUE if 
Agreement Start Date >= 2/2/2016)

To find all instances of the field itself, enter the label name "Agreement Start Date."
To find the condition/filter where Agreement Start Date is used in the expression to evaluate whether 
or not to include the section, enter the API name "Contract_Start_Date."

To find all instances of Agreement Start Date either as fields or as conditions, enter text which the 
label name and the API name both share (e.g., "Start").





X-Author Contracts on Salesforce Winter 2019 User Guide

41 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

•
•

•

1.
2.

3.

You can insert a single field, multiple fields, a section, and fields as a table from the Insert Fields dialog box.
You can neither insert the fields of Related Agreement object, such as Relationship From Type and 
Relationship To Type in an agreement template nor mark these fields in a generated agreement document.
In the left column of the Insert Field page, you can select the field's object context, e.g. Agreement, and in the 
right column, you can select the object-qualified fields. The fields will be inserted in the same order you select 
them from the list.

To insert a field in a template
In the X-Author Templates tab click Insert Field.
In the Insert Field dialog box, select Agreement Fields in the left column and click the appropriate FX2 field(s) 
to insert into the agreement template. To deselect an FX2 field hold the Ctrl key and click the field name 
simultaneously.
Click Finish to insert the selected fields or click Cancel to not insert any fields into the Template.

An inserted FX2 Template field looks like

You might view multiple instances of an object, but each of these objects has either a master-detail 
relationship or a lookup relationship with the parent object. For example, you might view 2 objects named 
Agreements when you click Insert Fields. One is the actual agreement object and second is the agreement 
object for EchoSign Integration with agreements and both these objects have a lookup relationship with the 
Agreement object.
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1.
2.
3.

1.
2.
3.
4.

5.
6.

To remove fields from templates
If you want to remove an inserted field from your template, X-Author allows you to remove fields cleanly using the 
Control Panel. This feature helps you avoid errors that may arise from manually deleting content controls from the 
Word document.

From the X-Author Template ribbon, select Control Panel.
Search for and select the field from the Control Panel Navigation pane.
Right-click the field name and select Remove field.

Inserting Line Item Fields as a Table
You can insert FX2 fields for line item objects that have a Master/Detail or Lookup relationship with the agreement as 
a table in your template. The table is inserted into your template as a Repeat Table, meaning each separate line item 
record is populated as a row in the table, with field data populated in individual cells by column.

To begin, place your cursor in the desired place in your document where you want to insert a table.
Click Insert Fields to open the Insert Fields dialog.
Choose a line item object, such as Agreement Line Items. 
In the window to the right, hold Ctrl and select one or more fields from the list. Each field you select will be 
displayed as a column in the table. Fields are inserted in the order you select them from the list.
Select the check box Insert as a table.
Click Finish. A Repeat table is inserted into your template with each field displayed as a separate column.

Using Table Display Attributes to Control the Appearance of Tables in Generated 
Documents
When your agreement document table is generated, default behavior displays line item field names in a header row at 
the top of the table and the values of the fields in subsequent rows. You may determine in certain cases that you do 
not want captions displayed for the generated table, or if there is no line item data in your agreement you may want 
the table to appear empty or to not appear in the document at all.
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1.
2.
3.

You can control options for generated tables in your agreement using Table Display Attributes in the Properties pane 
in the Control Panel.

To show or hide captions for a generated table
In X-Author, navigate to X-Author Templates > Intelligent Document > Control Panel.
Click the table in Control Panel Navigation that you want to configure.
In the Properties pane under Table Display Attributes click Show Caption. A drop-down menu is displayed.
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a.

b.
4.

1.
2.
3.

To show captions at the top of the table when the document is generated, do nothing or change the 
value to True.
To hide captions at the top of the table when the document is generated, change the value to False.

Check in the new version of your template to confirm changes to the table.

To choose table formatting when no data is present 
You may often find in your agreements that no line item data exists for a table in one of your templates. You can use 
Table Display Attributes to control how the table is rendered in the generated document. 

In X-Author, navigate to X-Author Templates > Intelligent Document > Control Panel.
Click the table in Control Panel Navigation that you want to configure.
In the Properties pane under Table Display Attributes click Format. A drop-down menu is displayed.
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a.
b.
c.

4.

To show table captions and one empty row, choose Show captions and one empty row.
To show captions only and no rows, choose Show captions only.
To remove the entire table from the generated document, choose Remove whole table.

Check in the new version of your template to confirm changes to the table.

Inserting Smart Fields in a Template
The X-Author Templates Word add-in has support for inserting smart FX2 fields into an agreement or clause 
template.

Smart FX2 fields are specialized FX2 fields that can retain the Apttus field definition even after the Merge Service 
generates the Agreement document. This feature helps for reconciling the document which is explained in detail in 
the Reconciliation section. Smart fields are intended for negotiable parts of an agreement. Smart fields are usually 
represented by small chunks of text, such as dates, categories, and numeric values. Smart fields are not intended to 
hold large amounts of text–if necessary, use smart clauses instead.
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1.

2.

Reconciliation functionality is supported for the fields inserted "as a section" or "as a table." Qualified FX2 fields as 
smart fields for 2nd and 3rd-level objects are not supported.

For details on Reconciliation, see Reconciliation.

To insert an FX2 Smart Field into an FX2 Template
You must have an FX2 Template checked out or have created a new FX2 Template.

Click Insert Fields and then select the desired fields in the Insert Fields dialog box.

Click Finish to confirm the field selection. 

•

•

•

•

Note

Smart fields have the following limitations:

Text Area data type fields, formula field for LongDate and Multi-Select Picklists are not supported for 
Smart FX2 fields.
A normal FX2 field or a qualified FX2 field can be inserted as a smart FX2 field. You cannot insert lookup 
fields as smart FX2 fields.
You can neither insert the fields of Related Agreement object, such as Relationship From Type and 
Relationship To Type in an agreement template nor mark these fields in a generated agreement document.
Smart fields cannot be used in the headers or footers of agreement documents.

Note

You might view multiple instances of an object, but each of these objects has either a master-detail 
relationship or a look-up relationship with the parent object. For example, you might view 2 objects named 
Agreements when you click Insert Fields. One is the actual agreement object and second is the 
agreement object for EchoSign Integration with agreements and both these objects have a look-up 
relationship with the Agreement object.
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Notice that the Control Panel will open. This is where you will need to change an inserted field to a Smart 
Field. Right-click the field name in the Control Panel Navigation Pane and select Mark as Smart.

 

 You can verify that the field has been correctly inserted as a smart field be checking the field values 
in the Properties pane at the bottom of Control Panel.
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•
•
•
•
•
•
•

You have successfully inserted a field and then changed it to a Smart Field.

Support for Nested Child Level FX2 Fields
X-Author and Merge Service can support resolving FX2 fields for nested child level items at the child and grandchild 
levels of an agreement or proposal.

With X-Author you can insert FX2 fields for child relationship objects that have a master/detail child relationship with 
the agreement and FX2 fields for a third level, the grandchild level objects with a lookup relationship to the original 
object that is a child object of the agreement.

X-Author supports either master/detail or lookup relationships at the child level, as well as lookup relationships from a 
grandchild that is related to the original agreement by its relationship to the child agreement. Only lookups at the 
grandchild or third level are possible.

X-Author supports inserting qualified FX2 fields for objects at both the child and grandchild levels. To summarize, X-
Author has:

The ability to pick standard FX2 fields for object child and grandchild levels
The ability to pick lookup (qualified) FX2 fields for object child and grandchild levels
The ability to distinguish between lookups at parent, child, and grandchild levels
The ability to insert section tags to denote nested child/grandchild levels
The ability to insert lookup fields in tables and sections
The ability to insert conditions in tables and sections
Backward compatibility with pre-existing templates

What this means is you can have Related Lists for Service Plan level information for an agreement, and then easily 
insert FX2 fields for this information into your templates. You can then define another object, say Service Plan 
Devices, which is related to a Service Plan by a lookup relationship, and then define merge fields for the agreement 
service plan devices that can be repeated for each agreement service plan.

The mechanism to support the features described above involves adding section tags to support defining an area to 
the Merge Service so it can interpret line item merge fields within a section as being grandchildren of the object 
whose scope enclosed the original section tags.

Although in the FX2 Template format, your inserted FX2 fields will not display mergecode; rather, these fields will 
display the name of the fields in boxes. The support for nested child level FX2 fields is the same as inserting merge 
fields into the pre-existing Template format. See: Support for Nested Child Level Merge Fields.
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Working with Clauses
Even though you will have standard clauses that you wish to use in every contract, through negotiations, your trading 
partners will not always agree with them – as you know. We provide the concept of template libraries - alternative 
clauses or sometimes known as fallback provisions. This simply allows you to select the alternative language with 
differing degrees of risk and acceptability so that you can replace your current clause with it.

As with contract language templates, clauses also can have embedded merge fields contained within them that gets 
auto-populated during agreement creation time. Please ensure that you markup the clause template documents using 
Microsoft Word to identify the merge fields similar to the language templates.

Creating Clauses
Clauses or clause templates are created and maintained the same way as agreement templates. The difference is that 
clauses are smaller sections of text that can be manually added during the negotiation process or automatically added 
to an agreement using conditional logic, whereas agreement templates are comprehensive terms and conditions and 
can be used by the Apttus Merge Server to generate an actual agreement. Open your clause document in Word or 
create a new one by pasting a pre-existing clause from the clause library into a new blank document.

As mentioned before, you can keep the clause the way it was or you can add merge fields or FX2 fields, conditional 
text, or change it any way you like. Once you’re sure the clause is the way you want it, select either Check-In or Clone 
menu to save the clause to Apttus.
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1.

2.

•

•

•
•
•
•

Enter appropriate properties for the clause. You can select multiple agreement types this clause applies to or 
deselect types by clicking while holding the Ctrl key down. When finished, click Save or Clone. A message should 
appear saying the clause template was created.

Updating Clauses
Open a pre-existing clause using Check-Out. Note that you should select Show Filter and choose Clause from 
the Type list before you run your search.
Make the required changes to the clause and click Check-In.

Best Practices on Using Clauses
For best results with your templates follow the best practices described as under:

Do not start or end a clause with a smart field. The clause must have an empty line or some text at the start 
and the end of the clause.
Do not start or end a clause with a repeat-table. You must add an empty line or some text before and after a 
table.
Two clauses must not be side by side without space.
You must insert a blank line (not a new line) between two consecutive clauses.
Avoid using repeat table or Microsoft Word table inside a clause, as it may result in unexpected behavior.
Using Refresh Clause on a clause containing a Microsoft Word table may result in an incomplete update of 
the table cell values.

Set Segment Menu in X-Author Templates
Set Segment allows the user to either set a segment conditional, style, or both. This includes conditionals from the 
expression builder for conditionals. This also includes built in Microsoft styles and custom styles.

Purpose for the Set Segment - Expression Builder Process
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•

•

•

Enables you to highlight content within a Template and then click Set Segment, which includes a picklist of 
additional options that enable you to either make the highlighted content Conditional or apply a Style to the 
highlighted content. If Conditional is chosen, the Expression Builder will open up.

Expression Builder
X-Author Contracts includes a very robust Expression Builder that you can use to define and build powerful 
expressions and expression condition rows, enabling conditional rendering or display of content in generated 
Agreements. The Expression Builder is fully integrated with the objects and fields in your Salesforce org.

The Expression Builder is a new way for users to interact with X-Author Contracts. The Expression Builder enables 
you to add conditionality in a simpler way than ever before.

Up to 9 rows of expression conditions can be used in a single expression for segments, clauses, sections, or 
tables at one time. From the Set Segment > Conditional button or from the individual selection of fields, 
section, tables in either the document or the navigation pane, and then by using the conditional section in the 
associated properties, the Expression Builder can be accessed from the top of Control Panel on individual 
clauses, tables and segments.
It can also be accessed at the bottom of the Control Panel or from the Set Segment in the X-Author Templates 
ribbon tab. Whenever a picklist or multi-picklist has been chosen, ellipses will appear at the end of the line to 
enable you to choose values for the field. The Expression Builder can apply filters to add different relationships 
between expressions.

Note

Upon creating a New Template and choosing to utilize the new FX2 Template format, X-Author Contracts 
November 2016 has moved Make Segment > Dynamic from the February 2015 release to Insert Dynamic 
Section.
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•

•

Expression Builder Important Notes

The Expression Builder enables you to create expressions with up to 9 expression condition rows and apply 
filter logic that is similar to that in Salesforce. These expressions can be used for segments, sections, and 
tables.
The Expression Builder gives direct access to the parent object fields. Lookups are accessed through the 
ellipses in the middle of the Expression Builder.
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•

•

1.

You can add filter logic, similar to that in Salesforce. Ensure that you have included every added row within the 
Expression Builder inside the filter logic, or else you will be prompted with an error indicating that you have 
missed a row.
Clicking Finish will apply all included rows in the Expression Builder and applied filter logic to the selected or 
highlighted content in your Template.

Using Expression Builder
X-Author Contracts includes a very robust Expression Builder that you can use to define and build powerful 
expressions and expression condition rows, enabling conditional rendering or display of content in generated 
Agreements. The Expression Builder is fully integrated with the objects and fields in your Salesforce org.

Invoking Expression Builder
You must have highlighted content.

The Expression Builder can be invoked in two ways:

Click on Set Segment > Conditional.

Open the Control Panel, right-click the desired Segment Conditional, and then select Edit condition.

You have successfully invoked the Expression Builder.

Highlighting inserted content
To completely highlight content in a Template, click the small tab attached to the surrounding content box.

You have successfully highlighted the content.

You can perform a partial search with picklist values, but not with multi-picklist values.

This step applies whenever you wish to select content and perform an action on the selected content.
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1.

2.

3.

Making content conditional within a template

Using Conditionals
You must have highlighted some text, a clause, a grouping of text across clauses, or text with fields.

In the X-Author Templates ribbon tab, click Set Segment > Conditional. The Expression Builder dialog box will 
appear.
Within the Expression Builder, you can make selected content conditional. The picklist allows the user to 
choose the business object context of the Template, to define qualified expression fields.
After choosing the business object, all of the fields in that business object will automatically expand, showing 
you a list of the available fields to choose from. Choose the necessary fields.

Each expression condition requires the identification of the field control to which the condition will apply, the 
operator to be used in the condition, and the value of the field where the condition shall be True.
The Expression Builder allows the user to Add Row to add more expression conditions, where 2 or more 
conditions are joined in the overall expression by the Boolean operator AND.

Click the red icon  to delete the expression condition row. You can click  to build advanced 
expressions using lookup fields of the objects.

You cannot add an action if the conditional resolves to False.

The default relationship for more than one row in the Expression Builder is 'AND'.
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Click Finish to apply the conditional for the highlighted text. The Control Panel will open up and you will see a 
new field called, Segment Conditional. This confirms that you have made the highlighted content a conditional.

Applying filter logic
You must have at least 2 rows or a maximum of 9 rows in the Expression Builder.

In the Expression Builder dialog box, click Add Filter Logic.
To change the default AND relationship between the rows in the Expression Builder, enter in the filter 
numbers, separated by the supported operators.

AND - Finds the data which matches where both expression condition rows are True.
OR - Finds the data which matches an enclosed set of expression condition rows or a specific 
expression condition row.

For example, by using brackets or parenthesis you can enter: ((1 AND 3) or (2 AND 5)) AND 4 or you can 
enter (1 OR 2) OR 3. If you enter in the filter logic statement incorrectly, you will be presented with a error 
message in a dialog box that will assist you in applying a valid statement. 
Click Apply Logic to apply the logical statement to the rows in the Expression Builder.

Using a lookup field when making content conditional within a template
You must have highlighted the text or field to make conditional.

In the X-Author Templates ribbon tab, click Set Segment > Conditional. The Expression Builder dialog box will 
appear.
Within the Expression Builder, you can make selected text or a field conditional. The picklist allows you to 
choose the business object in which the Template is related to.

Note

You cannot add an action, if the conditional resolves to False.
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After choosing the business object, all of the fields in that business object will automatically expand, showing 
you a list of the available fields to choose from. Choose the necessary fields.

To use a lookup, click the ellipses  after the object picklist. A dialog box will pop up that allows you to 
select the object context in the left pane and the corresponding object field from the right pane.

Click OK.
Click Finish to apply the conditional for the highlighted text or field. The Control Panel will open up and you will 
see a new field called, Segment Conditional. This is a confirms that you have made the highlighted text 
conditional.

You have successfully made selected text or a field conditional using the lookup feature in the Expression Builder
within a Template.

Applying a custom style to a Segment within a template
You must have highlighted the text, field, or segment to make Regular.
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In the X-Author Templates ribbon tab, click Set Segment > Style. The Control Panel will appear.

 

Click the ellipses icon  , next to the field for Style, and the Select Styles dialog box will appear.
By default, any custom styles will appear in the Select Styles dialog box. Click the Show built-in styles check 
box to populate the list with built-in Microsoft Word styles.
Select the style you want to apply and click Select.
Notice that the name of the selected style is applied to the Style property in the Control Panel.

Note

You cannot add an action if the conditional resolves to False.
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You have successfully applied a custom or Microsoft-defined style (Style) to a segment within a Template.

Conditional Columns and Rows in a Table
X-Author Contracts allows you to mark any or all of the rows and columns in a table as conditional. In practice, these 
conditions operate as filters, allowing rows and columns in the table to be conditionally shown (and populated) or 
hidden. When you are constructing your template, you define various condition expressions on rows and columns of a 
table. These conditions are then evaluated at runtime when an agreement document is generated using this template.

For example, your table consists of a 4 columns: Product Name, Quantity, List Price and Net Price. You can define a 
condition to show the Net Price column only when the Account Name is ABC Company.
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Conditional Columns in a Table
You can make columns conditional in a table when you want to remove columns that do not fit specified 
criteria (e.g., removing a column where a value is found or not found). 
Conditional Rows in a Table
You can make rows conditional in a table when you want to remove rows that do not fit specified criteria (e.g., 
when quantity or net price is over a certain amount). 

You edit table conditions in X-Author from either the Navigation pane or the Properties pane of the Control Panel.

Conditional Columns in a Table
Add conditions to table columns when you want to remove columns from an Apttus-generated table based on 
specified criteria. This filters out columns in the table when the document is generated whenever any criteria defined 
for the table are met.

Hint: click on an image on this page to enlarge the view.
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To define table column filters 
Open the Control Panel from the Intelligent Document menu in the X-Author Templates ribbon.
Right-click on the table in the Navigation pane that you want to make conditional and choose Edit Condition
 OR select the table in the Navigation pane and click the   Expression Builder button in the Properties 
section below the Navigation pane.

Select a column from the picklist at the top of the Expression builder that you want to make conditional.
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To build an expression, define your criteria:
using the picklist on the left to choose an Agreement header-level field

by clicking the   Lookup button to the right of the picklist to choose from a list of object fields 
with a lookup relationship to Agreement
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5. Complete your expression by adding an operator and a value (e.g., "Account Name equals ABC Company")

If you are defining column filters for a table inside a section which contains third-level fields, 
you can use header or second-level fields as criteria or any object fields with a lookup 
relationship to Agreement or the second-level object.
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Click Add Row to create additional expressions for the same column. You can create up to a maximum of 9 
filters for a single column.
By default, all expressions use AND logic, meaning all conditions are required for the rule to execute. Click 
Add Filter Logic to change condition logic to OR, or create your own custom condition (for example, (1 OR 2) 
AND 3 if you want to make only 1 of the first 2 conditions required).
Repeat steps 3 – 7 for each column you want to filter.
Click Next when you are finished to continue to the next screen in the Expression Builder to define any
 conditional rows in your table (see the next section for complete instructions).
Click Finish to save your table filters and return to your document.

Conditional Rows in a Table
Add conditions to table rows when you want to remove rows from an Apttus-generated table based on specified 
criteria. This filters out rows in the table when the document is generated containing values for column object fields 
whenever any criteria defined for the table is met.

To define table row filters
Open the Control Panel from the Intelligent Document menu in the X-Author Contracts ribbon.
Right-click on the table in the Navigation pane that you want to make conditional and choose Edit Condition
 OR select the table in the Navigation pane and click the   Expression Builder button in the Properties 
section below the Navigation pane.

Hint: click on an image on this page to enlarge the view.
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3. Follow instructions from the previous section to make create column filters (make any columns conditional). 
Click Next to proceed.
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To build an expression that will conditionally define which field values are displayed as rows in the table:
use the picklist on the left to define a field from the parent object to which the table belongs (e.g., for 
Quantity, the object is Agreement Line Item).

click the   Lookup button to the right of the picklist to choose from a list of object fields with a 
lookup relationship to the parent object (e.g., Agreement Line Item) or a header-level Agreement field
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5. Complete your expression by adding an operator and a value (e.g., "List Price is greater than or equal to 
1000")
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Click Add Row to create additional expressions for the same column. You can create up to a maximum of 9 
row filters for the table.
By default, all expressions use AND logic, meaning all conditions are required for the rule to execute. Click
 Add Filter Logic to change condition logic to OR, or create your own custom condition (for example, (1 OR 2) 
AND 3 if you want to make only 1 of the first 2 conditions required).
Click Finish to save your table filters and return to your document.

Referencing Term Exceptions in FX2 Templates
The Check-In dialog box includes the ability to associate a term exception with a template when it is checked in. This 
adds the term exception to the Term Exception field on the Template record and also adds an entry in the Sections/
Clauses related list on the Term Exception for the template.

Prerequisites

For using Term Exception, you must have version 7.0 or higher for both X-Author Contracts and Contract 
Management.

To reference a term exception while checking in
From the X-Author Templates tab, click New to display an empty Word doc.
Add content to the template and then click Check-in.
In the Check-In Template dialog box, as you enter details for the template note that the Term Exception list 
remains empty, as long as no Agreement Types have been selected.
Select one or more Agreement Types and the Term Exception list will be populated with term exceptions that 
have the same agreement type.

Select a term exception and click Check-In.

The template record now has the term exception associated with it. If you edit the template in X-Author later and 
change the term exception associated with it, the Template record and the old and new Term Exception records will 
be updated accordingly.
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Publishing and Auto Publishing Templates
In X-Author Contracts, you can manually Publish and Auto Publish one or more FX2 Templates from within the X-
Author Templates ribbon tab. The Publish ribbon publishes a business object's main Template from the top down, 
going through each layer of the clause and nested child clauses, to ensure that all of the current clause contents are 
being used when the main Template is applied in the generation of documents.

Publishing the templates improves document generation performance by taking referenced clauses in a template and 
publishing them before the template is used to generate a document. This takes the content of the clause and enters 
it into the template body as static text as if it was another part of the main template. Auto Publishing enhances this by 
enabling you to schedule a batch job which automatically completes the publishing task that previously needed to be 
completed manually.

Auto Publishing requires an apex scheduled job, entering a username and password, and then selecting the Enable 
Auto Publish option on the Publish Template dialog box. After that, the system automatically handles the process. 
Even when you have Auto Publish enabled, you can always manually publish templates on an ad hoc basis.

A scheduled apex job is used to set the frequency of your auto publish jobs, while the Publish Templates dialog box is 
where you can initiate publishing.

Prerequisites

You must have upgraded to X-Author Contracts February 2015.
You must have upgraded to Contract Management February 2015.

To Publish and Auto Publish Templates
Open a Template in X-Author Templates and click Publish in the X-Author Templates ribbon tab.

Auto Publishing enhancement is available only for FX2 Templates.
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Enter and select the necessary options within the Publish Templates dialog box.

Click Publish.

You have successfully either manually or auto publish triggered an apex scheduled job for the selected Templates.

Refreshing Clauses in a Template
Refresh feature in FX2 format provides the ability for the user to recognize and update any related templates which 
are affected by a nested clause template’s changes. Refreshing a template brings all lower changed template 
contents into the current template document, and Auto Publishing batch process allows publishing of all higher-level 
templates related to the current template document.

If we assume the example of an agreement main template which contains a 1st level clause template, which in turn 
contains an inserted or nested 2nd level clause template, changes can be made to templates at any of these three 
levels.

A change to the 2nd level template will have an impact on both the 1st level clause template and the main 
agreement template.
If you check out the 1st level clause template and then check it back in, the system allows you to refresh this 
1st level clause template’s contents. You can achieve this by updating the 2nd level clause template’s 
changed content directly in the 1st level clause template before check-in.
You can also view the affected parent clause or main agreement template records in Salesforce. So for the 1st 
level clause template at check-in, you can use the Auto Publishing feature to publish all of the main agreement 
templates which are affected by the changes to the 1st level clause template.

The Auto Publishing feature updates all higher level parent clause templates as well as the main agreement template 
affected by the changes in a 2nd or lower level child templates. The net effect of using both the Refresh and Auto 
Publishing features is that document generation uses the current template contents and hence, document generation 
becomes faster.

Prerequisites

You must have previously changed a 2nd level clause template.
You must have a 1st level clause template containing a second level clause template where the content of the 
child clause has been changed.
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To refresh clauses in a template
Open the first level clause template and click Check-in. You'll see the following pop-up message.

You can click the URL in the pop-up message to go the corresponding record in Salesforce within the Apttus 
Contract Management (CM) application.
Click OK to update your template. The content of your 1st level clause template associated with the 2nd level 
clause’s changed content is refreshed or updated. The check-in page dialogue is also updated because this 
changed 1st level clause template is used in one or more main agreement templates which should now be 
published to contain the changed clause templates’ contents.
On the check-in page select the checkbox Publish all clauses and agreement templates affected by this clause 
template's change, to publish all the affecting templates. If you do not want to publish the parent or main 
agreement, leave this checkbox cleared.

If you select this checkbox you'll see this link— Click here to view the list of affected templates and 
clauses. Click this URL to view a list of the affected parent and/or main agreement templates in the 
Apttus Contract Management application.

Click Check-in.

You'll see a pop-up dialog box saying that your clause template is successfully checked in, but that the referenced 
templates should be published. Click OK to submit the apex batch job for publishing the related template. You'll see a 
progress bar showing the progress of the publish batch job.

Finally, when the batch has been successfully published, the progress and status is updated with the related batch 
completion data.

Making Clauses Smart in a Template
With X-Author Contracts, a clause may be provided a smartness property. This can be done through either the 
properties in the Control Panel or using a right click on clause in the Control Panel.

A standard contracting process begins with a generated document, and ends with a final agreement. In between the 
initial document and the final signed agreement, the document will get redlined and negotiated. Apttus Smart Clauses 
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can capture the differences between contracts. In the November 2016 release of X-Author Contracts, you can add 
smartness property to a clause in an agreement template, which after generation will make those clauses Smart.

Access to the properties of a clause can be seen and manipulated from the Control Panel. Mark as Smart is the 
property within the X-Author Template Control Panel that can eventually make clauses Smart. When the property is 
True, the clause will be Smart at generation, and if the property is False the clause will be text at generation.

Nesting Clauses in X-Author Templates
A nested clause for the purpose of X-Author Templates, is when you have inserted a clause into another clause, 
which then you insert into an agreement template. For example, if a clause named Governing Law-CA is inserted into 
a Definitions clause which is inserted into a MSA Template. In this context, Governing Law-CA is a nested clause 
within the Definitions clause. For the purpose of X-Author Templates, Definitions clause is denoted as a 1st level 
clause.

 When a 1st level clause is inserted into an agreement template, there are a few things to consider.

Only the 1st level clause can gain the smartness property within the Control Panel. This means that when the 
clause has Mark as Smart attribute as True, only Definitions clause will have Smartness property.
Conditionals of clauses not in the 1st level, when inserted into a template, will be Read-Only.
Nested clauses, like other clauses, will only be considered Smart in the context of a generated document.

To mark a clause as smart in a template
Insert a clause into the agreement template using the Playbook of the X-Author Templates ribbon.
Click the Control Panel button on the X-Author Contracts Templates ribbon tab to open the Control Panel.
In the Control Panel, select the clause that you inserted into your FX2 Template.

Note

If your clause record contains only a table, ensure that you add a paragraph before and after the table to 
avoid any errors.
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Go to the Properties section at the bottom of the Control Panel and for the Mark as smart? attribute, change 
the value to the desired value (False or True).

You have added or removed smartness from a clause in an agreement template.

Making Clauses Read-Only in a Template
You can make clauses in your X-Author templates, read-only. When you enable the Read-Only attribute for a clause in 
a template, that clause becomes uneditable in the generated document. You can edit and take action on a read-only 
clause in a generated document only if you have enabled 'XA_UnlockReadOnlyClause' custom permission in 
Contract Management. For more information on how to unlock a read-only clause, see Unlocking Read-only Clauses. 

Read-only clauses are only considered read-only in the context of the generated document. In Contract Management, 
the read-only clause is listed in the Agreement Clauses related list, with clause status as Original. The Original status 
only applies to the read-only clauses that are part of the template and does not include clauses that you have inserted 
from the Playbook after generating the agreement. 

Read-Only clauses have the following characteristics:

Any clause can be made Read-Only clause.
A Read-Only clause cannot be made Smart.
A Read-Only clause can only be defined in a template.
A Read-Only clause shows a content control boundary in the generated agreement documents. 
The value of the Read-Only clause cannot be edited in the generated agreement document.
When you make a clause read-only, the smart fields or read-only fields inside that clause lose their smartness 
or read-only property and become plain-text fields.
You cannot mark a clause as read-only in the header or footer of a template.

Note

Clauses that contain images or Apttus repeating elements (e.g., repeat tables) cannot be marked as smart.
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To make a clause read-only in a template
From the X-Author Templates ribbon, select Control Panel.
Search for and click the clause in the Navigation Pane to highlight it in the document. Or, select and click on 
the clause content in the template to highlight it.
From the Properties pane, under Control Panel, set the Attribute of Mark as Read-Only to True. By default, this 
attribute is False. Simultaneously, the value of Mark as Smart? is updated to False.

Refreshing Clauses in an Agreement Template
Refresh Clauses functionality allows to keep your agreement template up to date. If the agreement contains clauses, 
and one clause has been changed but not published, this functionality can update the clause in the agreement 
template in context.

To refresh clauses in a template
In the X-Author Templates ribbon, click Refresh Clauses.
If the Template contains clauses with no changes, you will see a message stating, All clauses are up-to-date.

If the Template contains clauses with changes, you will receive a message showing which clauses need to be 
refreshed.

Click Refresh to update all of the clauses that are within your main Template.
Click OK when you receive the confirmation dialog box stating All clauses are refreshed successfully.
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Marking Clauses in Templates
A block of text or fields can use the Mark Clause menu to gain a clause boundary and Smartness properties. Upon 
generating the document, only the clauses marked as Smart will have the clause boundaries.

While constructing a template, you may have a block of text that you may not want in the playbook, but in the context 
of an agreement template (and later a contract), you would like to add smartness property. The Mark Clause menu 
allows the user to add properties into inline text in the agreement template. After utilizing the Mark Clause 
functionality, the new clause will be added to the Control Panel corresponding to its location in the document. Any 
clause formed from the Mark Clause functionality will have, Marked as Smart as True by default. Unless changed, it 
will be a smart clause in the context of a contract document.

You can mark text as smart by highlighting the desired text within a checked out Template, selecting the Mark Clause
menu from the X-Author Templates ribbon tab, and then filling in the appropriate clause details.

While marking a clause, please keep the following points in mind:

It is recommended to only mark clauses which are not inserted from the Playbook. In other words, you cannot 
mark a clause as smart inside an existing clause record.
A template containing Sections, Tables, Images or Reference Merge Fields cannot be marked as smart. Only 
text-based clauses and clauses containing the Microsoft Word Tables can be marked as a clause.
After you mark the selected content as a clause, you cannot mark any other part of the same content within the 
boundary of the Marked clause as a different clause record.

If you have marked the wrong section of the text or you have not captured all of the text that you wanted, you can 
Unmark a clause. A clause can also be Unmarked by right-clicking the clause in the Control Panel and choosing 
Unmark. This undo action can only be done in the same session the clause had used the Mark Clause menu 
functionality, prior to check-in of the template.

To mark a clause in a template
Open your template and highlight the desired clause.
After highlighting the clause, click Mark Clause from the X-Author Templates ribbon tab.
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In the Mark Clause dialog box, fill in the appropriate information.

Click Save.

You'll see success dialog box with the name of the marked clause to confirm that you have marked a clause. The 
successfully marked clause will be indicated with surrounding border. You can also verify if the clause was marked 
properly by opening the Control Panel and viewing the marked clause details there. By default, the marked clauses 
are set as Smart.

Prerequisites

You must have a clause marked in the same session as you want to unmark a clause.

To unmark a clause in a template
From the X-Author Templates Ribbon, click Control Panel to open it.
Click the marked clause from the Navigation Panel.

Do any one of the following to unmark the selected clause:
Right click on the selected clause and click Edit markup properties. You will see the message with the 
clause properties. Click Unmark.
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Place your cursor within any part of the marked clause and click Mark Clause from the X-Author 
Templates ribbon tab. You will see the message with the clause properties. Click Unmark.

Click Yes to confirm unmarking of the clause.

    You will see a confirmation message with the clause name. Click OK to finish unmarking the clause.

Working with Rich Text Area Fields
FX2 formatted templates can take advantage of Rich Text Area (RTA) fields by rendering them as HTML. You can use 
RTA fields in your template documents to include pre-formatted text, tables and images when documents are 
generated. You take care of this in X-Author Contracts when you insert Rich Text fields and choose how they should 
be rendered.

Configuring Rich Text Area Fields
Before you can use Rich Text Area fields in agreement templates, you must first create the fields on the Agreement 
object. For proposal templates, use the same process for the Quote/Proposal object.

To create an RTA field
Go to Setup > Create > Objects > Agreement.
Under Custom Fields & Relationships, click New.
Select Text Area (Rich) and click Next.
Enter a Field Label and Field Name, such as RTF Content 1, and click Next.
Set field-level access and click Next.
Click Save. The Rich Text Area is now available from the Fields list when you edit a page layout. Create 
additional RTA fields to hold other pre-formatted content.

To add RTA fields to the Agreement layout
Go to Setup > Create > Objects > Agreement > Page Layouts and select the layout that will contain your 
RTA fields.
From the Fields list, select the RTA fields you want to use and add them to the Information section or add 
them to a new or existing section.
Click Save. Repeat steps 1 – 3 for any other required Agreement object page layouts. You can use this same 
process for the Quote/Proposal object.

In pre-existing format, RTA fields are only supported by rendering them as an image. It is recommended for 
FX2 documents to use HTML content for your images as well, as long as they are accompanied by other 
items. It is still recommended to "Render As Image" RTA fields when you are inserting a field containing 
images and no other content. For instructions on inserting image references into templates for rendering as 
image, refer to Image References in Templates (FX2).
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How to Prepare Rich Text Content for Templates
X-Author templates only support Rich Text content developed using the Rich Text editor in Salesforce. RTA fields 
inside templates generate field content exactly as shown on the agreement record. Before generating an agreement 
based on a template containing RTA fields, edit the agreement record directly to format your Rich Text content.

To insert RTA fields into a template
Open Microsoft Word and connect to X-Author Contracts.
From the X-Author Templates tab, create a new template or check-out an existing template.
Click Insert Fields. The Insert Field dialog is displayed.
Select the Agreement object and the Rich Text field you want to insert. Hold Ctrl and select any additional 
fields to insert them in the order selected.

Be aware that copy-paste or data loading of Rich Text content that includes formatting not available using 
the editor (e.g., tables) may or may not appear correctly in generated documents. Refer to Salesforce 
documentation for HTML limitations if attempting to include RTF content in this way.
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Click Finish to insert the field into your template. The Rich Text field is inserted and displayed in the Control 
Panel with the appropriate icon.

Highlight the Rich Text field in the Control Panel. The Properties pane below the Control Panel displays 
attributes for the field.
Next to "Render As" click the drop-down and choose HTML, if it is not already selected.
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8. Continue to insert fields or check-in your document.

Image References in Templates (FX2)
X-Author can display images in agreement documents by including them in RTF fields and referencing them in 
agreement templates.

You cannot insert RTA fields into the header/footer of a template.

1.
2.

3.

Tip: Controlling HTML Content Width

If your RTF field contains large HTML content, and you want to control the width of the output in the 
generated document, follow these steps:

Prior to inserting your RTF field that contains large content, insert a table with only one cell.
Right-click the table and select Auto Fit/Fixed Column Width and adjust the table to your desired 
width.
Insert the RTF field into the one-cell table. The generated document content will use the selected 
width and grow downward.
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For images to be displayed in an agreement document, there must be a reference to the image available in Salesforce 
for the merge server to use, so it can place the image in the generated agreement document. Apttus provides this 
ability through the Upload Image option in the header of an object. This provides the option to upload an image to an 
RTF field associated with a page layout, which can then be referenced via a merge field in the template used for the 
agreement document.

In order for the Apttus Merge Server to render your image properly, you must specify a height and width after 
inserting the field. Failure to do so will result in no image being generated in the target document.

You can use images up to 1MB in size and .gif, .jpg, and .png file types. To ensure the images will be presented in the 
document as expected you should work on a draft document in Microsoft Word first, edit the images as required in an 
image editor application, and then upload them to an RTF field.

To add images and upload them to an object
The object must be using a page layout that has the required fields added to it.

In Salesforce, go to the Agreements tab and select the one you want to upload images to.
Click Upload Images and select which RTF field to use and click Next. Be sure to select the correct field for 
the page layout, as currently all RTF fields in the system are included in the drop-down list.
C lick Browse and select the required file from the Images folder.
C lick Upload and then click Finish.

The image is now displayed in the RTF field in the object's header section. The image can now be added to 
templates.

To reference an image in a template
Login to X-Author and from the X-Author Templates tab click Check-Out.
Search for the required template and click Open.
Place the cursor in the template where you want to insert an image and click Insert Field.
If this is an agreement template, select the Agreement Fields object.
 - or -
If this is a proposal template, select the Quote/Proposal Fields object.
Select the RTF field you want to insert and click Finish.

The merge field is inserted into the document template in the following format, with default width and height 
measurements. You can change the default width and height from the Properties tab as required. Measurements are 

It is strongly recommended to insert RTF fields into your templates as HTML when your content contains 
images and other content, as described in the previous section Working with Rich Text Area Fields. The 
following represents a valid process for inserting RTF fields as images and can still be used, but should only 
be used when your RTF content contains only images and no other content.



In case your system has not been configured to use image references, please ask your System Administrator 
to complete the required configuration in Salesforce before you try to add and reference images.
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in inches. When you preview or generate an agreement or proposal document using the template, images are 
included in the generated document.

To configure upload image action
This task assumes you want to configure an agreement object, other objects can also be configured in a similar 
manner.

Go to Build > Create > Objects > Agreement.
In the Custom Fields & Relationships section, click New.
Select Formula and click Next.
Enter a Field Label and Field Name, such as Upload Image, select Text from the Formula Return Type list and 
click Next.
Enter the formula below, ensuring it is all on the same line in the formula field, like the screenshot, and click 
Next.
 The code should be: HYPERLINK("/apex/Apttus__ImageUpload?id="& Id, IMAGE("/resource/
Apttus__Button_UploadImage", "Upload Image"),"_self")

Set the field-level access and click Next.
Click Save.

You can select page layouts here, but as you will likely want to edit the page layouts to reposition the Upload Image 
button, it is not required at this point. Upload Image is now available from the Fields list when you edit a page layout.

To create Rich Text Area
This task assumes you want to configure an agreement object, other objects can also be configured in a similar 
manner.

Go to Build > Create > Objects > Agreement.
In the Custom Fields & Relationships section, click New.
Select the Text Area (Rich) and click Next.
Enter a Field Label and Field Name, such as RTF Image, and click Next.
Set the field-level access and click Next.
Click Save.

You can select page layouts here, but as you will likely want to edit the page layouts to reposition the RTF area, it is 
not required at this point. The rich text area is now available from the Fields list when you edit a page layout. You can 
create more rich text areas if you want to have more images available for your documents.

To configure Image reference Fields
You must have created an Upload Image field and RTF fields to be used with a page layout.

You could add image support to Quote/Proposals by repeating this task for that object.

You should also create RTF fields for the images if they do not already exist.
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Go to Build > Create > Objects > Agreement > Page Layouts and select the one you want to add Image 
Reference functionality to.
From the Fields list select the RTF fields you want to use for images and add them to the Information section.
Then select Upload Image from the Fields list and add it to the Information section.
Click Save.
Repeat steps 1 to 4 for any other required Agreement object or Proposal object page layouts.

The fields will now be displayed on objects using those page layouts.

When you go to the object, there will be an Upload Image button, along with the RTF fields in the object's header 
section.

You must have created an Upload Image field and RTF fields to be used with a page layout.
Go to Build > Create > Objects > Agreement > Page Layouts and select the one you want to add Image Reference 
functionality to.
From the Fields list select the RTF fields you want to use for images and add them to the Information section.
Then select Upload Image from the Fields list and add it to the Information section.
Click Save.
Repeat steps 1 to 4 for any other required Agreement object or Proposal object page layouts.
The fields will now be displayed on objects using those page layouts.
When you go to the object, there will be an Upload Image button, along with the RTF fields in the object's header 
section.

Template Versioning
Template Versioning provides a solution framework of document versioning at the Template level to track template 
versions against generated documents. Your organization's policies, requirements, legal and business practices 
may change over time, requiring templates to be updated. Rather than manually keeping track of template iterations, 
you can use template versioning to track and manage every version of your template throughout its lifecycle. Template 
versioning maintains those different versions as the template changes, giving template admins the ability to activate 
specific template versions based on their needs, and to observe how the template looked at every stage in the 
authoring process. Template versioning applies to both agreement and clause templates in your library.

In short, template versioning allows template admins to:

Survey older contracts by viewing their associate template version to understand what was in the template at 
generation.
Revert to previous template versions.
Clone template versions to begin a new template lifecycle.
Publish updated clauses and nested clauses across specific template versions.
Understand the growth and evolution of a given template.

The following sections in this guide provide step-by-step instructions for managing templates in X-Author Contracts 
for orgs with Template Versioning enabled:

Behavior for versioned templates is different where described. All other X-Author Contracts functionality remains 
unchanged. Consult other chapters in this guide for information specific to your document format (FX2 or Pre-FX2).
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To use Template Versioning it must be enabled for your org. Refer to Template Versioning in the Contract 
Management Administrator Guide.

How Template Versioning Works
Each agreement or clause template in your org (with or without template versioning enabled) always consists of one 
template, and multiple child references to clauses and sections contained in that template. For every instance of that 
template, there is always only one template which can be considered active (the version selected by the user to 
generate the contract or the version of the clause inserted into an agreement template).

More specifically, whenever a new template is created by any means, one instance of the template is created, stored 
in the Template object in Salesforce, and any clauses or dynamic sections nested in the template are stored in the 
Template Clause Reference and Template Dynamic Section objects respectively. The Template object has a master-
detail relationship to both child objects, as shown in the following figure.

Template Versioning preserves the same template, called the "Header Template," which has a one-to-one relationship 
with the Active Version of the template and its child objects, and a one-to-many relationship with other versions of the 
template, which also have versioned clause and section references, but are considered inactive.
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Template Versioning introduces three new objects:

Template Version – a detail object of the master Template object
Template Clause Reference Version – a child object of Template Version that stores nested clause references
Template Dynamic Section Version – a child object of Temple Version that stores dynamic section references

When a user creates a new version of a template, the version information is incremented (e.g. from "1.0" to 2.0") but 
stored in the Template Version object and its child objects, NOT the Template object, creating a separate record of 
that template version. After creation, when and if a template version becomes the active version, data from the
 Template Version objects are copied to the Header Template objects and that template version becomes the new 
active version of the Header Template.

Creating New Template Versions
This page contains instructions for creating a new agreement or clause templates when Template Versioning is 
enabled. For instructions on creating templates without versioning, see Creating New Agreement Templates (Pre-FX2 
Format) in this guide.

To create a new agreement or clause template
Open Microsoft Word and connect to X-Author Contracts.
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From the X-Author Templates tab, click New. The Create New Template dialog is displayed.

Enter values in the fields provided as described in the following table (fields marked in red are required):

Field Description

Name Give the template a meaningful name according to its agreement 
type.

Framework Format Choose the format of your template (FX2 or Pre-FX2)

Business Object Choose the valid business context (for contracts, "Agreement")

Type Choose the type of template to create (e.g. "Clause" or 
"Agreement").

Category Choose the administrator-defined category.

Subcategory Choose the administrator-defined subcategory based on the 
chosen category.

Language Choose the default template language.

Locale Choose the default template locale.

Next Revision Date Identify a date for the next revision of the template.
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Field Description

Term Exception Use the lookup to search for an choose a Term Exception to apply 
to the template.

Keywords Enter comma-separated keywords to associate with the template. 
Can be used as tags with Document Finder.

Description Enter a description for the template.

Guidance Enter guidance to help users determine the purpose of the 
template.

Agreement Types Choose which Agreement Types are valid for this template. Use 
the arrow buttons to determine available agreement types.

Click Create New. This opens the enable formatting dialog box.
From the Enable Formatting dialog, configure the following fields to enable formatting:

Field Name Description

Enable Formatting Select this checkbox to enable locale formatting at the template and 
field level for your template. This allows you to define locale settings 
for Currency, Number, Percent and Date formats.

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale formatting.

Date Format Select an option from the drop-down to choose the default format 
for all the Date fields in your template.

Currency Format Select an option from the drop-down to choose the format for all the 
Currency fields in the template. Choose "None" to only display 
Currency field values in generated documents.

Number Precision Enter a number to define the precision for Number/Percent field 
values in your template (e.g., "2" if the Number/Percent field should 
display two digits following the decimal point.)

Currency Precision Enter a number to define the precision for Currency field values in 
Your template (e.g., "2" if the Currency field should display two 
digits following the decimal point.)
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6. The template is created in the system and flagged as transient. 

Note: Only the header information is captured. You must check in the template to create a version.

Checking In Template Versions
After you create a new template or make changes to an existing template, you can check-in the template to update its 
contents in Salesforce and create a new version. Depending on the version of the template, when you check it in it 
may or may not become the active version of the template.

This page contains instructions for checking in templates when Template Versioning is enabled. For 
instructions on checking in templates without versioning, see Checking In a Pre-Existing Template in this 
guide.
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To check in a template version
From the X-Author Templates ribbon, click Check-In. The Checkin Template dialog is displayed.

Enter values into the fields provided as described in the following table (fields marked in red are required):

Field Description

Name Enter a new name for the template.

Category Choose an option from the list to update the template category.

Subcategory Choose an option from the list to update the template subcategory.

Language Choose an option from the list to change the default language for 
the template.

Locale Choose an option from the list to change the default locale for the 
template.

Any changes made to fields during Check-In update template information for the master template 
record. When you check out a previous or new version after updating this information, the template 
properties will reflect these changes.
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Field Description

Next Revision Date Identify a new date for the next revision of the template.

Term Exception Choose an option from the list to change the term exception 
applied to this template.

Keywords Enter comma-separated keywords to associate with the template. 
Can be used as tags with Document Finder.

Description Enter a new description or modify the existing description for the 
template.

Guidance Enter new guidance or modify existing guidance to help users 
determine the purpose of the template.

Comments Enter comments that apply to this version of the template. 
Comments are displayed to template administrators during check 
out and are stored in the Template Version object record.

Agreement Types Add or remove Agreement Types to associate with this template.

Activate Check this box to activate the new version of this template when 
check-in is complete. If disabled, the new version will still be 
checked in but the currently active version will remain the same. 
You can activate this version at a later time.

Update Current Version Check this box to update the current version you have checked out. 
This template will replace the current version and will not create a 
new version of the template.

Click Check-In. This opens the enable formatting page.
From the Enable Formatting dialog, configure the following fields to enable formatting:

Field Name Description

Enable Formatting Select this checkbox to enable locale formatting at the template and 
field level for your template. This allows you to define locale settings 
for Currency, Number, Percent and Date formats.

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale formatting.

Date Format Select an option from the drop-down to choose the default format 
for all the Date fields in your template.

Currency Format Select an option from the drop-down to choose the format for all the 
Currency fields in the template. Choose "None" to only display 
Currency field values in generated documents.

Number Precision Enter a number to define the precision for Number/Percent field 
values in your template (e.g., "2" if the Number/Percent field should 
display two digits following the decimal point.)
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Field Name Description

Currency Precision Enter a number to define the precision for Currency field values in 
Your template (e.g., "2" if the Currency field should display two 
digits following the decimal point.)

Click Save.

Your formatting settings are saved, the template version is checked in and the version number is incremented by 1 
(unless Update Current Version is checked–see above). For example, if you have checked out Template v2.0, when 
you check in the new version, it will be checked in as Template v3.0. Template version information is updated and 
added to the Template details in Salesforce. The name of the template and the document itself will contain no version 
information.

Checking Out Template Versions

To work with any template version, you must check it out directly from X-Author Contracts. When you check out a 
template version, you are only working with the specific version of the agreement or clause. As with contracts, when 
you check out a template a lock is put on the document, preventing other users from editing it while you are working 
on it. After you release the lock or check in the template, the lock is released. Note that the lock only prevents other 
users from checking out the version you are working on, not every version of the template.

To check out a template version
Open Microsoft Word and connect to X-Author Contracts.

This page contains instructions for checking out templates when Template Versioning is enabled. For 
instructions on creating templates without versioning, see Checking Out a Template in this guide.
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From the X-Author Templates tab, click on Check-Out. The Checkout dialog is displayed.

Enter a name, description or keyword in to the search box. Use the filters below the box to restrict your search 
to a specific template type (e.g., Agreement or Clause) and further refine your search.

Click the Search icon   to display a list of Templates that match your criteria. Any guidance saved in 
the template record is displayed in the far-right column.

If your template document is already open because you have checked it in or released the document 
lock, you can instead click the arrow below the Check-Out icon and choose Check-Out Currently 
Opened Document to quickly check out the current document.
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5. Click Select to choose a template to check out. The Template Versions dialog is displayed. Comments saved 
in the version record for each template version are displayed in the far-right column.
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6. Click Open next to the version you want to check out. The template document is checked out of the system 
and locked for editing. X-Author Contracts automatically detects whether the document is FX2 or Pre-FX2 
format.

You are now ready to work with the template. Refer to the appropriate section in this guide for instructions on 
working with fields, clauses and other elements for FX-2 or Pre-FX2 templates.

Checking Out a Template with No Versions
You will likely have many templates in your org that were created before enabling Template Versioning. In this case, 
these templates will not have a template version. After Template Versioning is enabled, the first time you check out a 
non-versioned template, the system will automatically assign it as the version 1.00.
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The version number is added to the Template record as Template Version. The next time you check-in the template, 
the version will increment as normal.

Cloning Template Versions

You can clone a template when the need arises to have a template with similar language or elements. When you 
clone a template version, a new template record is created as version 1.0. Remember the following when cloning a 
template version:

You can only clone the active version of a template.
You cannot use the clone button if any version other than the active version is open in X-Author.
Cloning a template record is just like creating a new one except a copy of the document you are cloning is 
attached to the new record as the first version.

To clone a template version
Open Microsoft Word and connect to X-Author Contracts.
Check out the template version you want to clone.

This page contains instructions for cloning templates when Template Versioning is enabled. For instructions 
on creating templates without versioning, see Cloning a Template in this guide.
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From the X-Author Template tab, click Clone. The Clone Template dialog is displayed.

Make changes to the template header information as necessary. By default, the template Name appends the 
word "Copy" to the original name. For information on fields in the Clone Template dialog, refer to Creating 
New Template Versions.
Click Clone. After the cloning is successful:

X-Author creates a copy of the template as a new template record with the new name and header 
information. 
The template version information is saved to the record as version 1.0.
A copy of the template document is saved to the Notes & Attachments Related List of the template 
record.
The currently opened document is renamed to TemplateName.docx and remains checked out. When 
you check in the template the version will be incremented as usual.

To View Parent Template Version
You can clone a template from another template version and can track the version of the parent template from which 
the current template was cloned. To view the parent version of the current template:

Login to Salesforce.
Go to Templates tab to view the template record.
Go to Versions related list.
In the versions related list you can see the parent version of the current template in the Parent Version column. 
You can also see the active version from the Active Version field in the Publish Templates related list. The 
parent version of the new template created is blank because it does not have a parent template.

TheClonebutton will not be available unless the template you are cloning is the active version.
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Activating Template Versions
You can use X-Author to activate a template version to make it the current active version. When a contract is 
generated, the active version of the template will always be used. When a template is created, the first version 
becomes the active version. Every subsequent version of a template requires the administrator to activate it either on 
check-in or manually from X-Author or Salesforce. For information on activating template versions from Salesforce, 
refer to Activating Template Versions in the Contract Management Administrator guide.

In X-Author, there are several ways to activate a template version, depending on your objective. You can:

Activate a template version at check-in.
Activate a template version that is currently checked out.
Activate any version of a template without checking it out.

To view parent version, make sure to add the Parent Version column to the Versions related list using Edit 
Layout option from Salesforce.
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To activate a template version at check-in
Complete all steps required for checking in your template as described in Checking In Template Versions
before clicking Check-In.
Click the Activate check box to activate this version at check-in. If you do not enable this check box, the 
current active version will remain the active version.

Click Check-In. Your template is checked in and increments to a new version number. This version of the 
template is now active.

To activate a currently checked out template
From the X-Author Templates tab, check out the contract you want to activate.
From the X-Author Templates tab, click the Activate button. You can only activate checked out templates that 
are not the active version.
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When the template is successfully activated, the Activation dialog displays the message "Template Activated."

To activate any template version
Open Microsoft Word and connect to X-Author Contracts.
From the X-Author Templates tab, click Activate. The Activation dialog is displayed.
Enter a name, keyword or description associated with your template in the search dialog, choose any filters 

from the provided fields, and click the Search icon  . A list of templates matching your search is 
displayed.
Click Select next to the template record that contains the version you want to activate. A list of versions is 
displayed, along with any comments entered when the version was last checked in.
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5. Click on Activate next to the version you want to activate.

Publishing Template Versions
Publishing templates improves document generation performance by taking referenced clauses in a template and 
"publishing" them before the template is used to generate a document. In Pre-FX2, this takes the content of the 
clause and enters it into the template body as static text, as if it was another part of the main template. In FX-2 format, 
updated clauses are inserted into the template.

Template Versioning allows you to be more selective when publishing templates. You can choose which versions to 
publish, updating nested clauses in some versions while preserving older versions of your clauses in other templates. 
In template versioning, publishing adopts a "bottom-up" approach. You publish the main template with nested 
clauses, but the process actually travels up from the updated clause to the main template itself. For example, consider 
a template with a nested clause that contains an updated clause. First, the clause is updated, next its parent clause is 
updated, and finally the main template is updated. For every update, each template version is incremented by 1.

The process for both manually and automatically publishing templates in X-Author Contracts is unchanged. Refer to
 Publishing for step-by-step instructions for publishing your templates.

Consider the following scenario for publishing templates when a clause has been updated:

If a template has not yet been versioned and is published, the template is published with two versions: a pre-
published version and the published version.
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Use Case: MSA Payment Terms Publish Scenario

Sam Sales works for Tier One Systems, and is managing two different master templates, and MSA and 
MCA. Both templates contain the same Net Payment Terms clause (version 1.0). The figure below 
represents the template and clause hierarchy for both templates. Note the Net Payment Terms clause is 
nested under both.
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Sam is given instructions to update the Net Payment Terms clause to a Net 45 from Net 30 for MSA 
contracts only. Sam updates the clause to version 2.0 and activates it. This flags both parent clauses and 
master templates as "needs publishing." Because only the MSA contracts need to reflect the updated Net 
Payment Terms clause, Sam elects to publish just the MSA master template to a new version.

When the template is published, the Net Payment Terms nested in the MSA template, the Net Payment 
Terms clause, the MSA Payment Terms clause above it and the MSA master template are all updated to 
version 2.0. MSA template 2.0 is now the active template version. The MCA template is not published and 
still contains version 1.0 of the Net Payment Terms clause.

All MSA contracts using this template will now use the updated clause version.
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Migrating Template Versions
X-Author Migration Manager allows you to perform numerous functions, including migration of templates from one 
Salesforce org to another. When you migrate non-versioned templates, all template records are essentially copied to 
the new org with no changes.

With Template Versioning, migration of agreement and clause templates to a new org resets version numbers. All 
migrated templates are reset to version 1.0 when transported. In addition, if a template has been migrated to another 
org, and is migrated again into the same org, the newer version will replace any versions that are present.

To understand this more easily, it is important to remember that a template's active version is always copied to the 
Template record's header details. So, during any migration, the active version of any templates migrated becomes the 
new version 1.0, regardless of how many versions of that template may exist as nested clause templates. Therefore, 
any templates that remain unpublished and contained older versions of clauses will still contain those clauses, but 
there will only be version information in the template record for the active version of the clause template.

Cloning a Template
 

You can clone an existing template that you have checked out to make a new copy of the template.

Pre-requisites:

You must have an existing template checked out in X-Author Contracts.

To clone a template from an existing template:

Click Clone on the X-Author Templates ribbon in Microsoft Word.
Change the name of the cloned template, to suit your requirements. By default, the cloned template name has 
'Copy' added to the end of the original template name. For example, if you're cloning a template named Clause 
Agreement Template then the default name for cloned template will be Clause Agreement Template Copy.
Click Clone to save the cloned template to Salesforce.

Please note that during template migration, bookmarks created with the older versions of X-Author 
Contracts, that is versions before 9.0810, are not migrated by the Migration Manager. To overcome this 
limitation, remove the instances of such bookmarks from the template and re-insert them with the latest 
version of X-Author Contracts plugin (9.08010 or later).
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Using the Playbook
Playbook helps you to search for a template, clause, section or supporting documents that can be inserted into the 
template as inline text or smart content controlled text. By default, the Playbook pane is displayed on the right, within 
the main Word window, but it can be re-positioned, by clicking  and choosing Move. It can be closed by clicking 
Playbook again or clicking  .

While searching for clauses in the Playbook pane, within Microsoft Word, you can select Show Filter to add search 
criteria. Filters let you narrow down your search by specifying search criteria like Type, Category, Sub-Category, 
Locale, and Language. You can also set default filter values to restrict the number of clauses shown in the clause list. 
Playbook for FX2 templates allows you to search for a template, clause, section or supporting documents that can be 
inserted into the template as inline text or smart content controlled text.

NOTE

You have the option to change Locale settings for your template when you clone it. To know how to define 
locale options when cloning, refer to Defining Locale Options when Cloning.
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To insert a clause from the Playbook in a template
Login to X-Author Templates in word and open an existing template using Check-Out.
The template document opens in Word. Select a existing paragraph or place the cursor in appropriate place to 
replace or insert a clause.
Click on Playbook on X-Author Templates ribbon and search for the required clause you want to insert.
Click Select and then click Insert.
After you have inserted the clause, click Check-In.

Override Playbook Default Filter
You can set a default filter for the clauses shown in the Playbook clause list of X-Author, using the Comply System 
Property— Override Playbook default filter. In the scenarios where the complete clause list is lengthy, this feature is 
useful for showing only the relevant clauses in the clause list for an agreement. Default filters cannot be set for offline 
agreements.

You can set the field names for the filter criteria in the Override Playbook default filter custom setting. The clauses are 
filtered based on the value of the fields defined in the Override Playbook default filter setting. When a template is 
used to generate an agreement document, the default filter fields of that agreement inherit their values from the 
associated template's properties. The Playbook then filters and displays only the clauses that match the filter criteria.

You cannot insert a clause reference in FX2 Templates. You can only enter the clause as an inline text. You 
can still insert clause references into a pre-existing format Template.
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To define Override Playbook Default Filter
Go to Setup> Custom Settings> Comply System Properties.
Click Edit.
Enter the comma-separated values of Category, Sub-category, Language, and Locale in the Override Playbook 
default filter field and click Save.

For example, you have set the value of Override Playbook default filter= Category and Locale, and the values of 
Category and Locale in the template used for agreement generation are Spanish and Category 2. Now, when you 
Check-out an agreement and click Playbook in X-Author Contracts, Category and Locale filter values are set to 
Category 2 and Spanish. The clause list shows the clauses that match these filter criteria.

Clause Formatting on Insert Clause in FX2 Formatted Templates
For FX2 formatted templates, X-Author for Contracts has a feature that allows you to choose whether to adopt 
template formatting or retain clause formatting when a clause is inserted into a template. To use this:

Login to X-Author Templates in word and open a pre-existing template using Check-Out.
The template document opens in Word. Select a pre-existing paragraph or place the cursor in appropriate 
place to replace or insert a clause.
Click on Playbook on X-Author Templates ribbon and search for the required clause you want to insert.
On the top of Playbook Pane, select Use Clause Formatting checkbox.
Click Insert.
After you have inserted the clause, click Check-In.

Note that the inserted clause (highlighted in yellow above) retains the formatting of the clause.
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Inserting Clauses as Bookmarks (FX2)
When managing a contract, there is often legal language that may be required to exist in the agreement document in 
multiple locations. Using the standard workflow when designing an agreement template, the Template Administrator 
inserts clauses directly into the template, which are rendered in the agreement document when it is generated. 
Contract managers and negotiators then open the generated document and insert, modify or delete clauses as 
needed. The limitation with the standard workflow is that when numerous occurrences of the same clause are needed 
in a contract, each must be manually added to the template by either the Template Admin or the Contract Manager. 

This feature provides Template Administrators with the ability to instead insert bookmarks into the Agreement 
Template. Each bookmark contains a reference to a single clause in the template library. When the agreement 
document is generated, clauses inserted as bookmarks are not populated in the agreement document. Instead, when 
a Contract Manager works with the document, they have the option to automatically insert the content of a clause at 
every location in the document with the same bookmark using a single click. This provides greater flexibility and less 
work when multiple occurrences of the same clause are required in a document.

The Clause Bookmark feature requires X-Author Contracts for Word version 8.5.0713 or later and a connected org 
with Apttus Contract Management package version 8.5.0346 or later installed. Clause bookmarks only work with FX2 
format templates and documents.

Configuring Clause Bookmark Functionality
Adding Clause Bookmark functionality to X-Author Contracts requires configuration of the Admin properties 
described in the following table. 

Admin Property Description Possible Values

APTS_AllowBookmarkInsertio
n

Enables the "Insert Clause as 
Bookmark" check box in Playbook for X-
Author Templates.

True/False

APTS_HighlightClauseOnBoo
kmarkInsertion

Automatically highlights all clauses 
immediately after being inserted from 
bookmark locations in X-Author 
Contracts.

True/False

APTS_BookmarkHighlightCol
or

Defines the color to use when 
highlighted clauses are inserted as 
bookmarks after generating the 
agreement.

Recommended values (specify one): 
wdBlack, wdBlue, wdBrightGreen, 
wdDarkBlue, wdDarkRed, wdGreen 
(default), wdGray25, wdGray50, 
wdPink, wdRed, wdTeal, 
wdTurquoise, wdViolet, wdWhite, 
wdYellow.

You cannot apply Use Clause Formatting for Document Assembly Ruleset clauses, since the same settings 
do not apply to inserted nested clauses within Document Assembly Rulesets component clause.
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To configure Admin Properties
Log in to the connected Salesforce org.
Go to the Admin tab in Apttus Contract Management.
Click New to add a new Admin property.
Enter the Admin Property name into the Name field (e.g., "APTS_AllowBookmarkInsertion"). 
Enter the property's value into the Value field.
Click Save.
Repeat steps 3 – 6 for each property you want to configure.

Inserting Clauses as Bookmarks in Agreement Templates

Before Contract Managers can take advantage of the Clause Bookmark feature, Template Administrators must insert 
clause references as bookmarks in the agreement template. 

To insert a clause as a bookmark
Open Microsoft Word and log in to X-Author Contracts.
From the X-Author Templates ribbon, select Playbook. The Playbook pane is displayed to the right of the 
document.

Only APTS_AllowBookmarkInsertion is required to enable this feature.

•

•

Please note at this time the following limitations for clause bookmarks:

although you can insert clauses as bookmarks in any template, there is no support for bookmarked 
nested clauses.
clause bookmarks inserted in repeat tables will only appear once in the generated document, 
appended to the end of the table content.
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Use the Playbook search dialog to search for one or more clauses you want to insert.
At the top of the Playbook pane, select the check box to Insert Clause as bookmark.
Place your cursor where you want to insert the bookmark into your agreement template.
Click Insert next to the clause you want to insert. The following confirmation dialog is displayed.
Repeat Steps 5 – 7 to insert the same clause as a bookmark in other locations or to insert other clauses as 
bookmarks.
Check-In your agreement template to update the template in Salesforce with the bookmarked clause 
references.

Making Bookmarks Visible in the Template Document
After inserting clauses as bookmarks, you may find it easier to confirm insertion of bookmarks by making them visible 
in the Word document. To make bookmarks visible:

Go to File > Options > Advanced.
Scroll down to the Show Document Content section.
Select the "Show bookmarks" checkbox.

A Note on Publishing and Bookmarks. When a clause is inserted into a template as bookmark, it is inserting 
a reference to that clause into the corresponding template. Therefore, if the clause associated with the 
bookmark is changed, the corresponding template will not need publishing. When working with an 
agreement document, the most recent version of the clause is always inserted.
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Return to your document and confirm that bookmarks are present.

Updating References
The Update References button lets you update the clause references, table of contents, headers and footers, cross-
references, bookmarks, and formulas in tables. To update references in your document:

Go to X-Author Contracts tab in Microsoft Word ribbon.
Click Update References.
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Inserting Dynamic Segments

As a template administrator, you can use Dynamic Segments in your X-Author Contracts templates to dynamically 
populate agreement documents with the content of clause templates and/or attachments based on Document 
Assembly Rulesets (DAR) defined in the connected Org.

Dynamic segments are not to be confused with conditional segments in agreement templates–conditionality is 
handled by values in the Document Assembly Rulesets themselves, and in the context of line item objects, filtered 
further using conditional expressions when you insert the segment. Document Assembly components (the actual 
clause templates or line item attachments defined in the ruleset and its rules) are included or excluded at document 
generation based on these Rulesets and filters. For more information on configuring dynamic Document Assembly 
Rulesets, refer to Dynamic Document Assembly in the Contract Management Administrator Guide.

Dynamic segments can be inserted wherever you would typically insert a clause template or line item content 
(depending on your individual use case). 

Prerequisites
Before inserting dynamic segments into your template, your template must meet the following prerequisites:

Your template must be of the type Agreement or Proposal and can be in Pre-FX2 or FX2 format. You cannot 
insert dynamic segments into a Clause template.
You must have at least one dynamic Document Assembly Ruleset created in the target Org.

To insert Dynamic Segments
From the X-Author Templates ribbon tab, create a new template or check out an existing template.
Place your cursor at the point in the Template you want to insert a dynamic segment.

Hint: Click on an image to enlarge the view.

Support for the Proposal object and for both the Agreement and Proposal objects at the line item level is 
only enabled for users of Apttus Contract Management and X-Author Contracts November 2016 release or 
later (versions 8.335 (CM) and 8.508 (XAC) respectively). Prior versions only support the Agreement object 
header level and clauses as dynamic components (not attachments).



Note

Ensure dynamic component content matches the audience and requirement, such as whether it is going to be 
generic content reused in multiple rules or specific content aimed at a specific requirement such as a 
geographical area or business unit.
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From the Intelligent Document section of the X-Author Templates tab, click Insert Dynamic Segment.

The Insert Dynamic Section dialog is displayed.

 In the dialog box, enter a Section Name that describes the dynamic segment you inserting. The name must be 
unique to the document.
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Choose a Ruleset Name from the drop-down list to define the active Document Assembly Ruleset that will be 
used for this segment. Only Rulesets matching the agreement type (record type) of the template are displayed 
in the list.

For Rulesets using a Header-level context (no line item components, only clause components), skip to the next 
step. For Rulesets with Line Item-level context (e.g., components are attachments on Agreement Line Items or 
Agreement Products), you can define condition expressions to filter dynamic content by line item or lookup-
related field values.
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Click Insert to insert the dynamic segment into your template.
After you have completed adding dynamic segments to the template, check it in.
When you Check-In a template with dynamic sections, you will not be able to change the agreement type of 
the template.

For each dynamic segment you inserted, a record is added to the Template Dynamic Segments related list on the 
Template record.

When you generate an agreement document in Salesforce and use this template, the content that is included in the 
Agreement document will depend on the parameters set out in the Doc Assembly Rulesets referenced by the 
Dynamic Segments configuration.

Cloned Clause Template UUID Identification
The cloning of Dynamic Assembly Rules includes the cloning of the Component Types and the associated Clause 
Templates assigned to the Contract Types.

Document Assembly Rulesets do not make a distinction between Pre-FX2 and FX2 content. Be certain 
when authoring templates that include dynamic segments to use the Rulesets with the appropriate content 
format.
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Separately, within X-Author Contracts, this template cloning identifies the new template created from the original 
template using two fields, which are always updated on the original template, and containing the ID's of the new 
template. In this way, if a clause template has been cloned using X-Author Contracts, it is also an assigned template 
for a cloned component type within a cloned rule, the customer can determine if and which new template is to be 
used in the new rule's component type.

Auto Select Options When Finalizing Documents
You can choose to have PDF generation and reconciliation be automatically selected, when you select Check-In for 
an agreement document and choose to save it as the Final document. By default X-Author will give you the option to 
Reconcile Document and Create PDF Attachment when you check-in a final document; however, you can select 
system properties which make those options automatically selected and not editable. There are also additional system 
properties which allow you to override those automatic selections.

Configuring Auto Select Options
Four Comply System Properties control this functionality. By default they are not selected.

From Setup, go to Develop > Custom Settings > Comply System Properties and click Manage and then Edit. 
The two settings for auto enabling are:

Auto Enable PDF For Final Docs - Select this and the Create PDF Attachment option is always 
selected when you choose to save as Final - to be signed from the check-in dialog.
Auto Enable Reconciliation - Select this and the Reconcile Document option is always selected when 
you go to check-in an agreement document.
These two settings enable you to override the auto-enabled options when you go to check-in an 
agreement document:
Allow PDF Select Override - This is only applicable when Auto Enable PDF For Final Docs is selected.
Allow Reconcile Selection Override - This is only applicable when Auto Enable Reconciliation is 
selected.

The following table shows the check-in options available corresponding to the system properties configured.

System Properties Check-In Page Options

Auto Enable PDF For Final Docs

Auto Enable Reconciliation

Reconcile Document checkbox is disabled (greyed out)

Create PDF attachment checkbox is disabled (greyed out)

You must be using X-Author Contracts 7.0 or higher and Contract Management 7.0.228 or higher.
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System Properties Check-In Page Options

Auto Enable PDF For Final Docs

Auto Enable Reconciliation

Allow PDF Select Override

Allow Reconcile Selection Override

Reconcile Document checkbox and Create PDF attachment
checkbox are enabled but you can choose to select or clear 
it

Opening Agreement or Template Record in Salesforce From X-Author
You can open the Salesforce record of an active Template or Agreement document from within X-Author Contracts 
using Open in Salesforce feature.

Prerequisites

You must upgrade to X-Author Contracts 7.2.1104 in order to utilize this feature. You must be using X-Author 
Contracts 7.2.1104 or higher in order to use this feature.
You must be logged into Salesforce with an active session from X-Author Contracts.

The Open in Salesforce button enables you to view the corresponding Agreement document or Template in your 
Salesforceorg. When you click Open in Salesforce button for either an Agreement document or Template, the 
corresponding record opens in your default web browser.

Removing Track Changes in Microsoft Word
After checking in a template using the Check-in button in the X-Author Templates ribbon tab and then generating an 
Agreement document using that template, Track Changes will appear in Microsoft Word. To hide the Track Changes 
from a generated document, you must perform the following two tasks.

To deselect Microsoft Formatting
To configure the Microsoft Office Option Setting for Markup

Add-in features that are associated with Update From Salesforce, Playbook Access from the X-Author 
Contracts Tab, and Import Offline Documents are not currently available for custom objects.
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Prerequisites

You must have checked out a Template into X-Author Templates.

To deselect Microsoft Formatting
In the Microsoft Ribbon, select Review.
Click Show Markup and deselect Formatting. Verify that the check mark is no longer next to Formatting.
Click Check-in under the X-Author Templates ribbon.

You have removed the automatic formatting for Microsoft Track Changes for the checked out Template.

To configure the Microsoft Office Option Setting for Markup
Please refer to this Microsoft Office Knowledge Base Article for Markup text may reappear when you open or 
when you save a document of Word.
Click Check-in under the X-Author Templates ribbon.

You have successfully removed default behavior for how formatting affects opened documents.

Defining Template Locale

Using Custom Locales
Locale Settings for Templates

Prerequisites
Limitations
Defining Locale settings for a new template
Defining Locale settings at Check-in
Defining Locale settings when Cloning
Use Case: Template with Multiple Locale

Template localization is a feature allows Template Administrators to define the locale of their templates. Locales can 
be system defaults or user-defined locales. For more information on how to use user-defined locales, refer to Using 
Custom Locales. Template Administrators have the ability to

Specify the Locale when creating a new template or cloning a template, or change the locale of a template at 
check-in. At template creation, administrators can enable locale settings and choose the Currency Format, 
Date Format, and configure Number and Currency precision for the whole template.
Define the format for Currency and Date fields using the Control Panel. This preserves the locale for fields in 
inserted clauses at the template level while making specific changes to other field formats as needed. 
Generated documents conform to template locale except where specified at the field level.

Following are some of the important points about how localization works:

For a template, the Date format, Currency Format, and Currency and Number Precision values are defined 
according to the configured locale.

https://support.microsoft.com/en-gb/help/831771/markup-text-may-reappear-when-you-open-or-when-you-save-a-document-of
https://support.microsoft.com/en-gb/help/831771/markup-text-may-reappear-when-you-open-or-when-you-save-a-document-of
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Field-level locale formatting takes precedence over clause-level and template-level locale formatting.
Clause-level locale formatting takes precedence over template-level locale formatting.
For a clause or field, if locale formatting is not defined at field-level or clause level, the template formatting is 
applied.
If an agreement template or clause template has no locale defined, the default locale—English (US) is applied.

Combining the above features allows Template Administrators to use multiple locale formats in templates while 
maintaining a default locale and format for subsequent document generation. To learn how to change field format by 
locale, refer to Changing Field Format by Locale.

Using Custom Locales
In addition to the standard locales available in Contract Management, you can define and use user-defined custom 
locales in your agreement templates, clause templates, and template fields. You can use the user-defined or custom 
locales with both versioned and non-versioned templates. These user-defined locales are available for templates of all 
types, like, agreements, clauses, proposals, and billing invoices.

You can define the locale and use it at the time of creating a template or while checking the template in. The same 
locales are also present at field level at the time of inserting a smart field; provided, Enable Formatting is selected at 
the time of check-in. The field values are shown according to the locale setting. For currency fields, the precision and 
symbol values depend on the locale setting configured at the field level, or clause level, or template level while the 
currency value is reflected as defined in the agreement record. If the template does not have a locale specified, the 
default locale of English (United States) is applied.

The standard locales available in Contract Management and supported by X-Author Contracts are: English (US), 
English (UK), English (Canada), English (Ireland), Italian, German, Chinese, Japanese, Korean, Thai, Norwegian, 
Swedish, Russian, Portuguese, Polish, Greek (Greece), and Spanish. For more information on how to create custom 
locales, refer to Adding Custom Locale topic in the latest Contract Management on Salesforce Administrator Guide.

Custom locales are created in Contract Management by your system administrators. X-Author Contracts allows you 
to use the values of the custom locales and the associated formatting of various fields while creating templates of all 
types— agreement, clause, proposal, or billing. Within X-Author Contracts, user-defined or custom locales are 
supported with the following features:

Creating a new template or checking-in an existing template
Previewing Reconciliation and Check-in with Reconciliation pages
Using playbook to insert a clause, either smart clause or text clause, and to swap clause
Control Panel
Marking a Clause- The locale drop-down lists the custom locales as well as the standard locales. You can use 
the custom locales to filter the clauses in the Mark Clause search list.
Marking a field- The currency and date format, and currency and number precision convert to the locale setting 
of the template. the default locale used for marking a field is English (U.S.) locale with the following default 
formats:

Date format - m/dd/yy, mm/dd/yyyy, and mm/dd/yy
Currency format- The display format is 1,234,50.46  

Promoting a marked clause: The locale drop-down lists the custom locales as well as the standard locales.
Update From Salesforce
Validate Fields

To use user-defined locales, you must have Contract Management Winter 2019 (1903) version or higher.
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Locale Settings for Templates
Templates can use both standard out-of-the-box locales and user-defined locales. Templates support Date Format, 
Currency Format, Currency and Number Precision for user-defined locales. You must have at least one standard or 
user-defined locale in Contract Management, to use the locales in the template.

If your system administrator deletes a user-defined locale after you have created a template using that locale, 
you'll get a warning message while checking in that template.
If your system administrator deletes all the locales which are by default configured after Contract Management 
package installation, when you create a new template, you'll see a warning message.
If you create a template using a custom locale and your system administrator deletes that locale. When you 
check in that template, you'll see a warning message and your locale value will take the value of the first locale 
in the Locale picklist.
If you delete a locale that you had used at field-level in the template, that field will not show any locale value in 
X-Author Contracts and when you generate an agreement, it will show the original locale.

In such a scenario, you can use the default locale, that is, English (U.S.) to check in the template. Based on the 
version of Contract Management and X-author Contracts, the locale support works as described in the table below:

Contract Management 
Version

X-Author Contracts 
Version

Custom Locale Support

Winter 2019 (1903) or later Winter 2019 (1903) or later Contract Management and X-Author both 
support custom locales and you can use 
custom locales with templates. 

Pre- Winter 2019 (1903) Winter 2019 (1903) or later No custom locales can be created in Contract 
Management and therefore X-Author Contracts 
will not show the user-defined locales in the 
Locale field.

Winter 2019 (1903) or later Pre- Winter 2019 (1903) You can create custom locales in Contract 
Management and use those locales with X-
Author Contracts.

Prerequisites
The template type must be FX2.
Enable Formatting must be selected when creating, checking in or cloning a template to enable field-level 
locale configuration.
To use the template localization feature, the minimum X-Author Contracts version required is 9.0.0306.

Limitations
Locale formatting for templates is only supported in the FX2 format.
Changing locale at check-in is supported only in X-Author Contracts version 9.0.0306 and higher.
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Inserted clauses inherit the locale from the main template and generate using the same locale formatting 
unless the clause template already has a defined locale.
If you have a template configured for a specific locale (e.g., German) that includes inline clauses that are not 
configured for localization then, on generate action the clause will inherit the locale settings from the template. 
So, any Currency, Date, Number, and Precision settings in the main template will also apply to the clause 
when it is generated.

Defining Locale settings for a new template

To define locale settings for a new template enter values in the fields provided as described in the following table. 
Fields marked with an asterisk (*) are required.

Field 
Name

Description

Type* Choose the template type from the picklist (Agreement, Proposal, Clause, etc.).

Business 
Object*

Choose the business object for your template (e.g., Apttus__APTS_Agreement__c for Agreement). 
This picklist is dependent on the value selected for Type.

Locale* Choose an option from the list to change the default locale for the template.

Enable 
Formattin
g

Check this box to enable locale formatting at the template and field level for this template. This allows 
you to define locale settings for Currency and Date formats.

Optional: Specify the following fields when "Enable Formatting" is selected.

Date 
Format

Select a format from the picklist for Date fields in the template.

Currency 
Precision

Enter a number to define the precision for Currency field values in the template (e.g., "2" if the 
Currency field should display two digits following the decimal point.)

Currency 
Format

Select the appropriate radio button to choose the symbol format for Currency fields in the template 
(ISO or Currency Symbol). Select "None" if you do not want to specify a Currency format. All other 
Currency options are hidden.

•
•

To create a new template with locale options, refer to Checking In Agreements in FX2 Format.
For more information on how to create custom locales, refer to Adding Custom Locale topic in the 
latest Contract Management on Salesforce Administrator Guide.



If "Currency Symbol" is selected, Currency fields will be generated with no space between 
the symbol and field value. If "ISO" is selected, Currency fields will be generated with a space 
between the ISO code and the field value.
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Field 
Name

Description

Number 
Precision

Enter a number to define the precision for Number field values in the template (e.g., "2" if the 
Number field should display two digits following the decimal point.)

Defining Locale settings at Check-in

If you want to define or change the template locale when you check it in, specify values for the following fields:

Field Description

Locale Choose an option from the list to change the default locale for the 
template. If you do not change this option, the template locale will 
remain the same.

Enable Formatting Check this box to enable locale formatting at the template and field level 
for this template. This allows you to define locale settings for Currency, 
Number, and Date formats.

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale formatting.

Date Format Select an option from the drop-down to choose the default format for all 
Date fields in the template.

Currency Format Select an option from the drop-down to choose the format for all 
Currency fields in the template. Choose "None" to only display Currency 
field values in generated documents.

Number Precision Enter a number to define the precision for Number field values in the 
template (e.g., "2" if the Number field should display two digits following 
the decimal point.)

Currency Precision Enter a number to define the precision for Currency field values in the 
template (e.g., "2" if the Currency field should display two digits 
following the decimal point.)

Note the following behavior:

All existing configured fields and clauses will conform to the locale of the template prior to check-in and will 
persist on checkout unless explicitly changed. 

After adding a new locale, you must login again in X-Author Contracts.

After you create a new template or make changes to an existing template, you can check-in the template to 
create a new version. To check in a template, refer to Checking in Templates.
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• Any clauses inserted after checkout will adhere to the clause template locale if one has been defined. If not, 
any inserted clauses will adhere to the new locale. 

For a list of locales supported by Apttus, see List of Apttus Supported Locales and Associated Formatting.

Defining Locale settings when Cloning

You have the option to change Locale settings for your template when you clone it. You can specify the following 
fields:

Field Description

Locale Choose an option from the list to change the default locale for the 
template.

Enable Formatting Check this box to enable locale formatting at the template and field level 
for this template. This allows you to define locale settings for Currency 
and Date formats. 

Optional: Specify the following fields when "Enable Formatting" is selected to modify locale formatting.

Date Format Select an option from the drop-down to choose the default format for all 
date fields in the template.

Currency Format Select an option from the drop-down to choose the format for all 
Currency fields in the template. Choose "None" to only display Currency 
field values in generated documents.

Number Precision Enter a number to define the precision for Number field values in the 
template (e.g., "2" if the Number field should display two digits following 
the decimal point.)

Currency Precision Enter a number to define the precision for Currency field values in the 
template (e.g., "2" if the Currency field should display two digits 
following the decimal point.)

To clone a template, refer to Cloning a Template.

If "Currency Symbol" is selected, Currency fields will be
generated with no space between the symbol and field value. If 
"ISO" is selected, Currency fields will be generated with a 
space between the ISO code and the field value.
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a.
b.
c.
d.

4.
5.

Selecting a Locale for the template defaults all Date, Number and Currency values in the template to pre-
defined formats. To see the list of locales and their corresponding formats, refer to List of Apttus Supported 
Locales and Associated Formatting in the Appendix.
You can define formats for the selected locale by specifying the optional Date and Currency formats described 
in the table above. Field format can also be defined from the Control Panel when you are working with the 
template (see Changing Field Format by Locale) 

Use Case: Template with Multiple Locale
Scenario: Template locale is Spanish and field locale is not defined

Consider an organization that needs to create a Memorandum of Understanding (MoU) type of agreement for 
Spanish Locale. To create a template:

Open Microsoft Word and connect to X-Author Contracts.
In the X-Author Templates click New, to create a new template.
To check the localization feature, enter following fields in the template:

Agreement Start Date
Agreement End Date
Agreement End Date
Total Agreement Value

Check in the template with Locale set as Spanish and Enable Formatting selected.
Generate an agreement using the above template. The date fields shall reflect the format corresponding to the 
template locale. This is shown in the following screenshot.

*field values highlighted with yellow are the locale-dependent fields

The generated agreement has all four fields with formats conforming to the template locale, which is Spanish.

For a list of locales supported by Apttus, along with default formats for the above fields, refer to List of 
Apttus Supported Locales and Associated Formatting
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Changing Field Format by Locale
When you create a new template or clone an existing one, you are required to specify a Locale for your template. X-
Author Templates provides template administrators with the ability to define the format for Number, Currency, and
 Date fields using the Control Panel because some scenarios may require you to override formats at the field level. 
This allows you to preserve locale for fields in inserted clauses at the template level while making specific changes to 
other field formats as needed. Generated documents conform to template locale except where specified at the field 
level.

Prerequisites
This feature is only supported in X-Author for Contracts version 9.0.0306 and higher.
Only template documents in FX2 format are supported.
Enable Formatting must be selected when the template is created, cloned or checked in.

To change the format for Date fields
From the X-Author Templates ribbon, select the Control Panel.
Select the field in the document or in the Control Panel. 
In the Properties pane, select the Date Format drop-down and choose the new format.

•

•

If you have not selected Locale value at the field level for the date field in the localized template, then 
its Date Format will be inherited from the template level settings.
If you select the Locale value for a date field from its Field Properties pane, then the Date Format 
attribute will display the list of values corresponding to Locale selected at the field level, and you can 
select the desired format.
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To change decimal precision for Number fields
From the X-Author Templates ribbon, select the Control Panel.
Select the field in the document or the Control Panel.
In the Properties pane, select the Locale drop-down and choose a Locale for the field.

In the Properties pane, enter a number to represent decimal precision for the field (e.g., "2" if the Number field 
should display two digits following the decimal point.)
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To change locale, precision, and format for Currency fields

From the X-Author Templates ribbon, select the Control Panel.
Select the field in the document or the Control Panel.
In the Properties pane, select the Locale drop-down and choose a Locale for the field.
In the Properties pane, make any of the following changes as needed:

Enter a number to represent decimal precision for the field (e.g., "2" if the Currency field should display 
two digits following the decimal point.)
Select a Currency format from the drop-down list: ISO Code, Symbol, or None. If "None" is chosen, 
only the Currency field values will be displayed in generated documents.

For currency fields (for both single currency or multi-currency org), the currency precision and currency 
symbol come from the locale setting at the field level or clause level or template level, if it exists. Whereas, 
the currency value (USD, Pound, INR, etc.) comes from the agreement record.



•

•

For a list of locales supported by Apttus, along with default formats for the above fields, refer to List 
of Apttus Supported Locales and Associated Formatting
If you have a template configured for a specific locale (e.g., German) that includes inline clauses that 
are not configured for localization, then on generate action the clause will inherit the locale settings 
from the template. So, any Currency Format, Date Format, Number and Currency Precision settings in 
the main template will also apply to the clause when it is generated.
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5.

Use-Case

Template with Multiple Locale

Scenario: Template locale is Spanish and field locales are updated with a different locale

After multiple iterations of the above agreement, the organization gets a request where they have to update 
the Agreement Start Date and the Agreement End Date to reflect the German locale. To achieve this:

Open Microsoft Word and connect to X-Author Contracts.
In the X-Author Templates ribbon click Check-Out. Select the template generated in the previous 
scenario to checkout.
Click Control Panel from the X-Author Templates ribbon.
Select the following date fields from the Control Panel, to make locale changes from the properties 
pane:

Agreement Start Date: Change the locale to German. In the properties pane select German as 
locale from the drop-down menu.
Agreement End Date: Change the locale to German. In the properties pane select German as 
locale from the drop-down menu.
Agreement End Date: Keep it as it is.
Total Agreement Value: Keep it as it is.

Check-in the template with the same locale settings.
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To learn more about localization, refer to Defining Template Locale.

6. Regenerate the agreement with the updated template. The regenerated agreement shows updated 
format for the date field values whose locale was updated.

*field values highlighted with blue show the updated locale format. The blue highlighted date field 
now reflect the format corresponding to the German locale.

Thus, with localization feature you can create templates with a specific locale to reflect locale-specific 
precision or date formats.
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Managing Agreements
You can check-out, redline, negotiate, and send an agreement for review from X-Author Contracts. 

In This Section

Checking Out Agreements
To work with any version of an agreement document associated with an agreement record in Salesforce, you must 
open it directly in X-Author For Contracts. When you open the document, you are "checking out" the document. As 
the metaphor implies, it is like checking a book out from a library. After you have checked it out, no one else can work 
with the document until your return it, or "check-in" the document.

Because of this, checking out an agreement document also put a lock on the document, stopping other users from 
editing it while you are working on it. This applies when you initially check-out a document, as well as if you select 
Check-Out > Currently Opened Document after releasing the lock on a document. For more information on how 
document locking works, see Locking Documents.

If your Salesforce org has upgraded to the February 2016 release of Contract Management and has Document 
Finder enabled, skip ahead to Document Finder Checkout. Otherwise, continue with Classic Checkout.

Classic Checkout
From the X-Author Contracts tab in Word, click Check-Out.
Enter an agreement name or number for a search term and click the search icon .
Click Select for an agreement and then click Open to open the desired document.

If the document is currently locked by you or someone else, a message will display who has locked the file and at 
what time. You can use Refresh Lock Status to release a lock you had previously put on the document and begin 
editing the document. You cannot release someone else's lock.

Note

Use a .doc format if you are generating agreements in the pre-FX2 format and a .docx format for generating 
agreements in the FX2 format.



The Comply System Properties setting — Enable Version Control — also used for locking agreement 
documents, is required for this feature. If the feature does not seem to be working, check that this setting is 
enabled.
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a.

b.

c.

5.

6.

If you refresh the lock, you can select Check-Out > Currently Opened Document, to re-apply the lock and enable your 
checked out document to be checked in.

Document Finder Checkout
Document Finder allows you to locate agreement records and agreement documents attached to those records with 
greater ease.

From the X-Author Contracts tab in Word, click Check-Out.
To find the agreement record associated with the agreement record you want to check out, narrow the list of 
agreements on the page using one or more of the provided filters:

Enter an Agreement name or Agreement number and click the search icon .
Use the drop-down to choose a User type and click the lookup button to search and choose from a list 
of users.
Click the lookup button to choose from a list of Primary Contacts associated with the record you are 
looking for.

Click Select to display a list of agreement documents associated with the chosen agreement record.
(Version Aware) Search for an agreement document to check out by Keywords/Tags.

Enter a name or keyword into the Document Finder search box. (Note: If there a predefined tags set by 
the Default Document Tags property, or from previous check-ins of other agreement documents, they 
will be displayed in a drop-down).
Press Enter or type a comma (,) at the end of each name or tag you enter. You can enter any number of 
values. The list of documents updates as you enter each tag.

After you enter a name or a tag, click the 'X' in the tags to remove it from your search. This updates the 
document list to reflect only the current keywords/tags.

(Non-Version Aware) Search for a document by Document Name or Number. Enter a name or number and 
click the search icon  .
If necessary, refine your document search by applying one or more filters. Consult the following table for a list 
of these filters and how to define them. Some filters are only available for Version Aware records.

Note: The functionality of document checkout differs slightly depending on whether you are checking out 
version aware or non-version aware documents.
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Document Filter Version Aware 
Required

Description

Version Yes Choose from All Versions to list all versions of all 
agreement documents which match the current 
search configuration, or Most Recent Version to 
constrain the current list to only the most recent 
versions.

Document State Yes Choose the Document State to list only document 
versions matching the selected Document State 
for the current configuration: All Document States, 
Final, Clean, Draft, or Redlines.

Document Owner (User) No Choose a User type from the drop-down menu 
and use the lookup to search for and choose a 
user to constrain the list of documents to only 
documents owned by the chosen user. You can 
also directly type the name of the user and click 
outside the provided field.

Click Open to check out your document.

If the document is currently locked by you or someone else, a message will display who has locked the file and at 
what time. You can use Refresh Lock Status to release a lock you had previously put on the document and begin 
editing the document. You cannot release someone else's lock. If you refresh the lock, you can select Check-Out > 
Currently Opened Document, to re-apply the lock and enable your checked out document to be checked in.

Checking In Agreements in FX2 Format
Checking in an agreement document saves the changes made to the agreement document in the corresponding 
agreement record in Salesforce. Whether you are saving a redlined version, clean version, final version, or updating 
the current version of the agreement document the process for each is similar and each makes use of X-Author's 
Check-In feature.
Only Microsoft Word documents in .doc and .docx format are supported for maintaining versions and checking in and 
checking out Agreements.

The various options available on Check-In are:

Check-in an Agreement document with redlines.
Check-in an Agreement document without redlines.
Reconcile an Agreement Document when checking in an Agreement document.
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Update the current version of the agreement document.

To check-in agreement document versions
Select an agreement in Salesforce and open an agreement document from the Notes & Attachments (non-
version aware record) or Document Versions (version aware record) related list.
From the X-Author Contracts ribbon in Microsoft Word, use Connect to log in to your Salesforce org.
Make changes as required to the document and then select Check-in to display the Check-In dialog and select 
one of the following options from the Save list.

Option Description (Non-Version 
Aware)

Description (Version Aware)

With Redlines This saves a draft version of the 
agreement document with all markups 
and Redlines is used as the action in 
your org's configured default 
document naming convention.

This saves a draft version of the agreement 
document with all markups and Redlines is 
used as the action in your org's configured 
default document naming convention. 
Selecting this option creates a Minor 
version under the Document Version Details
related list in your Agreement record.
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Option Description (Non-Version 
Aware)

Description (Version Aware)

Without Redlines This saves a draft version of the 
document without markups and is 
typically done before sending an 
agreement to a third party for review. 
Track changes/redlines are 
automatically removed from the Word 
file and _Clean is used as the action 
in the configured default document 
naming convention.

This saves a draft version of the document 
without markups and is typically done 
before sending an agreement to a third 
party for review. Track changes/redlines are 
automatically removed from the Word file 
and _Clean is used as the action in the 
configured default document naming 
convention. Selecting this option creates a 
Major version under the Document Version 
Details related list in your Agreement 
record.

Final - to be signed This saves a version of the document 
without markups and also enables a 
PDF version of the document to be 
created. If this option is selected, both 
a Word and the PDF file will be saved 
to the agreement's Notes and 
Attachments related list. By default, 
_Final is used as the action in the 
configured default document naming 
convention.

This saves a version of the document 
without markups and also enables a PDF 
version of the document to be created. If 
this option is selected, both Word and PDF 
files are created. The PDF file is saved to 
the agreement's Notes and Attachments 
related list and the Word document is saved 
to the Document Version Details' Notes and 
Attachments related list. By default, _Final is 
used as the action in the configured default 
document naming convention. Selecting this 
option creates a Major version under the 
Document Version Details related list in your 
Agreement record.

Select Update Current Version if you only want to update the current copy of the document you are working 
on in Salesforce. If you do not select this option a new document is saved in Salesforce. You can also select 
Reconcile Document along with Update Current Version, to reconcile smart fields.

In the Suggested Name field, enter the required name for the document or leave it as the name suggested by 
X-Author. The default name depends on your version of Contract Management and the default document 
naming convention defined for your org. You do not need to specify a file extension in the Suggested Name
field, as author automatically saves it in .docx format.

This option is not visible if you are checking in a generated version for the first time (the draft must 
have been checked in at least once). Also, any document lock created when the document was first 
checked out will remain. An admin must release the lock or assign the lock to another user for anyone 
else to work with the document.
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11.

Select the required watermark option.
Select Include Watermark, to include the watermark from a non-final version. This option is available 
with the With Redlines and Without Redlines options.
Include Watermark is automatically deselected (greyed out) if you are saving the document as Final - to 
be signed. If there is a watermark in the document, it is automatically removed.

 Select Reconcile Document to synchronize the Salesforce Agreement object fields with those that were 
updated in the document. This option is disabled if your agreement document does not contain changes to 
any smart elements' values. See Reconciliation for more details.
Select Create PDF attachment to have a PDF file saved to the agreement's Notes and Attachments related 
list.
Select Make this document private if you want the agreement document accessible to only the document 
owner and the system administrator. See Marking Agreement Document as Private for further details.
Enter any comma-separated Keywords/Tags you want to associate with the document upon check-in. X-
Author users can filter version-aware agreement documents at checkout based on these keywords/tags. 
Contract Management users can also make use of these tags when using Document Finder on the agreement 
record.

Click the   button to the right of Keywords/Tags to choose from a list of existing tags to apply to the new 
version of the document you are checking in. Click OK to add them to the list of keywords/tags on the 
previous screen.

If you want to use personalized document name by editing the document name in the Suggested 
Name field, the default name of the document specified in the Document Naming Convention 
property will be overridden.

Also, note that the Suggested Name field shows the file name with %version% attribute, which gets 
resolved into the document version number in the file name after checking in the document. For more 
details on the Document Naming Convention property, refer to Comply System Properties topic in 
Contract Management Administrator Guide.



Keywords/tags functionality is only enabled in orgs updated with Apttus Contract Management 
8.4.0321 or higher with Document Finder enabled. For more information on enabling Document 
Finder, refer to Configuring Document Finder in the Contract Management on Salesforce 
Administrator Guide. Keywords/tags can only be used with version aware records.
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Click Finish and then click OK in the confirmation message box. The checked-in document is stored on the 
agreement record based on the record's version aware status:

Version Aware – The updated Word document is stored in the Document Versions related list for the 
agreement if you choose to check-in With Redlines or Without Redlines or Final - to be signed. If the 
Create PDF attachment is selected, the PDF file is created and saved to the Notes and Attachments 
related list.
Non-Version Aware – The updated document (Redlines, Clean or Final) is stored in the Notes & 
Attachments related list.

Restricting Agreement Document Check-in
As an administrator, you can restrict users from checking in agreement documents based on the agreement's 
Agreement Status Category and Agreement Status. To restrict the users from checking in you must use a new 
custom setting Restrict Checkin of Documents. To restrict check-in for an agreement status, you must enter the 
agreement status's code value in the Restrict Checkin of Documents comply system property. To restrict check-in for 
more than one status or status category, you can enter the status or status category names as a comma-separated 
list.

You cannot check-in an agreement document if its status category value is defined in the 'Restrict Checkin of 
Documents' custom setting. If the status or status category of your agreement document is in the list of restricted 
statuses:

When you check-out the document, you cannot edit the document and the X-Author action buttons are 
disabled in the X-Author Contracts tab.
When you click Check-in, you will not be able to check in the document and you'll see an information 
message.

For more information on how to set the custom setting in Contract Management, refer to Comply System Property 
topic in Contract Management on Salesforce Administrator Guide.

Controlling Check-in Save Options Based on User's Profile
You can control the save options available on the check-in page based on the user's profile. For controlling the 
check-in options you must use the custom permissions.

When you click to check in a document, the permissions for your profile are checked and only the options available 
for your role/profile are available on the check-in screen. The remaining options are hidden. If your profile does not 
have any permissions associated with it, you will see all the Save options. If your profile has more than one custom 
permission enabled for the profile, the least restrictive permission is applied to your profile. Following table describes 
the custom permissions and the associated save options available on the X-Author Contracts check-in screen:

Limitation: For an agreement whose status is defined in Restrict Checkin of Documents setting, when you 
download the agreement document and open it in Microsoft Word, the Check-out button is disabled. This 
happens when the X-Author connection is already established and you open the document in Microsoft 
Word.
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Custom Permission Name Save Options Visible

XA_CheckinWithRedlines Update Current Version
With Redlines

XA_CheckInWithoutRedlines Update Current Version
With Redlines
Without Redlines

XA_CheckinAsFinal Update Current Version
With Redlines
Without Redlines
Final - to be signed

To set custom permission for a user's profile, refer to Custom Permissions topic in Contract Management on 
Salesforce Winter 2019 Administrator Guide.

Creating Offline Agreements in FX2 format
Offline Agreements can be created directly in X-Author Contracts, by taking a pre-existing Microsoft Word document 
that was created outside of Salesforce and has not previously been associated with an Agreement, and checking it in.

When a document is open in X-Author Contracts and has not previously been kept in Salesforce, the Check-In option 
can be used for creating an Offline Agreement. There are some mandatory fields that must be completed before a 
new Agreement can be generated, otherwise the fields that can be displayed can be configured. The results are the 
same as creating an Offline Agreement from the Agreements tab in Salesforce.

When you click Check-in, the dialog box will prompt you to select an answer to the question, "Do you want to import 
this agreement document using the FX2 format?" The available answers are "Yes" or "No". After selecting one of the 
options, clicking OK will initiate the New Offline Agreement VisualForce page where you can then enter in details for 
the desired Agreement record.
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The document you want to use must not have previously been uploaded.

With the document open, connect to the Salesforce org where you want to create the offline document.
Go to the X-Author Contracts tab and click Check-In. The Check-In dialog is displayed.

You must be using Contract Management 6.3 or higher, as well as X-Author Contracts 6.3 or higher to 
create offline agreements.
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Select Create as a new offline document and click OK. Optionally, you can choose to make the offline 
document private. For more information on what this means, see Marking Agreement Documents as Private.
In the New Offline Agreement window, enter an Agreement Name for your document, select an existing 
Account, and complete any remaining fields. Click Save.
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Wait for the confirmation dialog to be displayed. Your offline agreement has been completed successfully.

The agreement record is created in Salesforce and the document is attached to the Notes & Attachments related list 
or Document Versions if Contract Document Versioning is enabled.

Mark Clause Menu Actions and Promote Clauses
Using the Mark Clause menu, you can drag and a drop a block of text onto Library node in the Mark Clause menu or 
drag it onto the playbook clause (with the option to replace the agreement text with the playbook text). A marked 
clause can then be promoted to the Playbook for using it in future.

Marking a Clause in an Agreement
During the process of negotiation, a user may find a section of text that they would like to make smart or replace with 
a clause from the Playbook library.

Mark Clause is available for Agreement documents generated from FX2 Templates. This is similar to the Insert 
Section feature in the pre-existing format framework.

 A user can mark a clause in a contract document through one of two ways:

Drag and drop the selected content onto the library node to mark a one-off clause.
Drag and drop the selected content onto a clause in the clause list.

This has implications for the imported document, 3rd party paper and document during negotiation cycles.
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With each action such as insert, modify or delete you make to the smart clause, the Agreement Clause related list in 
your agreement record reflects these changes effectively. For more details, refer to Tracking Clauses in your 
Agreement.

To mark a clause in an agreement
There are two ways to mark a clause in an agreement document:

drag-and-drop document content onto the library node of the Mark Clause panel, to mark it as a "1-off" 
instance of a clause.
drag-and-drop document content onto a clause from the clause list, to assign clause properties to the content 
or replace it with the content of the clause from the Playbook.

To mark a "1-off" Clause
From the X-Author Contracts ribbon, select Mark Clause. The Mark Clause panel is displayed. 
Highlight the content in the contract to be marked as a clause.
Drag and drop the highlighted content onto Library node in the Mark Clause panel:

The Mark Clause form is displayed.

Mark Clause button is disabled in the X-Author Contracts ribbon if your agreement's protection mode is: 
Read Only, Fill in Form Fields, or Insert comments.
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4. Fill in the following fields in the form (fields marked with an asterisk (*) are required):

Field Description

Action This drop-down list shows various actions you can perform with 
the selected clause. By default, Inserted is chosen and is Read-
Only.

Clause Name Type a name for the 1-off clause.

Category Select a Category for the 1-off clause.



X-Author Contracts on Salesforce Winter 2019 User Guide

141 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

•
•
•

5.

Field Description

Sub Category Select a Sub Category for the 1-off clause. This drop-down list 
is dependent on the Category drop-down list.

Exception Select a term exception record from the drop-down list to 
associate with your clause.

Risk Rating Select an appropriate risk rating for your clause. Valid values 
are:

Green
Red
Yellow

Materially Significant Select this check box if you want to make your clause materially 
significant.

Clause Text (Selected) This text area shows the selected text which you want to mark 
as a clause.

Click Save to mark document content as a 1-off clause. The clause is marked as smart in the document and a 
confirmation dialog is displayed.

Any smart fields in the original content will be preserved in the newly-marked clause. The clause is displayed in 
the Control Panel when you have the document checked out.
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Check-In and/or Reconcile your document when you are finished.

To mark document content as an existing clause
From the X-Author Contracts ribbon, select Mark Clause. The Mark Clause panel is displayed. 
Highlight the content in the contract to be marked as a clause.
Drag and drop the highlighted content onto the desired clause in the Mark Clause panel:

The Mark Clause form is displayed.

The Mark Clause menu user interface is enhanced to now show a flat list of clauses under Library 
node. Earlier the Mark Clause menu showed clauses in a hierarchy tree according to the Category or 
Sub-category.
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4. Fill in the following fields in the form (fields marked with an asterisk (*) are required):

Field Description

Action This drop-down list shows various actions you can perform with the 
selected clause. By default, Inserted is chosen and is Read-Only.

Clause Name Enter a name for the clause. This field is pre-populated with the 
name from the clause library. If you change the name, the clause will 
adopt the properties of the one in the library, but be displayed with 
this clause name in the document Control Panel.
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Field Description

Category Select a Category for the clause.

Sub Category Select a Sub Category for the clause. This drop-down list is 
dependent on the Category drop-down list.

Exception Select a term exception record from the drop-down list to associate 
with your clause.

Risk Rating Select an appropriate risk rating for your clause. Valid values are:
Green
Red
Yellow

Materially Significant Select this check box if you want to make your clause materially 
significant.

Clause Text (Selected) This text area shows the selected text which you want to mark as a 
clause.

(Optional) Select Replace the current clause selection with the one from the library? to replace the clause 
content with content from the clause in Playbook. If you choose this option, the following dialog is displayed.

If the content to be marked was dropped onto a clause and 
the Category picklists in the Template and Agreement 
Clause objects in your org are the same, this field will be 
automatically populated.



If the content to be marked was dropped onto a clause and 
the Sub Category picklists in the Template and Agreement 
Clause objects in your org are the same, this field will be 
automatically populated.



Clause properties defined in this form will override any properties inherited from the associated 
clause, unless you choose to replace the selection with a clause from the library (see below).
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6.

7.

1.
2.

When click Save to mark a clause that replaces content with a clause from the library, if your marked content 
contains any smart fields, you will be prompted with the message, "The current selection contains Apttus fields 
which will be deleted and replaced with the contents of the clause. Do you wish to proceed?"
Click Yes to confirm replacement or No to cancel.

Click Save to mark the clause clause in your document. The clause is marked as smart and a confirmation 
dialog is displayed.
Check-In and/or Reconcile your document when you are finished.

Recording Marked Clause Activity on the Agreement Record
With each action on the smart clause, such as insert, modify or delete, the Agreement Clause related list in your 
agreement record reflects these changes effectively. For more details, refer to Tracking Clauses in your Agreement.

Comparing Marked Content with the Clause Library
Prior to, or after you mark a clause in your document, you can compare the text of the marked clause with the content 
of the associated clause in Playbook. To compare content:

Highlight the marked text (or text to be marked) and click on the associated clause in the Mark Clause panel.
By default, the Clause Text is displayed in a tab below the Mark Clause panel.
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3.

•
•

1.

Click Compare with Library to show diff text between the marked content and the clause from the Library.

To unmark a clause in an agreement
Ensure that you have marked a clause in an agreement document opened in X-Author Contracts ribbon.
You can unmark a clause in the same session as you marked it.

From the X-Author Contracts Ribbon, click Control Panel to open it.
Make sure you deselect both, Show changed clauses only and Show clause library for marking check boxes to 
view all the clauses.

Limitation on indented content: if the content you are marking has an indent (tab) at the beginning of the first 
paragraph and you mark the content as a clause, when you choose to Show Changes from the Control 
Panel, the text will no longer be indented. To correct this, prior to marking the clause, remove the indent from 
your text and use Tab to indent the text. From the auto-correct menu which appears, select "Change Back to 
Tab." You may then mark the clause as normal and the indent will be visible when you choose to Show 
Changes.
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2.
•
•

Right click on the marked clause in the Control Panel and do any one of the following:
Click UnMark Clause.
Click Edit Marked Clause Properties. You will see the message with the clause properties. Click 
Unmark.
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3.
4.

•

•

•

•
•

Click Yes to confirm unmarking of the clause.
You will receive a confirmation message with the clause name. Click OK to finish unmarking the clause.

You have unmarked a clause in the same session as you marked a clause.

With each action on the smart clause, such as insert, modify or delete, the Agreement Clause related list in your 
agreement record reflects these changes effectively. For more details, refer to Tracking Clauses in your Agreement.

Searching Clauses in Mark Clause Menu
Using the Mark Clause menu, you can drag and a drop a block of text onto either clause Library node (root node) or 
drag it onto the playbook clause (with the option to replace the agreement text with the playbook text). A marked 
clause can be then be promoted to the Playbook for future use. The Mark Clause menu displays the list of clauses in 
an alphabetized ascending sequence from A to Z. Mark Clause menu has following features to help you in searching 
the desired clause faster:

The Mark Clause menu lists only those clauses which have the Record Type same as the Record Type of the 
agreement document currently opened in the X-Author Contracts.
The clauses listed in the Mark Clause menu, under Library are sorted in ascending alphabetical order, from A 
to Z.
The Mark Clause menu has search feature with a search box which searches per the search string entered by 
you. The search feature searches in the Clause Name, Keywords and clause Description fields.
The search string is not case sensitive.
The search feature also has an advanced filter which filters the clauses based on Category, Sub-category, 
Locale and Language.
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1.

2.
•
•
•

Using the Search Box
To search clauses in the Mark Clause menu:

Go to X-Author Contracts tab and click Mark Clause.  This opens the Mark Clause menu in the right hand side 
of your Microsoft Word Document window.

To search with a search string, type the search string in the search box on the top of the menu and click Go.
The search box shows result according to full or partial search string entered.
The search box does not accept special characters including *, |, :, ", <, >, ?, \, /.
You can also perform search with wild character %. 
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•
•
•
•
•

•

Using Clause Filters
The search feature of mark Clause menu has some pre-built filters to further refine your clause search. These filters 
are under the search box.

Advanced filters can refine the search based on following four type of pre-built filters:
Category,
Subcategory,
Language, and
Locale

The four advanced filter are all picklist fields and you can select the picklist values from the drop-down.

i.
ii.
iii.

Use Case

If you want to search a clause or list of clauses which have the words Non and Clause in their 
name, you can use the wild character "%", in your search string.

Go to Mark Clause menu.
In the search box, type "Non%Clause" and click Go.
The search result will show all the clauses with the words "Non" and "Clause" in their 
name
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•

•

1.
2.

The search results are shown after logical AND operation of the search string in the search box and the values 
selected in the above four advanced filters.

Resetting Search
Reset clears out all the filter and search parameter including the search string and the advanced filter selection.

To reset all the search parameters click Reset in the Mark Clause menu.

Promoting a Marked Clause to the Playbook
Using Promote Clause you can mark a clause in X-Author Contracts and promote it directly to the Playbook. Earlier, 
you could promote the clauses to Playbook only through the X-Author Templates ribbon. Now, as a system 
administrator, you can select any content in the agreement document, mark the content as a clause and then promote 
it to the clause library.

If your clause contains Smart fields, Playbook takes these Smart fields as text only.

To promote a marked clause to the Playbook
You must have a marked clause in X-Author Contracts.

On the X-Author Contracts tab, click Promote Clause ribbon.
From the list of marked clauses, select the clauses you want to promote to the clause library.

•
•

•
•

Use Case

If you want to perform a complex search for a clause you can leverage the search box and the advanced filter 
to get a more accurate search result. if you want to search a clause in Spanish language, from Procurement 
category and having the word "Sales" in its title you can do it in the following manner:

In the search box type "Sales"
In the advanced filter Category field, select Procurement from the picklist and in the Language field, 
select Spanish from the picklist.
Click Go
The clause or clauses, fulfilling all the three conditions outlined above will be shown in search results.



Promot Clause button is disabled in the X-Author Contracts ribbon if your agreement's protection mode is: 
Read Only, Fill in Form Fields, or Insert Comments.
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3.
•
•

4.

5.
•

Do one of the following:
Click Next to move to the Check-In Clause dialog.
Click Cancel to cancel promoting the clause to Playbook.

In the Check-In Clause to Playbook dialog, enter a mandatory Name, Category, Subcategory, and Language
for the selected clause. This is similar to checking in a clause from X-Author Templates ribbon.

Do one of the following:
Click Back to move back to step 2.



X-Author Contracts on Salesforce Winter 2019 User Guide

153 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

•
•

•
•

•

Click Finish to complete promoting the selected clause to the Playbook.
Click Cancel to cancel the clause promotion.

You have promoted the marked clause to the Playbook. You can open Playbook and search for the promoted clause 
to use it in any other document.

X-Author Contracts Control Panel
The Control Panel can be accessed from the X-Author Contracts ribbon tab. The Control Panel enables you to view 
all of the fields, sections, and tables in an Agreement document that uses the new FX2 format. To access the Control 
Panel, click Control Panel in the X-Author Contracts ribbon tab. The Control Panel opens in a side panel in Microsoft 
Word.

Within the Control Panel, you can view the fields and clauses that have been tagged within an Agreement document. 
The Control Panel lists all smart fields and clauses in the order they appear in the document.

Fields - You can view the Field Name and the previous value and the current value of that field.
Clauses - You can view the Clause Name, check if the content in the clause is changed or not and also mark 
the clause for deletion.

You can also use the Filters section above the field columns to filter the results in the Control Panel by selecting the 
following options for fields and clauses.

For fields, use Show changed fields only to list only those fields whose values have been changed and use
 Show fields for marking to list the fields with its field types which can be used for tagging.

Note

From November 2015 release onwards, ensure that you have at least one smart field or smart clause in your 
agreement document to access the Control Panel ribbon tab in X-Author Contracts. Accordingly, you can view 
the Fields or Clauses tab within the Control Panel.
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•

           

For clauses, use Show changed clauses only to list only those clauses whose content has been changed and 
use Show clause library for marking to display the clause library to further mark a clause in the agreement 
document. You can also view the difference between the selected text and the text from the clause library. The 
red strike-through shows the deleted content and the content in blue shows the new content.



X-Author Contracts on Salesforce Winter 2019 User Guide

155 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

• X-Author Contracts Control Panel is enhanced to show highlighted clause name in the Clauses tab of the 
Control Panel when you select any text of the corresponding clause in the body of the agreement document. 
This ensures that while deleting clauses from a document you don't accidentally delete a wrong clause.
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•
•
•

1.

2.
3.

a.
b.

4.
5.

Changing the position and the width of the Control Panel
When the Control Panel is opened up, you can move it to other locations within Microsoft Word. By clicking and 
holding on the title bar, you can move the Control Panel to the top, left, right, or bottom of Microsoft Word. You can 
also change the width of the Control Panel by using the left column of the Control Panel for Fields and Clauses tabs.

When you expand the Control Panel, the leftmost column also moves with the cursor. In cases where you decrease 
the size of the Control Panel to a greater extent, use the scroll bar to view the various columns. Even tooltips for each 
record in the fields tab help you view the previous and current value of each record.

Clause Control Panel Actions
The Control Panel under X-Author Contracts enables you to perform the following actions:

Reject Clause Changes to an Agreement Document
Mark Clauses for Deletion
Remove Clauses Inserted in the same session

Rejecting Clause Changes in an Agreement
X-Author Contracts also enables you to accept or reject the changes you make to the clause content in a generated 
document. When viewing a redlined agreement, you will need to reconcile changes in the clauses. Clause changes 
and clause reconciliation with X-Author Contracts is absolute, either you accept the entire change (default) or reject 
all changes. Unlike Fields and Tables, clauses during any reconciliation are Read Only. You can reject a change in a 
clause from the Control Panel. Select a changed clause from the Control Panel and in the bottom pane, you will see 
the differences in the current clause to the previous clause.

To reject clause changes in an agreement
From the X-Author Contracts Ribbon, click Control Panel to open it. By default, Show changed clauses only is 
selected to view only the changed clause records.
You can adjust the column width in the Control Panel by drag and drop functionality.       
Right-click any clause which has Changed checkbox selected against it.
Click any one of the following:

Click Reject Changes if you do not wish to keep the changes in the clause.
Click Show Changes if you want to view the changes made to the clause. The newly added content is 
visible in blue and the deleted content in red.

If you chose to reject the changes, the following confirmation message appears.
Click Yes to remove the changes from the clause or click No to retain the changes in the clause.

You have either accepted or rejected the changes made to the marked clause in the generated document. You can 
now Check-In the document.
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1.
2.

3.

4.

Deleting Clauses from an Agreement
There will be times in the negotiation when the other party will want to delete a clause. In X-Author Contracts, only the 
Apttus user can delete smart clauses. During the negotiation of a contract the other party may highlight and attempt 
to delete a clause, but to the Apttus user, they will see a clause with a boundary that has been wholly redlined.

X-Author Contracts allows you to mark a clause for deletion and deletes the clause content from the document after 
you reconcile the document back to Salesforce.

Following reconciliation, the changes in the deleted clause are visible on the Agreement Clause related list on the 
Agreement record. For more details, refer to Tracking Clauses in your Agreement.

To delete a clause from the Control Panel
Open the Control Panel from the X-Author Contracts ribbon.
Click the Clauses tab in the Control Panel and clear Show changed clauses only checkbox to display a list of 
clauses in the document.

Select the check box under the Marked for Deletion? column corresponding to the clause you want to delete. 
A confirmation dialog is displayed.
Click Yes to mark the clause for deletion. The clause is now marked for deletion. If you have tracked changes 
enabled for the document, the content of the marked clause is redlined.

X-Author Contracts Control Panel is now enhanced to highlight the name of the clause in the Control 
Panel when you click the clause body text in the agreement document. Use X-Author Contracts 
version 9.0.1201 or later for accessing this feature.
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5.

1.

2.

3.

Make any additional changes to the document, including marking other clauses for deletion. Check-in the 
document to complete deletion of the clause. The Check-in dialog displays all clauses marked for deletion.

To delete a clause inserted from Playbook in the same session
You can mark a clause for deletion which has been inserted in the same session to remove it from the agreement 
document prior to check-in. A session refers to the time between checking out an agreement document and checking 
it in.

Open the Control Panel > Clauses tab and clear the Show changed clauses only check box to display a list of 
clauses in the document.
Click thecheck boxunder Marked for Deletion? corresponding to the clause you previously inserted. A 
confirmation dialog is displayed.
Click Yes to remove the clause from the agreement document. The clause is removed from the document as 
well as the list of clauses displayed in the Control Panel.

To unmark a clause for deletion
You can unmark a clause which has been marked for deletion in the same session. A session refers to the time 
between checking out an agreement document and checking it in.
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1.

2.

3.

1.

2.

1.

2.

3.

Open the Control Panel > Clauses tab and deselect the Show changed clauses only check box to display a 
list of clauses in the document. Note the clause which has been marked for deletion.
Select the checkbox corresponding to the clause which has been marked for deletion. A confirmation dialog is 
displayed.
Click Yes to unmark the clause for deletion. The check box is no longer enabled. Any redlines applied to the 
clause when it was marked for deletion are removed.

Your clause is unmarked for deletion.

Field Control Panel Actions
The Control Panel of X-Author Contracts allows you to reject the changes made to the smart fields in your agreement 
document with just a right click on the smart field. This is applicable when you want to negotiate only certain part of 
your agreement document without changing the rest of the content.

Also, if there are multiple occurrences of the same smart field in a single agreement document, but with different 
values, you can decide a single value for that smart field for all of the occurrences across your agreement document.

Rejecting the Field Changes in an Agreement
During the multiple rounds of negotiation, there can be changes made to the smart fields in your agreement 
document. As a contract administrator, you can decide to perform any one of the following 2 options in the Control 
Panel.

Accept the changes made by the negotiators: The changes are accepted implicitly by the system when you 
Check-In the document.
Reject the changes made by the negotiators: Use the Control Panel to navigate to your smart field and reject 
the changes made to it.

For example, your customer may want to start the agreement at a date later than originally proposed date. After your 
customer changes the Agreement Start Date, you can review the change and decide to either implicitly accept or 
explicitly reject the change.

The Control Panel within the X-Author Contracts ribbon supports the above mentioned feature with the help of a right 
click. You can accept or reject the field changes before you check in the document to Salesforce.

To reject field changes in an agreement
You must have an agreement document containing changes in the field values open under the X-Author Contracts 
ribbon.

From the X-Author Contracts ribbon, click Control Panel to open it. By default, Show changed fields 
only checkbox is selected to view only the changed field records.
You can adjust the column width in the Control Panel by dragging and dropping the left column of the Control 
Panel.
For each field containing a change in its value, you see its Previous Value and Current Value (marked in 
red). Right click on the field label.
Click the Reject Changes to reject the change made to the smart field.
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4. Click Yes on the confirmation message to remove the changes from the agreement document.

The Current Value column reflects the earlier value of the smart field and is no more marked in red.

While you Check-In or Preview Reconcile the agreement document, the field values will be reflected at the Reconcile 
Smart Fields dialog box.

Viewing multiple occurrences of the Smart fields in an agreement document
The Control Panel within the X-Author Contracts ribbon enables you to view the multiple occurrences of a smart field 
and choose a single value, thereby bringing uniformity of the field value across the agreement document. By default, 
the first occurrence of the smart field is shown in the Control Panel.

If the same smart field occurs more than once in your agreement document, you can now view the various values of 
the same smart field by clicking the link on the field label and choosing the value which you want to display across all 
of its instances in the agreement document.

To view multiple values of a Smart field in an agreement document
You must have made changes to the values of the smart field which appears more than once in your agreement 
document.
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1.

2.

From the X-Author Contracts ribbon, click Control Panel to open it. By default, Show changed fields 
only checkbox is selected to view only the changed field records.

You can adjust the column width in the Control Panel by dragging and dropping the left column of the Control 
Panel.

Click the link on the smart field to view the dialog box containing all the occurrences of that smart field. For 
example, if Agreement Start Date is occurring more than once in your agreement document, it has a link to 
view all of its values, like shown in the below dialog box.
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3.

4.

•
•
•

1.

You can select the radio button against the value which you want to keep for your smart field across your 
agreement document. In our example, if you want to keep 7/23/2015 as the Agreement Start Date, select the 
radio button next to it.
Click Select.

The smart field will now contain the final value under the current value column.

Removing Smart Fields from an Agreement
There will be times in the negotiation when a negotiating party wants to remove language from an agreement that 
contains a smart field. Depending on document protection settings, non-Apttus users can remove content from the 
agreement, but any smart field content removed will not remove the field itself. Follow the instructions on this page to
 mark fields for removal. You usually want to mark fields for removal when:

An Apttus user marked static text as a field.
A Template Admin marked a field as smart.
You need to delete a smart clause from an agreement document.

To remove a Field
Open the Control Panel from the X-Author Contracts ribbon.

Note

Using this feature only removes the smartness of a field, not the content. Once the field is no longer smart, 
negotiating parties can make changes as required.
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2. Click the Fields tab in the Control Panel and deselect Show changed fields only to display a list of fields in the 
document. Where there are multiple occurrences of the same field in the document, this will be noted in 
parentheses after the field name (e.g., if there are 3 occurrences of "Agreement Start Date," the first instance 
is displayed as "Agreement Start Date (1/3)").
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3.

4.

Right-click on the field you want to remove and click Mark for Removal.

(Single Occurrence of Field) Click Yes to confirm marking of the smart field for removal or No to cancel.
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5.
a.
b.
c.

6.

7.

(Multiple Occurrences of Field) Click on one of the following:
Yes to mark all occurrences in the document for removal.
No to mark only the selected occurrence for removal.
Cancel to return to the document without making any changes.

Review fields in the Control Panel and document which are marked for removal. Note that any fields marked 
for removal will be stricken through in both the Control Panel and body of the document, in addition to any 
redlining in the Word document itself.

Make any additional changes to the document, including marking other fields or clauses for deletion. Click
 Check-in. 
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8.

9.

10.

Choose Reconcile Document to permanently remove smartness from any fields.

Click Next to preview the smart fields marked for removal. All smart fields marked for removal are stricken 
through and each occurrence is listed separately.

Click Next to reconcile any clauses as needed.
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11.

1.

2.

Click Finish. The document is checked in and smartness is removed from all marked fields. No values on the 
record are affected by smart field removal. All removed smart fields in the document are converted to static 
text.

To unmark a field for removal
You can unmark a field which has been marked for removal in the same session. A session refers to the time between 
checking out an agreement document and checking it in.

Open the Control Panel > Fields tab and deselect the Show changed fields only check box to display a list of 
fields in the document. Note the field or fields which have been marked for removal.

Right-click on the field or fields marked for removal and choose Unmark for removal.
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3.

4.
a.
b.
c.

(Single Occurrence of Field) Click Yes to confirm unmarking the smart field for removal or No to cancel.

(Multiple Occurrences of Field) Click on one of the following:
Yes to unmark all occurrences in the document for removal.
No to unmark only the selected occurrence for removal.
Cancel to return to the document without making any changes.
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•
•
•

Marking Agreement Documents as Private
X-Author Contracts allows you to mark documents as private whenever you take one of the following actions:

Check-In an agreement document
Create Offline Agreement
Import Offline Agreement 

When you mark a document as private it sets the Is Private field for a specific record/action (Check In or Import 
Offline Agreement) of the Merge Event object to true. You can then use this flag to create custom triggers on the 
Agreement record for controlling permissions to your documents. You are encouraged to work with Apttus 
Professional Services to develop a solution for your private documents.

To mark an agreement document as private at check-in

In previous versions of X-Author Contracts, the default behavior for documents in your system was to set the 
default value for all draft documents to private (Is Private = true) and all final documents to public (Is Private 
= false).



Check-in dialogs may appear differently depending on whether your agreement uses Pre-FX2 or FX2 format.
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1.
2.
3.
4.

5.

Open Microsoft Word and log in to X-Author Contracts.
Check-out an agreement document from an existing agreement record.
Make any changes as required.
Click Check-in to open the Check-in Document dialog.

Select the check box under Version Details to Make this document private.
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6.

1.

Click Finish to check-in your document.

In Apttus Contract Management, the Merge Event Detail page on the Merge Event related list shows the Check-in 
event flagged as Is Private.

To mark an offline agreement as private
Open an offline document in Microsoft Word.
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2.

3.
4.

Click Check-in to display the Import Offline dialog.

Choose the document format and choose to either Create or Import an offline document.
Select the checkbox under Version Details to Make this document private.
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5. Click OK and complete any additional steps required to create or import your offline document.

In Apttus Contract Management, the Merge Event Details page on the Merge Event related list shows the Create 
Offline Agreement event flagged as Is Private.
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•

•

•
•
•
•

Private Indicator Properties
There are two Comply System Properties that control the availability and behavior of the option to make documents 
private from X-Author:

Auto Enable Private Indicator– When this property is enabled, the Make this document private checkbox is 
automatically selected and cannot be deselected.
Allow Private Selection Override – When this property is enabled, the Make this document private checkbox 
option can be overridden when Auto Enable Private Indicator is set to true.

Depending on how the above properties are configured, when you check-in or create offline agreements, you may 
notice the Make this document private option is already enabled and can or cannot be changed. The following table 
describes how the combination of properties affects your ability to make documents private during one of these 
actions.

Auto Enable Private 
Indicator

Allow Private Selection 
Override

Available Action

FALSE FALSE Make this document private is not 
automatically enabled. You can enable this 
option during check-in or creation of an 
offline agreement.

TRUE FALSE Make this document private is automatically 
enabled. You cannot override the option for 
any document version.

TRUE TRUE Make this document private is automatically 
enabled. You can override the selected 
option for each document version.

Making Fields Updatable
Update fields are fields with content control border and their values can be updated after document generation using 
Update from CLM. These fields are different from smart fields and merge fields in that they are not inline like merge 
fields and their values cannot be edited like smart fields. If you have generated an agreement document using a 
template containing Update fields and later want to update the values of the field without generating or regenerating 
another document, you can click Update from CLM and the values of the Update fields will be updated from the CLM 
agreement record. This is useful when you need to use the same agreement as a baseline document for creating 
another agreement with the same content but for a different agreement record. All the fields which cannot be marked 
as smart but need to be updated with the values from the new agreement record can be made Update fields.

Update fields have following characteristics:

Any field can be made an Update field.
Update fields cannot be made Smart.
Update fields can only be defined in a template.
The value of the Update fields cannot be edited in the generated agreement document and can only be 
updated.
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Update fields show a content control boundary in the generated agreement documents.

To mark a field as Update Field
Insert the field into your template by following the steps in Inserting Fields into a Template or Inserting Line 
Item Fields.
From the X-Author Templates ribbon, select Control Panel.
Search for and click the field in the Navigation Pane to highlight it in the document.
Right-click the field name in the Control Panel and select Mark as Updatable.

The value next to Mark as Updatable? in the Properties pane, under the Control Panel, is updated to "True" and 
simultaneously the value next to Mark as Smart? is updated to "False."

To delete an Update field
From the X-Author Templates ribbon, select Control Panel.
Search for and click on the field in the Navigation Pane to highlight it in the document.
Right-click on the field name in the Control Panel and select Remove Field.
Click Ok in the confirmation dialog box.

The Update field is deleted from the template.

Marking Fields
Using Playbook, you can mark small chunks of agreement document content as fields. When you mark content in an 
agreement document as a field, it becomes a smart field. Smart field values can be reconciled with data in the 
agreement record when the document is checked in, allowing changes made during negotiation to be accurately 
reflected and managed as data in Dynamics. Content marked as a field must map to the data type of existing fields in 
your agreement record. 

To mark a field in an agreement
From the X-Author Contracts ribbon, select Mark Field to bring up the Mark Field window.

To Unmark an Update Field, right-click the field in the Control Panel and select Unmark as Updatable. You 
can also make this change by changing the value in the Properties pane from "True" to "False."



Marking a field in a single agreement does not mark the field across all other documents for the same 
agreement record.



Mark Field button is disabled in the X-Author Contracts ribbon if your agreement's protection mode 
is: Read Only, Fill in Form Fields, or Insert Comments.





X-Author Contracts on Salesforce Winter 2019 User Guide

176 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

2.

3.

Highlight the field you want to mark, and drag-and-drop it onto the corresponding Field Label in the Mark Field 
window.

Click Yes to mark the highlighted text as a smart field.

The field is marked and highlighted in the document by a content control.
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Open the Control Panel to view changed fields. The marked field is listed, showing its current value.

Click Validate Fields to ensure that the newly marked field is in a valid format for the data type of the field 
mapped. 
When you are finished marking other fields and working with your document, Check-In the agreement 
document and Reconcile fields to the agreement record in Dynamics.

Marking Fields with Hidden Boundaries
Because smart field boundaries can be hidden in agreement documents, text you attempt to mark as a smart field 
may already be a smart field in the document, just not visible. If you have the proper permissions to use the feature, 
make sure to show smart boundaries (X-Author Contracts ribbon > Hide Smart Boundary) before marking any fields. 
If the text you are marking is already a smart field, the following message will be displayed in Word.

Validating Fields
Validate Fields enables the user to ensure that inserted fields are legitimate. The validation is for proper data type 
values in the field (date, number, etc.) and valid selected values from picklists, multi-picklists, etc. Validate Fields is 
only available for FX2 formatted Agreement documents.

Prior to checking in an Agreement document, the user can click Validate Fields. If any field is invalid, a dialog box will 
appear, alerting the user about the invalid fields. If all fields are valid, the user will get a dialog box confirming that all 
fields are valid. If a field is invalid, the document cannot be reconciled.

Hiding Smart Boundaries
You can control the visibility of bounding boxes using the Hide Smart Boundary action in the X-Author Contracts tab.

Prerequisites

Ensure that you have at least one smart field in your agreement document to access Validate Fields ribbon 
tab in X-Author Contracts.
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You must have Microsoft Office 2016 or later installed on your system.

Smart fields and smart clauses in an agreement document are represented in Microsoft Word as a content control, 
with a bounding box that displays it as a smart element.

To hide smart boundaries in an agreement document
Open Microsoft Word and connect to X-Author Contracts.
Open or check out a document that contains smart fields or clauses.
From the X-Author Contracts tab, click Hide Smart Boundary to toggle smart boundaries off. The button is 
highlighted in the tab and bounding boxes are no longer shown around smart elements.

Hide Smart Boundary button is disabled in the X-Author Contracts ribbon if your agreement's protection 
mode is: Read Only, Fill in Form Fields, or Insert Comments.





X-Author Contracts on Salesforce Winter 2019 User Guide

179 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

4.

•
•
•

Click the button again to toggle smart boundaries on.

During contract negotiation, it may be necessary to insert clauses or make changes to smart elements. When 
boundaries are hidden in a document, they are automatically displayed if:

a field or clause is highlighted in the document body or Control Panel
a clause is inserted into the agreement document
a field or clause is marked in an agreement document

Smart elements remain automatically displayed in a generated document when a field/clause is marked. X-
Author users still have the option to manually show/hide boundaries.
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Highlighting Smart Fields (FX2)
If your org is properly configured, you can add a feature to the Control Panel that lets you highlight smart fields in your 
document. You can also configure X-Author Contracts to automatically highlight all smart fields in your document, 
while retaining the ability to toggle the highlighting on or off.

Configuring Smart Field Highlighting for FX2 Agreements
Enabling Smart Field highlighting requires proper permissions to create a new Admin entry in the connected 
Salesforce Org. The following Admin properties must be configured:

Admin Property Description Possible Values

APTS_HighlightFieldsUsingControl
Panel

Adds a check box to the Control Panel in X-
Author Contracts that allows users to toggle 
highlighting of smart fields in the document on/
off.

True/False

APTS_DefaultHighlightFieldsContr
olPanel

Automatically enables the "Highlight fields" 
check box when you open a document in X-
Author Contracts.

True/False

To configure Smart Field highlighting for FX2 format agreements
Log in to the connected Salesforce Org.
Go to the Admin tab in Apttus Contract Management.
Click New to add a new Admin property.
Enter "APTS_HighlightFieldsUsingControlPanel" into the Name field.
Enter "True" into the Value field.
Click Save.

To configure X-Author to highlight Smart Fields by default for FX2 format agreements
From the Admin tab in Contract Management, click New.
Enter "APTS_DefaultHighlightFieldsControlPanel" into the Name field.
Enter "True" into the Value field.
Click Save.

Highlighting Smart Fields in an FX2 Agreement
After you configure Admin properties to enable highlighting, you can highlight smart fields in your agreement 
document. (Note: the following example assumes you do not have all smart fields highlighted by default)

Open Microsoft Word and connect to X-Author Contracts.
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Check Out the agreement document you want to work with.
From the X-Author Contracts ribbon, select Control Panel. By default, the Fields pane is displayed.

Select the Highlight fields checkbox (shown in the image above). All smart fields in the open document are 
highlighted.

Updating Fields from Salesforce (FX2)
Update from Salesforce is an action located in the X-Author Contracts ribbon you can use to update smart fields in 
your agreement document where fields have been updated in Salesforce since the document was generated. Update 
from Salesforce updates all header, 2nd and 3rd level smart fields located in your document, including:

Smart and read-only fields in the body of the agreement document.
Smart fields in sections.

Mark Field and Highlighting

If you have smart field highlighting already enabled and choose to mark text in your agreement as a smart 
field (by way of the "Mark Field" option), the new field is not automatically highlighted. Close and reopen the 
Control Panel to apply highlighting.
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Smart fields in tables or repeating data sets. Adding a new line item in Salesforce and updating will create a 
new row in the table.
Smart fields in generated clauses.

To update smart fields or read-only fields
Check out your agreement document.
Click Update from Salesforce to display a dialog showing all header-level fields in the document. Field values 
that have been changed on the Salesforce record are highlighted in yellow.

Review the changed values and click Next to continue. The next page displays fields contained in sections and 
tables. Changed field values are highlighted in yellow.
Click Update. All highlighted field values are updated in the document to reflect changes made to the record 
in Salesforce.

•

•

•

•

If you choose to update fields from Salesforce, all changed smart field values will be updated. You 
cannot select only specific fields.
Adding new line items to a Salesforce record and updating will only add a new row to the agreement 
document if a table exists containing those fields.
If your agreement was generated when the agreement line items were not created, you can use 
Update from Salesforce to update the empty table's values in the agreement document.
Fields cannot be updated to or from an empty (null) value.



Fields updated from Salesforce are not marked in the Control Panel as changed.
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Your field values are updated with the values of Contract Management.

Unlocking Read-only Clauses
Read-only clauses are clauses with content control boundary whose text cannot be edited in a generated agreement. 
However, as a Contract Administrator, you can grant certain users the permission to unlock the read-only clauses in 
the agreement document. This feature gives you more control on clause access and you can speed up the review or 
negotiation process by allowing certain users to edit the read-only clause. You can use the custom permission
 XA_UnlockReadOnlyClause to give edit access to read-only clauses. This permission must be associated with the 
user's profile to provide the user the access to the read-only clauses. When you enable XA_UnlockReadOnlyClause
custom permission for a profile, the users of that profile get access to the Unlock Clause toggle button in X-Author 
Contracts toolbar. Clicking Unlock Clauses scans the entire document and unlocks are the read-only clauses present 
in the document. Update from Salesforce does not impact read-only clauses.

You can delete a read-only clause when:

a) You have edit access to the read-only clause, which means, XA_UnlockReadOnlyClause custom permission is 
enabled. 

b) UnlockSmartElement custom setting is enabled, which means, the smartness property of the clause is unlocked.

To unlock a read-only clause
Check-out the agreement document in X-Author.
Go to the Review section of the toolbar and click the downward arrow.
Click Unlock Clause.

When you unlock a read-only clause, modify it, and then check it in, the modified clause appears in the Reconcile 
Smart Clauses page of the check-in window.

Deleting Smart Elements Using Delete or Backspace Key
You can now use the Backspace or Delete key to delete clauses, fields, nested clauses, smart clauses, smart fields 
and read-only fields from an agreement document. Clauses or fields deleted from the document are recorded in the 
reconciliation screen as deleted. This feature improves the usability experience of X-Author Contracts.

Earlier smart elements like smart fields or smart clauses could be deleted only by marking them for deletion from the 
control panel and then reconciling them. This feature removes that limitation. Also, if you are not an Apttus user and 
do not have X-Author installed, you would still be able to delete smart elements from the agreement document. 
Additionally, earlier it was difficult to remove static text if it was in between two smart elements. That problem is 
solved with this feature.

Prerequisites

To delete a smart element you must ensure that the value of the Comply System Property, 
UnlockSmartElements is set to True in Contract Management. Only then the smart elements become available 
for deletion.
For more information on how to configure Comply System Property, refer to Contract Management on 
Salesforce Summer 2018 Administrator Guide.
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To delete a smart field, smart clause or repeat section
Select the smart element in the document. Highlight the text value of the field, clause, section or table with 
your mouse.
Press Delete or Backspace. This only deletes the field value but the content border remains.
Press Delete or Backspace again to completely delete the smart element. Now, the content border is also 
deleted.

OR

Identify the smart element in the document.

Click the vertical ellipsis icon   on the content control border of the element.
Press Delete or Backspace.

The content control border of the fields, as well as the field value, will be deleted.

To delete a repeat-table
Identify the smart table in the document.

Click the vertical ellipsis icon   on the content control border of the table.
Press Delete or Backspace.

The cell values are deleted but the table remains with blank cells. When you delete a cell value within a table, the 
changes are shown as strikethrough in the reconcile smart fields in table screen. The new value column remains blank 
and the previous value is shown as strikethrough. However, this practice is not recommended because if you delete a 
cell in a repeat a table, you may see some issues during reconciliation.

To delete a read only field
Select the read only field in the document (Protection Mode= Full Access).
Press Delete or Backspace.

OR

Select the read only field in the document (Protection Mode= Insert Comments and Track Changes).
Press Delete or Backspace.
You will see a Microsoft Word warning message, click Yes to delete.
Go to Microsoft Word ribbon and click the Review tab.
Click Accept, to accept the delete change. The content control of the read only field is deleted but the text 
value remains.
Select the text value and again press Delete or Backspace.
Repeat step 3 and 4. You have to Accept the delete changes twice.

Now the complete read only field is deleted.
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Best Practices and Application Behavior for Deleting Smart Elements or Read Only 
Fields
Smart elements can be deleted using the Del or Backspace key but, while doing it you must adhere to the following 
recommended best practices to avoid errors.

Existing documents would not support delete using Delete or Backspace key unless they are regenerated from 
Contract Management or checked out in X-Author Contracts.
An offline user or a non-Apttus user cannot delete Read Only fields. If an offline user or external user deletes a 
Read only field, only the content control of the Read Only field is deleted and the field value will be deleted 
only when an Apttus user checks in the document in X-Author Contracts and accepts the delete changes 
once for content control deletion and again for the field value deletion.

When Document Protection is set to Full Access

You must Accept or Reject each change in the Review tab of Microsoft Word, before checking in the 
document using X-Author Contracts.
If you delete a field by selecting the field value text and pressing Delete or Backspace, hit Backspace or delete 
twice to remove the text and the content control border of the field. If you fail to do so, you'll see a validation 
error on reconciliation or while validating the fields using Validate Fields.

When Document Protection is set to Insert Comments and Track Changes

In Insert Comments and Track Changes protection mode, it is mandatory for you to first Accept or Reject the 
changes in the document from the Review tab of Microsoft Word before you perform any action from X-Author 
Contracts. Failing to do so will give you validation errors or unexpected behavior in X-Author Contracts. X-
Author Contracts actions include performing Update from Salesforce, Checking in the document, reconciling 
the document, Preview Reconcile, and Validate Fields.
You must remove the document protection by manually entering the password before you can delete smart 
elements as well as read-only fields from your document.
If you select a content control and partially delete the text, the partial text would remain as static text.
When you delete a smart field in the document and then open the control field, the Current Value column of 
the Control Panel will show blank values for the deleted fields.
When you delete a smart field which has multiple occurrences in the document, the smart field's occurrence 
index is not updated in the Control Panel unless you check-in the document. The index number helps identify 
which occurrence of the field you have deleted.

Importing Offline Agreement Documents
X-Author Contracts enables you to import a document which has not previously been saved in Salesforce and attach 
it to a pre-existing agreement record. You can also select how you want date and time to be formatted in the footer of 
imported docs and how you would like an agreement number included in the header.

Like creating a new agreement, when you choose to associate the document with a pre-existing agreement record, it 
is added to either the Document Versions or Notes & Attachments related list for that agreement (depending on your 
versioning settings).
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When you import a document, the date and time for when it is imported can be automatically added to the footer of 
the imported document. To automatically include the date and time when you import a document, you can configure a 
Comply System Property indicating you want the date included and the format in which the info should be displayed.

Another Comply System Property is used to indicate that you want the agreement number automatically included in 
the header and which field you want that value to come from.

When you use these settings, they add values to the header and footer of the document regardless of what other 
content was already in the header and footer.

To add importing offline agreement actions

From Setup, go to Create > Objects > Merge Event.
Under Custom Fields & Relationships, click Action and for Picklist Values click New.
Enter Create Offline Agreement and Import Offline Agreement on separate lines and click Save.

From Setup, go to Create > Objects > Agreement Protection.
Under Custom Fields & Relationships, click Action and for Picklist Values click New.
Enter Import Offline Agreement and click Save.

Document protection can now be extended to documents that were imported.

To set the Agreement Number Field for the header

From Setup, go to Develop > Custom Settings and click Manage beside Comply System Properties.

You must be using Contract Management 7.0.228 or higher to import offline documents.
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Click Edit and for Agreement Number Field For Imported Docs, enter the API name of the field you want to 
use. For instance, you could useApttus__Agreement_Number__cfrom the Agreement object.
Click Save.

When a new document is imported into the system, it will include the agreement number in the top right corner of the 
header on each page, using the field selected above.

To set the date and time format for the footer

From Setup, go to Develop > Custom Settings and click Manage beside Comply System Properties.  
Click Edit and for Footer Datetime Format For Imported Docs enter the format you want to use. For example:

Supported DateTime Format Example

MM/dd/yyyy 08/22/2006

dddd, dd MMMM yyyy Tuesday, 22 August 2006

dddd, dd MMMM yyyy HH:mm Tuesday, 22 August 2006 06:30

dddd, dd MMMM yyyy hh:mm:tt Tuesday, 22 August 2006 06:30 AM

dddd, dd MMMM yyyy H:mm Tuesday, 22 August 2006 6:30

dddd, dd MMMM yyyy h:mm tt Tuesday, 22 August 2006 6:30 AM

dddd, dd MMMM yyyy HH:mm:ss Tuesday, 22 August 2006 06:30:07

MM/dd/yyyy HH:mm 08/22/2006 06:30

MM/dd/yyyy hh:mm tt 08/22/2006 06:30 AM

MM/dd/yyyy H:mm 08/22/2006 6:30

MM/dd/yyyy h:mm tt 08/22/2006 AM

MM/dd/yyyy HH:mm:ss 08/22/2006 06:30:07

MMMM dd August 22

yyyy'-'MM'-'dd'T'HH':'mm':'ss 2006-08-22T06:30:07

yyyy'-'MM'-'dd HH':'ss'Z' 2006-08-22 06:30:07Z

dddd, dd MMMM yyyy HH:mm:ss Tuesday, 22 August 2006 06:30:07

Click Save.

When a new document is imported into the system, it will include the Date in the bottom left corner of the footer on 
each page, in the format selected above.
To import an offline document

 Only the following date and time formats are supported:
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With the document open, connect to the Salesforce org where you want to create the offline document.
Go to the X-Author Contracts tab and click Check-In. The Check-In dialog is displayed.

Select Upload/Import as an offline document and click OK. Optionally, you can choose to make the offline 
document private. For more information on what this means, see Marking Agreement Documents as Private. 
Depending on the version of Contract Management installed in your org, you will see one of the two screens.

(Contract Management 8.4.0319 or higher) Enter the Agreement Name or Number of the agreement 
you want the imported document associated with and click . Refine your search by also choosing 
an Owning User and/or a Primary Contact for the agreement.
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b. (Contract Management 8.3.0310 or earlier) Enter the name or number of the agreement you want the 
imported document associated with and click .
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4. Click Select for the appropriate agreement and the dialog closes. If your agreement record is Version Aware, 
the document is imported and attached to the Document Versions related list. Otherwise, it is imported and 
attached to the Notes & Attachments related list.

 

Locking Documents
When you check-out a document in X-Author For Contracts, the same document can be locked to prevent others 
from editing the document and checking in a new version at the same time you are working on it.

When you check-out a document it is automatically locked, which is indicated by the lock icon being closed . If 

you choose to refresh the lock status and release it, the icon changes to open . Once you have unlocked a 
document, you can relock it by selecting Check-Out > Currently Opened Document.

When someone else has a document locked and you open it, you will not be able to edit the document. The Create, 
Playbook, and Highlight Smart Fields menu options will be disabled. When you mouse over the lock icon, a message 
will display when the document was locked and by whom.

If you are using Offline documents (documents imported without Apttus properties, such as third party 
paper) with your agreements, you must ensure that any required documents are converted using OCR 
(Optical Character Recognition) prior import, or they will not be searchable. 
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Configuring Locking Documents
You must have enabled Comply System Properties and applied the correct permissions in Salesforce for this feature 
to work in X-Author.

From Setup, go to Develop > Custom Settings > Comply System Properties and select Enable Version 
Control.
From Setup, select the profile you want to have access to this feature and select Object Settings. Set the 
object permissions for Agreement Locks to Read, Create, Edit, Delete.
From Setup, go to Create > Objects > Agreement and from Custom Fields & Relationships select Is Locked. 
Click Set Field-Level Security and select the Visible check box for each profile that you want to be able to use 
this feature.

To lock documents
From the X-Author Contracts tab, check-out a document and it is automatically locked, which is indicated by 

the lock icon  .
Hover over the lock icon and a message indicates the document is currently locked by you. If someone else 
opens the document at this point, they will not be able to edit it and the Create and Playbook options will be 
disabled.
Check-in the document.

The document is checked into Salesforce and the lock is removed, indicated by the open lock icon . You can 
use Check-out to relock the document.

Using the Playbook for Agreement Documents
A playbook is a repository of clauses, sections, and supporting documents which can be inserted in the agreement 
document during the agreement management process. The playbook allows you a greater degree of delegation and 
experience sharing by providing a repository of readily available clauses which can be used during the negotiation 
process.
Working with the clause library for agreement management process, generally assumes that these clauses actually 
contain text only, and do not have merge fields, conditional statements, etc. which need to be resolved at runtime. 
Only clauses that have an agreement type that matches the record type of the agreement are displayed in the search 
results.

Due to a Windows build update limitation, Playbook may fail to load or you may encounter an error when 
accessing Playbook or its features. To fix this issue, you must install Windows 10 1803 update which 
includes OS build 17134.228.
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Playbook for Pre-FX2 Agreement Documents
For illustrating the use of Playbook for pre-FX2 agreement documents, Let's consider a case where you need to add 
two clauses to the agreement document which are concerned with training and confidentiality. To work with Playbook 
in Pre-FX2 agreement document:

Download the agreement document from Salesforce, open it in Microsoft Word.
Log in to Salesforce from X-Author Contracts tab from the Microsoft Word ribbon and then click Playbook.
In the agreement document, place the cursor exactly where you need to insert the clause for Training. Note 
that by default the search filter Type is set to Clause:

After the clause is inserted the document looks like the following:
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Now you must insert another clause replacing previously created (in our document it is section 5). Select the clause 
and click Playbook from the X-Author Contracts tab:
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After the clause is inserted the document looks like the following:

The agreement activity history log entries created by the two above actions:

Also these clauses get inserted into the Agreement Clause related list table associated with an agreement. Here are 
the two agreement clauses:

To learn how the Agreement Clause related list is populated with each insert, modify and delete action, refer Tracking 
Clauses in your Agreement in Contract Management Administrator Guide.
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Playbook for FX2 Agreement Documents
To insert clauses using Playbook in agreement documents generated with FX2 formatted template:

Login to X-Author Contracts in Microsoft Word and open a generated agreement document using Check-Out.
The agreement document opens in Microsoft Word. Select a pre-existing paragraph or place the cursor in the 
appropriate place to replace or insert a clause.
Click Playbook on X-Author Contracts tab and search for the required clause you want to insert.
Click Insert.
After you have inserted the clause, click Check-In.

Inserting Clauses with Merge and Smart Fields
From the Playbook, you can insert clauses into agreements. These clauses can contain lookup merge fields and 
header level smart fields and the value of those fields are populated with the values from the associated Salesforce 
object record.

Agreement header level fields can be inserted as smart fields. Lookup merge fields are also supported. However, 
related lists, child object fields, repeating data sets, and conditional content are not supported.

Playbook button is disabled in the X-Author Contracts ribbon if your agreement's protection mode is: Read 
Only, Fill in Form Fields, or Insert comments and track changes.
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Prerequisites

You must have generated an agreement document and have clause templates with merge and/or smart fields 
available.

To insert clauses
Open the document and from the X-Author Contracts tab and click Playbook.
Search for a clause type template and click Insert to insert the clause content into the document.

The inserted clause appears redlined in the agreement document if the agreement's protection level is set to Insert 
Comments and Track Changes.

Fields that can be resolved with values from the agreement record are displayed with those values. For those fields 
that do not have a value, nothing is displayed. If a field does not exist on the agreement record the merge/smart field 
formula code is displayed. If any changes are made to the values of the fields, you must reconcile them to have the 
agreement record fields updated accordingly.

When you insert a clause into a generated agreement from the playbook that has a nested clause, the system treats 
the main clause as a master clause. The nesting is removed and insert the clause with only a single content control.

Auto Clause Insertion using Bookmarks (FX2)
When managing a contract, there is often legal language that may be required to exist in the agreement document in 
multiple locations.

This feature provides Contract Managers with the ability to automatically insert clause content into a generated 
agreement document based on the placement of Clause Reference Bookmarks in the corresponding template 
document. When you works with a document that contains clause bookmarks, you have the option to automatically 
insert the content of a clause at every location in the document with the same bookmark using a single click. This 
provides greater flexibility and less work when multiple occurrences of the same clause are required in a document.

Before you can automatically insert clauses from bookmarks, your template must include bookmarks. Refer to
 Inserting Clauses as Bookmarks (FX2) under Managing Templates in this guide.

When you insert an agreement clause into a document, it is only valid for that specific agreement document. 
If you regenerate the agreement, a new document - without the inserted clause - is created.



If you add a clause with both conditional logic and merge fields into a newly generated document, the clause 
will not be evaluated properly.



You must not insert a clause containing a repeat section or repeat table in an agreement document. If you do 
so, the values of the repeat section or table are not resolved properly in the agreement document.
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The Clause Bookmark feature requires X-Author Contracts for Word version 8.5.0713 or later and a connected org 
with Apttus Contract Management package version 8.5.0346 or later installed. Clause bookmarks only work with FX2 
format templates and documents.

To automatically insert a clause in all bookmark locations
Open Microsoft Word and connect to X-Author Contracts.
Check Out the agreement document containing the bookmark references.

From the X-Author Contracts ribbon, select Playbook. The Playbook pane is displayed.
Use the Playbook search dialog to display the clause or clauses you want to insert.

This feature inserts clause content as static text, not smart clauses. Smart clauses must still be inserted or 
marked as normal. Also, any style or text formatting in the inserted clause is removed and will match the 
format of the agreement document at the point of insertion.



Note: Bookmarks are not visible in the document by default. You must "show bookmarks" in Word to 
make them visible.
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From the list in Playbook, click Insert next to the bookmarked clause you want to insert. The following dialog is 
displayed.

 Choose an option from the dialog:
Click Yes to insert the clause at ALL bookmark positions in the document. 
Click No to instead insert the clause at the cursor's current position. 
Click Cancel to cancel clause insertion entirely.

If you click Insert next to a clause that does not have a corresponding bookmark, the dialog will not be 
displayed and your clause will be inserted into the document at the cursor's current position.
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Each occurrence of the same clause is inserted into the document at the bookmark's location, replacing the 
bookmark with the contents of the clause.

Check-In your contract document after you have inserted all bookmarked clauses. Document highlighting of 
clauses inserted from bookmarks is removed following check-in with or without reconciliation.

Locating Specific Bookmarks by Clause
When you are working with an agreement document, you may decide to inspect bookmark locations before inserting 
clause content. If you want to learn which clause reference bookmarks are associated with which clause, you can use 
Microsoft Word functionality to do so. 

To find bookmarks by clause
From the "Insert" menu in word, click Bookmark. A list of bookmarks in the document is displayed
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Bookmark names are a combination of the Clause Reference ID in Salesforce and the current Date/Time. You 
can identify an Apttus-specific bookmark because the name always begins with "APTSBmrk".
Select a bookmark from the list and click Go To to jump to the bookmark position in the document. The first 
string leading up to the underscore in the Bookmark name corresponds to the Salesforce Record ID for that 
specific clause. For example, if the bookmark name is 
"APTSBmrk_a0361000005cHv9AAE_636056479067", then the Clause Reference ID is 
"a0361000005cHv9AAE". Knowing this, you can track how many occurrences of the same clause can check 
Salesforce for the name of the clause corresponding to this ID.

Inserting Clause as Text
You can now insert a clause as plain text anywhere in a generated document. When you insert a clause as plain text 
and check-in the agreement, the clause is marked with the action InsertedAsText in the Agreement Clauses related 
list in Contract Management. Also, when you insert a clause as plain text into a smart clause in the generated 
agreement and perform check-in with reconciliation, the smart clause is marked as modified whereas the inline clause 
is marked as InsertedAsText.  This way you can track a clause inserted as plain text in the agreement. For more details 
on how to track clause activity in an agreement, refer to Tracking Clauses in your Agreement.

To insert clause as text
Open the document and from the X-Author Contracts tab, open the Playbook.
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Search for a Clause type template and click Select.
Click Insert Text to insert the clause content as plain text into the document. The inserted clause text appears 
redlined in the agreement document if the agreement's protection level is set to Insert Comments and Track 
Changes.

Swapping Clauses
You can use swap clause to replace an existing smart clause in the agreement document with another clause's 
content from the Playbook. The Swap button in the Playbook facilitates easy replacement of clause content and 
eliminates the need to mark the existing clause for deletion and then insert a new clause. This feature saves time and 
makes the negotiation process smoother by reducing the number of steps needed to swap a clause. However, the 
swap feature only works on smart clauses and not for inline or read-only clauses. Read-only clauses are eligible for 
swapping only if they are unlocked. When using swap clauses feature, you must consider the following:

Swap action is available only when you select a smart clause.
You cannot select the non-smart inline text, Read-only clauses, or other fields along with your smart clause to 
swap.

To swap a clause
Check-out an agreement document in X-Author Contracts.
Select a smart clause in the agreement document to activate its content control. Alternatively, click the content 

control tab  of the clause to select the whole clause.
Click Playbook from the X-Author Contracts tab toolbar.
Use the Playbook search to search for the clause.
Select the clause from the Playbook search results and click Swap.
Select Yes on the confirmation dialog box.
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After successful swapping, the new clause content replaces the older content in the agreement document. 
Additionally, in Contract Management, the Agreement Clauses related list of the associated agreement record 
registers the following changes:

The new clause is marked as Inserted.
The older clause, which is swapped, is marked as Deleted.

Comparing and Merging Versions
X-Author can be used to compare or merge any two versions of an agreement document in Salesforce. X-Author uses 
Microsoft Word's compare and merge feature to allow you to compare agreements from two different agreement 
records.

Compare: The comparison is done based on Word's Legal Black lines compare functionality. Compare Legal Black 
Lines compares the documents and displays only what changed between the two documents. The documents being 
compared are not changed. This type of comparison is always displayed in a new third document, typically named 
Compare Result. Microsoft Word displays a new, third document in which tracked changes in the baseline document 
are accepted and changes in the selected document are shown as tracked changes. The documents being 
compared are not changed. There are two ways you can compare the agreement documents:

You can compare the different versions of an agreement document within the same agreement record, or,
You can compare the different versions of an agreement document from two different agreement records.

Merge: Merging documents uses Word's Combine feature to merge selected documents. Merging documents can 
be advantageous if you have one version of the document that has been redlined, and a regenerated version in the 
latest format (dynamically inserted fields, new clauses, etc.). Original (pre-merged) documents do not get changed. 
Merging the documents displays a new third document, named Merge Result. At this point, you can accept and reject 
any of the redlined elements in the combined document and check-in the document as a new version.

Compare Vs Merge

The Compare function takes two similar files (usually an original and an edited version of agreement document) and it 
produces a new version of the document that contains Tracked Changes for the differences. If the edited version was 
produced with Track Changes turned on, the newly generated version and the edited version will be identical. There 
should be no reason to do a compare if the edited version had track changes enabled. 

The Merge (or combine) function takes two similar files that do contain Tracked Changes (usually two versions edited 
by different people, starting from the same original), and it produces a version with both sets of edits as Tracked 
Changes. This should be the same as if one person had edited the original with Track Changes turned on, and then 
the second person edited the first person's version with Track Changes turned on. This may produce some odd 
results if both people changed the same piece of the original text to two different phrases, as both edits will appear. 
Also, Merge can only keep one set of formatting changes.

Note

You may want to perform a comparison before you decide to merge documents.





X-Author Contracts on Salesforce Winter 2019 User Guide

203 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

1.

2.

3.

4.

5.

Use Case: Merging a redlined MSA with a regenerated version
Mary Manager is working with an MSA document generated from an agreement. There have been several 
rounds of negotiations, mainly consisting of various redlines being made to clauses and text marked as fields.
Sam Sales makes changes to the Agreement record in Salesforce, adding several more Agreement Products 
to the agreement.
Mary realizes that this will require the agreement document to be regenerated, but does not want to lose all 
the changes made to the redlined version. She decides to use X-Author's Merge Versions functionality.
On the Agreement record, Mary selects Regenerate to generate a new agreement document that captures the 
Agreement Product information.
Mary opens the redlined version in Word, checks it out, and chooses Compare from the X-Author Contracts 
ribbon.

The compare and check-in feature of X-Author Contracts allows you to compare two agreement documents 
and check-in the resulting compared document. You can also perform other X-Author Contracts actions on 
the compared document.
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Mary chooses the redlined version from the left pane (1.4.0) and the regenerated version from the right pane 
(2.0.0) and selects Merge Selected Versions.

Mary verifies that the redlined changes are still present, and checks the agreement line items that were present 
in the regenerated version.
Redlines

New Line Items
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Mary checks in the document as the new redlined version, appending the Suggested Name with "Merged."
On the agreement record, the merged document is available under Document Versions (because this was a 
version-aware agreement).

Comparing Agreement Versions
The Compare function takes two similar files (usually an original and an edited version of agreement document) and it 
produces a new version of the document that contains Tracked Changes for the differences. If the edited version was 
produced with Track Changes turned on, the newly generated version and the edited version will be identical. There 
should be no reason to do a compare if the edited version had track changes enabled. 

Prerequisites

You must be logged in to X-Author Contracts and have an agreement document open.
Both the agreement documents for comparison must be created with the same template.
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To compare versions
From the X-Author Contracts tab, go to Review > Compare. The currently opened agreement is displayed first 
in the list.

To compare agreement versions of the same agreement record, select a version in 'compare or merge from' 
and then a version from 'compare or merge to' and click Compare Selected Versions. The list of agreement 
documents displayed in 'compare or merge from' and 'compare or merge to' list is from the same agreement 
record.
-OR-
To compare agreement versions of different agreement records click Search Records button. Clicking Search 
Records opens the agreement Checkout page. Search and check out the agreement record from which you 
want to select a contract for comparison. Select the two agreements from the list and click Compare Selected 
Versions.

A third document is generated and displayed in Word showing the differences between the two versions, in 
which tracked changes in the baseline document are accepted and changes in the selected document are 
shown as tracked changes. If either version of the document has previously tracked changes, Word might 
display a message box. Click Yes to compare the documents.

The selected agreement record's name is displayed next to the Search Records button (as shown in 
the screenshot above).
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You can select differences from the Summary pane to go directly to that part of the document. If the Summary
pane is not displayed, go to Word's Review > Reviewing Pane to enable it. If you want to view the documents 
that are being compared side by side, along with the combined comparison document, select Review > 
Compare > Show Source Documents > Show Both.
The composite comparison document can be saved.
Check-in your document to create a new version.

Compare Behavior and Recommendations
Do not use Accept All action on the compared document if either of your documents contains smart fields with 
modified values, as it may result in an error. As a workaround, perform manual Accept or Reject on each track 
change, including the smart fields, from Microsoft Word's Review pane.
Apttus recommends that you perform merge on different versions of the agreement documents generated from 
the same template for best results. Merging documents from non-identical sources may result in unexpected 
behavior. Non-identical means agreement document generated with the same template after modifications, or 
with a different template.
Agreements should be compared between versions of the same generation cycle. For example, you can 
compare or merge 1.0.0, 1.1.0, 1.2.0 but you must not compare or merge 1.x.x and 2.x.x.
If you are working with the merged document and change your view to 'Show Source 
Documents' (from Review > Compare), X-Author actions such as inserting a clause may cause unexpected 
behavior. Always work with one active document window at a time (compared view).
The value of the read-only fields (from the 'Revised' document) is not displayed in the merged document 
automatically. To view the values of the read-only fields, you must first check in the document and then perform 
Update from Salesforce.
If you merge two non-identical documents (non-identical refers to documents not generated from the same 
template or belonging to a different agreement record, or regenerated with the same template after 
modification), the resulting merged document retains the new repeat tables or repeat sections. The repeat 
items (tables or sections) added are not detected for reconciliation or preview reconcile.

Compare Limitations
Reconciliation and Update from Salesforce do not impact new rows added to a repeat-table as a result of 
comparing (insertion accepted).

If your agreement documents have smart date fields inserted in a table cell, after comparing the two 
agreement documents some of the date fields may lose their smartness property. This problem 
occurs when you compare two agreement documents that have date fields inserted into a Microsoft 
Word table and then you navigate to the Microsoft Word Review tab and click Accept All Changes. 
After accepting all the changes, some of the smart date fields in the agreement document might lose 
their smartness property.

To prevent this from occurring, avoid using smart date fields within a table and after comparing the 
documents individually Accept or Reject the changes to each smart field.



The compare and check-in feature of X-Author Contracts allows you to compare two agreement documents 
and check-in the resulting compared document. You can also perform other X-Author Contracts actions on 
the compared document.
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Fields marked as smart in the 'Revised' document before comparing are not detected for reconciliation in the 
compared document.
You cannot unlock smart elements in a compared document because Unlock Smart Elements comply system 
property does not impact compared document.
You cannot Accept or Reject changes to the value of a read-only field or clause in the compared document.

Merging Agreement Versions
The Merge (or combine) function takes two similar files that do contain Tracked Changes (usually two versions edited 
by different people, starting from the same original), and it produces a version with both sets of edits as Tracked 
Changes. This should be the same as if one person had edited the original with Track Changes turned on, and then 
the second person edited the first person's version with Track Changes turned on. This may produce some odd 
results if both people changed the same piece of the original text to two different phrases, as both edits will appear. 
Also, Merge can only keep one set of formatting changes.

Prerequisites

You must be logged in to X-Author Contracts and have an agreement document open.
You must have X-Author Contracts version 8.5.1010 or higher.

To merge versions
From the X-Author Contracts tab, select Compare. The currently opened agreement is displayed first in the 
list.
Select a version to 'compare or merge from' and a version from 'compare or merge to' and click Merge 
Selected Versions. You can click Search Records and also select the documents from a different agreement 
record.
A third document is displayed showing a combination of the selected documents. Redlines are preserved in 
the combined document.
Accept or reject changes in the combined document.

Check-in your document to create a new version. To avoid errors, it is recommended to append the 
Suggested Name of your document with "Merged." For version-aware documents, the merged document will 
increment the version based on the "from" document (For example, if the previous redlined version was 1.2.0, 
the new version will be 1.3.0).

Merge Behavior and Recommendations

Do not use Accept All action on the merged document if either of your documents contains smart fields with 
modified values, as it may result in an error. As a workaround, perform manual Accept or Reject on each track 
change, including the smart fields, from Microsoft Word's Review pane.

Apttus recommends that you manually review and Accept or Reject every track change individually. 
Using Accept All Changes may result in unexpected behavior.
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Apttus recommends that you perform merge on different versions of the agreement documents generated from 
the same template for best results. Merging documents from non-identical sources may result in unexpected 
behavior.
If you are working with the merged document and change your view to 'Show Source Documents' (from 
Review > Compare), X-Author actions such as insert clause may cause unexpected behavior. Always work 
with one active document window at a time (merged view).
Do not perform Update from Salesforce before check-in on a merged document if your document contains 
repeat table.
The value of the read-only fields (from the 'Revised' document) is not displayed in the merged document 
automatically. To view the values of the read-only fields, you must first check in the document and then perform 
Update from Salesforce.
If you merge two non-identical documents (non-identical refers to documents not generated from the same 
template or belonging to a different agreement record), the resulting merged document retains the new smart 
fields or smart clauses. The smart clauses and fields added are not detected for reconciliation or preview 
reconcile.

Merge Behavior and Limitations
Microsoft Word has a limitation which causes X-Author Contracts to display an error when a user tries to 
merge two agreement documents containing smart date fields. Therefore, we recommend you to avoid using 
Merge Selected Version with your documents if your documents contain smart date fields and the value of the 
date field in one of the documents is modified. As a workaround, you can use Compare Selected Versions and 
check-in the resulting compared document.
Reconciliation and Update from Salesforce do not impact new rows added to a repeat-table as a result of 
merging (insertion accepted).
Fields marked as smart in the 'Revised' document before merging are not detected for reconciliation in the 
merged document.
You cannot unlock smart elements in a merged document because Unlock Smart Elements comply system 
property does not impact merged document.
You cannot Accept or Reject changes to the value of a read-only field or clause in the merged document.

Associating Term Exceptions
X-Author enables you to associate specific clauses in an agreement or proposal document with an exception clause 
or term exception. A term exception is a stipulated condition that may needapprovalto grant or prevent certain 
allowances in an agreement or proposal.

For example:you associate an exception clause for 'Payment Terms' in an agreement document. If the payment terms 
value is changed and if the change is not in line with the company’s policy, which is usually a condition mentioned in 
the exception clause, then the agreement is sent for approvals. In X-Author, you can associate term exception in two 
ways: Create Section and Playbook.

Prerequisites

You or your system administrator must have set up the following in Salesforce before you can associate term 
exceptions:

Create a new term exception using the custom object Term Exception in Salesforce and associate the term 
exception with an agreement type of your choice.
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Set the Admin property APTS_EnableTermExceptionsInAuthor to True, to be able to associate Term 
Exceptions to clauses via X-Author. If this setting has not been created then you must create it and set it to 
true.

To associate term exceptions using Create Section
Open Microsoft Word and check-out a document in which a section needs to be associated to a term 
exception.
Select the chunk of text to associate it with a term exception and click X-Author Contracts > Create > Create 
Section.
In the Create Section dialog, fill in the following:

Menu Item Description

Action Select an action that will execute the term exception. For example, 
the term exception will be triggered if the clause that you select is 
‘modified’ or ‘deleted’.

Category Select the category of the clause. For example, Confidentiality, 
General and so on.

Subcategory Select the sub-category of the clause.

Risk Rating Select the risk rating to define a risk rating for the clause.

Exception Select a term exception to associate the agreement clause. A list 
of term exceptions available for a particular agreement will be 
displayed (based on Active & Agreement Type filters).

Section Enter an appropriate name for the clause.

Comments Enter appropriate comments for the task.

Section text (selected) The section that you have selected will be visible here.

Status Select the status of the clause document

Click Save and click Check-In. 

A new Agreement Term Exception record will be created. Alsothe Agreement Clause and Agreement Term Exception 
relatedlistsare automatically populated with the Term Exception name.

To associate term exceptions using playbook
You or your system administrator must have set up the following in Salesforce before you can associate term 
exceptions:
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Create a new term exception using the custom object Term Exception in Salesforce and associate the term 
exception with an agreement type of your choice.
Set the Admin property APTS_EnableTermExceptionsInAuthor to True, to be able to associate Term Exception 
with clauses via X-Author. If this setting has not been created, then you must create it and set it to true.

Intelligent Import
You can use the Intelligent Import feature to automatically extract key data from the third party paper contracts. Apttus 
Intelligent Import scans the third-party paper, recognizes, and maps important metadata and clauses to Apttus CLM 
system. You can control the visibility of the Intelligent Import feature in X-Author Contracts. For more details, see 
Configuring Intelligent Import Settings topic in the latest Contract Management Administrator Guide.

Previously, on importing an offline agreement, you had to manually find clauses and fields and mark them. Intelligent 
Import uses the pre-trained Artificial Intelligence-based clauses and fields AI Models to recognize the words that 
denote the clauses or fields in the third party document.

To perform the intelligent import
Check-in the third-party paper as an offline agreement in X-Author Contracts.
From the X-Author Contracts tab, click Intelligent Import.

Your document will be sent for the intelligent import and you'll see a confirmation message. After the Intelligent Import 
has performed the data extraction successfully, you will receive an email. Click Review Import Result button to see the 
Fields and Clauses recognized from the document.

The Review Import Result pane shows the list of fields and clauses identified in the document. The extracted fields or 
clauses are highlighted in black in the document as well as in the Review Import Result pane. When you click a field 
or clause name from the Review Import Result pane, the corresponding text is highlighted in the document. If you find 
that some clause or field is incorrectly marked, you can remove the identified clause or field from the imported 
document.

To remove a marked field or clause after intelligent import
Open the imported document.
Click Review Import Result.
From the Review Import result pane, select the incorrectly tagged field or clause and right-click on the field 
name or clause name.
Select Unmark Field or Unmark Clause.

Additionally, clauses and fields extracted by Intelligent Import are converted into smart clauses and fields. Upon 
check-in with reconcile, it will promote all marked clauses.

Intelligent Import AI algorithm works on previously trained AI models, and you can use X-Author Contracts to 
review auto-Marked Clause and Field, identified based on AI algorithm. You can correct the marked fields 
and clauses from X-Author Contracts Control Panel as a part of the review process.
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Regenerating an Agreement Document
You can regenerate an agreement document using the original template or a different template. A regenerated 
document contains clause specific redline changes done in the original agreement document. You can do this by 
using the Regenerate button. 

The Regenerate button is visible only if the custom permission AllowRegenerate is set to True for your role. If the 
custom permission is false or missing, this button is not visible in the X-Author Contracts toolbar.

Prerequisite

You must check out the agreement document and acquire its lock to use regenerate.

To regenerate an agreement document
Open an agreement in X-Author Contracts and click Regenerate. The Regenerate Agreement window 
appears.
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By default, the original template used is selected. You can choose a different template to regenerate the 
agreement.
To do a comparison of the original agreement to the regenerated document and provide a redlined version, 
select Compare after regeneration?
Click Submit.

The regenerated document opens in X-Author Contracts.

Unprotecting Agreement Documents
You can unprotect an agreement document by clicking Unprotect Document in X-Author Contracts. This eliminates 
the need for you to know the system password for removing the protection from an agreement. Unprotect Document 
is a toggle button under the Access tab, meaning that when you click Unprotect Document, the button changes 
to Protect Document and the previous protection level is applied. Thus, you can ensure that the document is 
protected before you share it. This feature prevents the sharing of password among the users and reduces the 
chance of unauthorized users getting access to the document.

Your system administrator configures the access to the Unprotect Document button for specific roles using
 XA_UnprotectDocument custom permission. If your role doesn't have permission for access, the button would be 
disabled in your X-Author Contracts ribbon. For details on how to assign custom permissions to a role or profile in 
Contract Management, refer to Custom Permissions topic in the latest Contract Management on Salesforce 
Administrator Guide.

You can use the Unprotect Document feature, only when your document's protection level is anything other than Full 
Access. If your agreement's Protection Level is Full Access and you click Unprotect Document you'll see the 
following message: "This action cannot be completed since this document is already unprotected".

Limitations

Currently, regenerate feature works only with the smart clause. Readonly clause is not supported. If a smart 
clause appears multiple times in the same agreement document, irrespective of whether it is a markup 
clause or inline clause, its content is skipped. This means in the final regenerated document, all the smart 
clauses will have the latest content.

Also, if any clause contains a comment, regenerate does not work and Microsoft Word application hangs.
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When you check-in an unprotected document with any of the Save options, the protection level configured for that 
Save option is applied to the agreement. If there is no protection level configured for that Save action in the 
Agreement Protection object, the document's previous protection level is applied to the document.

Tracking Clauses in your Agreement
The Agreement Clauses related list on the Agreement record is used to capture clause activity for associated 
agreement documents during contract negotiation. When you check out an agreement document as a negotiator, you 
can make changes to it by inserting, modifying, or deleting clauses. When you check back in the agreement 
document, new records are created in the Agreement Clauses related list that reflects these changes. With each 
change made to the clauses, either from Playbook or to the new clause marked in an agreement document, you can 
see corresponding entries in the Agreement Clauses related list of your agreement record in Contract Management 
application. You can use this data for reference or reporting purposes or to trigger an approval workflow based on the 
status of the clause.

For more information, refer to Clause Versioning topic in the Contract Management on Salesforce User 
Guide.





X-Author Contracts on Salesforce Winter 2019 User Guide

215 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

1.

2.

3.

4.

Reconciliation
Reconciliation allows you to merge the changes made to smart fields and smart clauses in an agreement document, 
outside of the Salesforce/ X-Author environment, with the data held in the associated Agreement record in 
Salesforce. Reconciliation is done at the time of check-in.

In a typical scenario where an agreement document is sent to an external party for negotiation, the external party will 
make changes to the document as part of the negotiation. If the changes to the document involve data belonging to 
the Agreement record, reconciliation provides the mechanism to ensure the values in the document and the 
Agreement record are in sync.

To reconcile an agreement, you must select Reconcile Document option from the check-in document page. 
Reconciliation process comprises four steps:

Reconcile Smart Fields: This page appears only if your agreement contains modified (modified means smart 
field whose value is updated or deleted) smart fields. You can view the previous and new values of the 
modified smart field. In the absence of a smart field or changed smart field in your document, this page is 
skipped during reconciliation.

Reconcile Repeat Tables and Sections: This page appears only if your document has modified repeat tables 
or modified repeat sections. The page provides existing and new values in a table with the changed values 
highlighted in the table. The page highlights only the table row which has the modified values.
Reconcile Smart Clause: This page appears if you have modified smart clauses in your agreement. The 
reconcile smart clauses screen shows the previous and current clause content and highlights the changed 
clause content in the current clause text pane. Clauses can only be smart in the context of a generated 
contract document.
Approvals and Term Exceptions: This page provides existing and new content of approval terms and term 
exceptions.

You can view the reconciled clauses and their changes under Agreement Clauses related list of the associated 
agreement record in Salesforce. For more details, refer to Tracking Clauses in your Agreement.

Preview Reconcile
Before reconciling the agreement, you can review the changes made to the content of a smart clause, a smart field, or 
a table using Preview Reconcile. Preview Reconcile button is enabled in the X-Author Contracts toolbar only if you 
have at least one smart clause, or smart field present in your agreement document.

Preview reconciliation does not reconcile the values of the smart elements to the agreement record. To do that, you 
must reconcile from the Check-in Document page.

In some cases, a smart field is not displayed in a generated agreement document. This happens 
because that field does not have any value to display and therefore, cannot participate in the 
reconciliation process. For more information on smart fields, refer to Inserting Fields in a Template.



You cannot change the content of the smart fields, smart clauses, tables, or term exceptions on the 
reconciliation page.
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Points to Remember
If your agreement document contains header level smart fields in a section, which is of type Repeat, the 
changes made to these fields are not reflected during the Preview Reconcile and Check-In processes.
During reconciliation of smart clauses, X-Author Contracts does not reconcile the clause content 
containing < and >.

Reconciling Smart Elements in an Agreement
Ensure that you have a checked out agreement document containing few smart fields and clauses under the X-Author 
Contracts ribbon.

On the X-Author Contracts ribbon, click Check-In.
If you have multiple occurrences of a smart clause in your document and you've only changed or updated one 
instance of the clause, you'll see a validation message first. See the Syncing Clause Edits topic given below.
The following sequence of dialog boxes will appear:
Select one of the options:

To check in the agreement document with redlines, choose With Redlines.
To check in the agreement document without redlines, choose Without Redlines.
To check in the agreement document as final, choose Final - to be signed.

Steps 3 to 8 appear only when you select the Reconcile Document check box.

In the Reconcile the Smart fields dialog box, for each field label, review the Previous Value or the Current 
Value which has Read-Only access. Only the modified fields appear on this page.
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Do one of the following.
Click Back or Cancel to return back to the agreement document.
Click Next to move to the next step for the reconciliation of smart fields in sections and tables.

In the Reconcile the smart Fields within Sections and Tables dialog box, review the values of the smart fields 
you want to use in the sections and tables of the Salesforce record.

Do one of the following:
Click Back or Cancel to return back to the Reconcile the Smart Fields dialog box.
Click Next to move to the next step for the reconciliation of smart clauses.

In the Reconcile the Smart Clauses dialog box, for each changed clause, you see the non-editable Current 
Clause Text, the Previous Clause Text and the comments section which contains the comments made inside 
the clause boundary and the Microsoft Word comments (inlined or balloon).
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Do one of the following:
Click Back to return to the smart field reconciliation dialog box.
Click Next to move to the next step for term exceptions and its associated approvals.

In the Exception Approvals dialog box, you can review the term exceptions and the approval requests for the 
clause changes accepted in this reconciled document.
Clicking Select all approvers selects all the term exception clauses and clicking Submit for Approval submits 
these clauses to the respective approvers.

Do one of the following.
Click Back to return to the smart clause reconciliation dialog box.
Click Finish to complete the reconciliation process.

You have completed the reconciliation process in X-Author Contracts.
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You can view the red strikethrough for the deleted content and blue text for the newly added content in the 
Agreement Clause on an agreement record. Also, note that the system may fail to save some of the content of the 
clause to the fields of the Agreement Clause record.

Syncing Clause Edits in Multiple Occurrences of a Smart Clause
If you have multiple occurrences of a smart clause in your document you may make changes to one instance and 
forget to make similar changes in the other clauses. X-Author Contracts alerts you if the clause content of your smart 
clause is not in sync across all its occurrences within a document. When you make changes to one instance of a 
clause and leave the other clause instances unchanged and then check-in your document, you will see a validation 
message reminding you that your clause content is not updated for all the instances of that clause. You thus have the 
flexibility to either update all the clause instances with similar edits or continue with check-in without changing the 
clause.

When you make changes to one instance of a smart clause which has multiple occurrences in your document and 
click Check-In, you'll see the following message:

Click Yes, if you want all your clauses to have identical content, otherwise, click No to proceed with check-in. If 
however, you have already made the same changes to all the similar smart clauses, you will not see the validation 
prompt when you click Check-In.

To preview reconciliation of smart clauses in an agreement
Ensure that you have a checked out agreement document containing few smart fields and clauses under the X-Author 
Contracts ribbon.

On the X-Author Contracts ribbon, click Preview Reconcile. 
In the Reconcile the Smart fields dialog box, for each field label, preview the Previous Value and the Current 
Value which have Read-Only access.
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Do one of the following.
Click Back or Cancel to return back to the agreement document.
Click Next to move to the next step for reconciliation of smart fields in the Sections and Tables.

In the Reconcile the smart Fields within Sections and Tables dialog box, review the values of the smart fields 
you want to use in the sections and tables of the Salesforce record. The changed value is highlighted in 
yellow.

Do one of the following:
Click Back or Cancel to return back to the Reconcile the Smart Fields dialog box.
Click Next to move to the next step for reconciliation of smart clauses.
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In the Reconcile the Smart Clauses dialog box, for each changed clause, you see the non-editable Current 
Clause Text, the Previous Clause Text and the comments section which contains the comments made inside 
the clause boundary and the Microsoft Word comments (inlined or balloon).

Do one of the following:
Click Back to return to the smart field reconciliation dialog box.
Click Next to move to the next step for term exceptions and its associated approvals.

In the Exception Approvals dialog box, you can review the term exceptions and the approval requests for the 
clause changes accepted in this reconciled document.
Clicking Select all approvers selects all the term exception clauses and clicking Submit for Approval submits 
these clauses to the respective approvers.             

Do one of the following:
Click Back to return to the smart clause reconciliation dialog box.
Click Finish to complete the reconciliation process.
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You have completed the reconciliation process in X-Author Contracts.

You can view the red strikethrough for the deleted content and blue text for the newly added content in the 
Agreement Clause on an agreement record. Also, note that the system may fail to save some of the content of the 
clause to the fields of the Agreement Clause record.

Smart Clauses in an Agreement Document
Smart clauses, like smart fields are parts of a contract that can be reconciled between versions of an agreement, and 
noted in the agreement record. This can be used during negotiations when clauses are redlined. Clauses that have 
been changed will be reconciled during Preview Reconcile and Check-In Reconciliation. Clauses can only be smart in 
the context of a generated contract document.

In the process of negotiations, a contract may get redlined multiple times. During these redlines, a user may choose 
to accept the changes made to the contract. Smart Clauses provides visibility onto the changes made in the contract 
document by allowing the user to view the changed clauses in Preview Reconcile, Check-in Reconciliation and when 
a clause change has been checked in, on the agreement record. During either of the reconciliation process, the 
clause view will be Read Only.

The Mark Clause menu in X-Author Contracts allows the user to take a block of text in an agreement document, and 
turn it into a smart clause. In some cases, the user may be able to take a block of text, and replace it with a clause 
from the playbook that will become a smart clause. This has implications when looking at use cases pertaining to 3rd 
party documents and importing offline agreements. 

With each action on the smart clause, such as insert, modify or delete, the Agreement Clause related list in your 
agreement record reflects these changes effectively. For more details, refer Tracking Clauses in your Agreement.

Reconciling Comments on Smart Clauses
You can reconcile comments made on smart clauses even if there was no change made to the clause text. While 
reviewing an agreement if you add or update comments to a clause text or reply to a comment made on a clause, you 
can save that information in the agreement record after checking in the agreement document with reconciliation. This 
can be used during negotiations when the external party adds comments to a clause text but does not make changes 
to the clause text. 

To reconcile comments on smart clauses
Check-out an agreement document with smart clauses.
Place the cursor inside any smart clause boundary and add a comment.
Click Check-in and select Reconcile Document.
On the Reconcile the Smart Clauses screen, you can see the comments section with the new or modified 
comments. When only the comments are added or updated, the Current Clause Text pane displays "No 
clause changes detected. Only comments added to this clause." 
Click Next and then click Finish to complete reconciliation.
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After reconciliation, the changes are saved in the agreement record's Agreement Clauses related list with the action
 CommentsChangedOnly. If you modify a smart clause as well as add a comment to it, the Agreement Clauses 
related list shows a new entry with Action Modified- for the modified clause content and also saves the comment in 
the Comments field of the Agreement Clauses related list. To view the Comments field, click the clause's Number link 
and in the details page, you will see the previous comment and the new comment. Also, the Diff Text column of the 
Agreement Clauses related list shows the entry 'No changes detected' when you only make changes to the 
comments. For more details on how to track agreement clauses, refer to Tracking Clauses in your Agreement.
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Sending Agreement Documents for Review from X-Author Contracts
A significant part of the negotiation process for any agreement involves including reviewers–internal or external–in the 
collaboration process. This typically requires the main agreement document and any supporting documents to be 
sent by the contract negotiator to reviewers for term changes, additional redlining, clarification of language, or other 
legal or contractual input. Apttus Contract Management provides a standard Send for Review process from 
Agreement records in Salesforce, but this may not always be the most ideal solution for contract negotiators. Just as 
you can use X-Author to check out, redline, manage legal language and terms, check-in, and finalize agreement 
documents, you can also manage the entire Send for Review process using X-Author and Microsoft Office 
applications.

Sending for Review from X-Author provides several advantages:

Send and receive agreement documents using the X-Author for Microsoft Outlook add-in. This saves you time 
and effort by eliminating the need to Send for Review from Apttus Contract Management.
Track and manage review cycles of negotiated documents along with their recipients.
Use review cycles of agreement documents to monitor negotiations at the summary and detail level.
Complete the end-to-end negotiation process without leaving Microsoft Office.

From Word or Outlook
Initiate Send for Review from the X-Author Contracts tab in Microsoft Word or Microsoft Outlook. This action invokes 
Outlook to send one or more agreement-related documents to internal or external parties for further review. Using 
Word, you can then track these documents and recipients as a fixed cycle of negotiations.

To make use of the full functionality of Send for Review from X-Author Contracts described in this guide, you 
must send only documents that belong to Version Aware agreement records and have the X-Author 
Contracts for Outlook add-in installed. For documents that are non-Version Aware, tracking and managing of 
reviews will be disabled. Likewise, review tracking is not enabled if the Outlook add-in is not in use (emails 
can still be sent and X-Author Contracts functionality is still available for users with access).

For more information on making agreement records Version Aware, see Contract Document Versioning.
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From Microsoft Word you can:

Check in the currently checked-out agreement or supporting document as a new Negotiator (minor) version 
prior to review.
Initiate the Send for Review, automatically attaching the currently checked-out agreement document to a new 
Outlook message.
Track and manage review cycle status for the opened document or any other existing open cycles.
Check in an agreement document as Negotiator, on behalf of a reviewer as a new Reviewer (revision) version, 
or close open cycles.
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From Microsoft Outlook you can:

Initiate the Send for Review by checking out an agreement document and attaching it to a new Outlook 
message.
Choose To and CC/BCC recipients from your Outlook address book.
Attach files to your Outlook message for review from the Apttus agreement record, including the agreement 
document, supporting or offline documents, other versioned documents, or documents from the agreement 
record's Notes & Attachments.
Attach files from your local drive, media or other storage.
Choose which documents are tracked as part of a review cycle (Note: tracking is only enabled for versioned 
documents and the X-Author Contracts for Outlook add-in).
Reply as an internal reviewer and check your version of an agreement document in to the agreement record.

Understanding Review Cycles
A tracked Review Cycle (also known as a "Send Cycle") is automatically created for every document associated with 
the Agreement record that is sent by the negotiator for review. This Review Cycle is then further divided into
 Cycles based on the number of recipients and the number of documents sent. Each unique recipient/document 
combination creates a separate cycle.
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For example, if 3 tracked documents are sent to 1 recipient, 3 cycles are created for that recipient. Similarly, if 3 
recipients each receive 3 tracked documents, 9 cycles are created (3 for each recipient).

Negotiators track open cycles in X-Author Contracts and can manually close cycles from this window or during 
Check-in. Internal reviewers have the option to check-in agreement documents from their Outlook email instance 
when they complete their review, returning an attached reviewed version, which automatically closes the cycle for the 
checked-in document. Negotiators and contract managers can also monitor Cycle status, by using Merge Event 
Details within the Merge Event related list on the Agreement record.

For more details on tracking review cycles, see Tracking and Managing Review Cycles.

To send an agreement document for review
You can send an agreement document for review from X-Author Contracts using one of the following two workflows:

Send for Review from Microsoft Word (does not require X-Author Contracts Outlook add-in)
Send for Review from Microsoft Outlook (requires X-Author Contracts Outlook add-in)

Note

Send for Review Cycles differ from agreement lifecycles and are not tracked using Cycle Time Groups or 
Cycle Time Reporting.



The examples provided in this section use Microsoft Outlook and Microsoft Word 2013. Depending on your 
version of Microsoft Office, certain menu actions and elements of the user interface may be in different 
locations. Apttus functionality remains the same regardless of Office version.
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To send an agreement document for review using Word
You must have at least 1 agreement document version generated or imported (Offline document) for the agreement 
record in question.

Open your generated document in X-Author Contracts for Word or open Microsoft Word and navigate to the 
X-Author Contracts tab.
Click Connect and choose a connection to log into the Salesforce org where your documents are stored.
If the document is open, click Check-Out under the Versions section and select Currently Opened Document.
 Otherwise, click Check-Out and follow the normal process for checking out a document from Salesforce.

Click Send for Review from the Review section to request a review. A pop-up message is displayed.

Click Yes if you made changes to the document since checking it out. Follow the usual process for checking 
in your document. Click No to continue with the review but keep the document as checked out or Cancel to 
return to the document without initiating a review. As part of this action, X-Author for Outlook automatically 
connects to the same org you are logged into from Microsoft Word. If Outlook is already connected to another 
org, you will see the following message.

Click Yes to log into the correct org or click No to remain connected to your current org.

If you are using Microsoft Office 2007, after login the view will default to the "Home" tab. You must 
re-select the X-Author Contracts tab to continue.





X-Author Contracts on Salesforce Winter 2019 User Guide

229 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

7.

X-Author Contracts invokes Microsoft Outlook to open a new message with the active context agreement 
document already attached (click image below to enlarge). Note: at this point all actions in Microsoft Word 
and Outlook will be disabled until you have completed or cancelled the Send for Review.

From here, you can send the agreement documents and other documents and attachments to any recipients in 
your Outlook address book or to other external recipients. 

To attach additional documents associated with your agreement in Apttus Contract Management, click Attach 
from Apttus in the X-Author Contracts section. The Select Documents and Versions window is displayed.

If you choose not to connect to the same org in Outlook as in Word you will not be able to complete 
the Send for Review for the current agreement document. Both Outlook and Word must be 
connected to the same Salesforce org in order to have access to documents that are part of the 
same agreement record.



Remember, if you do not have the Outlook add-in installed and are not working with versioned 
documents (from a Version Aware agreement), you cannot Attach from Apttus, as described in the 
next step. You can still send and receive emails.
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The first document in the list is your primary agreement document, or the document you used to initiated the 
Send for Review. The most recent version of the document is automatically selected. You cannot deselect this 
document. Additional documents associated with your agreement records are listed and can be any of the 
following:

A supporting document which you have already generated using Apttus Contract Management and 
tagged with Apttus properties.
An offline agreement document attached to an existing agreement record, using the Create Offline or 
Import Offline agreement actions, tagged with Apttus properties.
Any other document attached to the Notes & Attachments of the agreement record.

Select the check box next to a document to include it and click the drop-down list under the Version column to 
choose a specific Document Version for any attachments you want to include. 

Click Attach to attach the selected documents to your email.
Include any attachments stored locally using Outlook's Attach File command.
Click the To... button in your Outlook message to add recipients from your Outlook address book or enter any 
email address into the To... field.
Click the Cc... button to add additional recipients. Any recipients that are cc'ed or bcc'ed on the message 
receive copies of the documents sent for review but are not tracked by Apttus in review cycles.

Note that only one version of a document can be included as an attachment and you cannot change 
the version of the original agreement document. Non-versioned documents will not have this option. 
To attach other versions of a document to the same email instance, you can download them directly 
from the agreement record. As an alternative, initiate a separate Send for Review using another 
version of the document (you can track it independently).
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Add a Subject to your email (e.g., "Please review the following documents").
Add any desired text to the body of the email regarding the review.
Click Send to send the email with attached agreement documents to your reviewers. The Review process is 
officially initiated by this Send action and a Review Cycle has been created for the agreement record, 
including all recipients and documents.

To send an agreement document for review from Outlook
You must have at least 1 agreement document version generated or imported (Offline document) for the agreement 
record in question.

Open Outlook and navigate to the X-Author Contracts tab.

Click Connect and choose a connection to log in to log into the Salesforce org where your documents are 
stored. The Send for Review button becomes available.

Click Send for Review. The X-Author Contracts Checkout dialog opens in a separate window.

Please note that you cannot initiate a Review Cycle if you save the email message as a draft to send later. If 
you are working from a draft email, please copy any message contents and attachments to a new message 
using the Send for Review method described above.
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4. Enter keywords into the Search box to find the agreement document's related agreement record.
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6.

Click Select to choose the agreement record. A list of agreement documents associated with the chosen 
record is displayed.

Click Open to choose the agreement document to send for review.  Outlook opens a new message with the 
chosen agreement document already attached (click image below to enlarge). Note: at this point all actions in 
Outlook will be disabled until you have completed or cancelled the Send for Review.
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7.

From here, you can send the agreement documents and other documents and attachments to any recipients in 
your Outlook address book or to other external recipients. 

To attach additional documents associated with your agreement in Apttus Contract Management, click Attach 
from Apttus in the X-Author Contracts section. The Select Documents and Versions window is displayed.
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The first document in the list is your primary agreement document, or the document you used to initiated the 
Send for Review. The most recent version of the document is automatically selected. You cannot deselect this 
document. Additional documents associated with your agreement records are listed and can be any of the 
following:

A supporting document which you have already generated using Apttus Contract Management 
and tagged with Apttus properties.
An offline agreement document attached to an existing agreement record, using the Create 
Offline or Import Offline agreement actions, tagged with Apttus properties.
Any other document attached to the Notes & Attachments of the agreement record.

Select the check box next to a document to include it and click the drop-down list under the Version column to 
choose a specific Document Version for any attachments you want to include. Note that only one version of a 
document can be included as an attachment and you cannot change the version of the original agreement 
document. Non-versioned documents will not have this option.
Click Attach to attach the selected documents to your email.
Include any attachments stored locally using Outlook's Attach File command.
Click the To... button in your Outlook message to add recipients from your Outlook address book or enter any 
email address into the To... field.
Click the Cc... button to add additional recipients. Any recipients that are cc'ed or bcc'ed on the message 
receive copies of the documents sent for review but are not tracked by Apttus in review cycles.
Add a Subject to your email (e.g., "Please review the following documents").
Add any desired text to the body of the email regarding the review.
Click Send to send the email with attached agreement documents to your reviewers. The Review process is 
officially initiated by this Send action and a Review Cycle has been created for the agreement record, 
including all recipients and documents.



X-Author Contracts on Salesforce Winter 2019 User Guide

236 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

•
•

1.

Responding to a Send for Review request from Outlook
The X-Author Contracts add-in for Outlook not only provides negotiators with the ability to send documents for 
review, but also provides a mechanism for internal reviewers to directly check-in documents to Apttus Contract 
Management after making changes and/or providing feedback. Internal reviewers can simply reply to the email they 
received and attach their reviewed, tracked agreement document addressed to the review owner and then choose to 
check it in at the moment the email instance is sent.

Internal vs. External Reviewers
Send for Review from X-Author Contracts provides a solution that allows contract negotiators to send documents for 
review to any recipient that can be reached by email. This means that reviews can be sent not only to users who are a 
part of the negotiators organization (internal) but also to reviewers outside of the organization (external). Internal 
reviewers are assumed to have both access to the same Salesforce org as the negotiator and the X-Author Outlook 
add-in installed on their machine. It is not necessary for internal reviewers to have X-Author Contracts for Word as 
they may not be initiating reviews or tracking documents, but they must have the proper credentials to connect to the 
right org from within Outlook.

External reviewers can have any email client: Outlook, Gmail, MSN, etc., but it is assumed that even if they do have 
the X-Author Contracts add-in for Outlook that they are not part of the same organization. External reviewers should 
not have the ability to check in documents via a response to the review. When they respond to the Send for Review, 
external reviewers simply return the reviewed document to the contract negotiator. The negotiator then downloads the 
document and checks it in to the agreement record on behalf of the reviewer.

To respond to a Send for Review request and check-in a tracked document
As a prerequisite, the reviewer responding to the Send for Review request must:

be an internal reviewer (Apttus customer with a licensed X-Author Outlook add-in).
have downloaded and saved the document originally sent by the negotiator/SFR owner. This document has 
properties assigned to it when the review was initiated which are recognized by Outlook and allow for the 
reviewer to check-in the document when sending an email instance in response. Note: Do not work with a 
document opened directly from email as it will always be read only. 

Open Microsoft Outlook and navigate to the X-Author Contracts tab.

Please note that you cannot initiate a Review Cycle if you save the email message as a draft to send 
later. If you are working from a draft email, please copy any message contents and attachments to a 
new message using the Send for Review method described above.



The examples provided in this section use Microsoft Outlook and Microsoft Word 2013. Depending on your 
version of Microsoft Office, certain menu actions and elements of the user interface may be in different 
locations. Apttus functionality remains the same regardless of Office version.
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Click the Connect icon and log in to the organization with the agreement record that contains the document(s) 
being reviewed.

Under the Home tab, click New Email or find the email message originally sent by the Send for Review 
requester and click Reply. (In this example, we are using a new email message.)
In the To... field add the negotiator or review owner as recipient and any others as desired.
Enter an appropriate Subject for the email.
Click Attach File in the Include section of the message and attach the reviewed document to the email 
message. You message should look something like the following.

The check box "Check in the attached document to its agreement record as a reviewer's version" is enabled 
be default. Deselect the checkbox to send the response without checking it in.(Note: if you do not enable the 
check box at this time, the negotiator or contract admin can check the document in on behalf of you using X-
Author Contracts).
(Optional) Click Add Comments to open the add comments dialog. 
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11.

Enter your comments (cannot exceed 255 characters) for the draft and click Add Comment. A preview of your 
comments are shown in the Message tab.  

Click Send to send the email response and return the reviewed document. X-Author Contracts for Outlook 
checks in the agreement document (provided it has the valid properties) to the agreement record as a new 
Reviewer (revision) version: e.g., 1.0.1. Any comments you added in Steps 8 – 9 are recorded in the 
Document Version details of the agreement record.
Repeat steps 3 - 10 for each tracked agreement document assigned to you for review. (Note: Each document 
to be reviewed and returned by the reviewer should be submitted as an attachment to its own individual email 
message for the close cycle / check-in feature to work properly).

Tracking and Managing Review Cycles
You can easily track review cycles from X-Author Contracts for Word while agreement documents are out for review. 
As a negotiator, you have full control over each Review cycle and its sub-cycles (each separate combination of review 
recipient and document). You have the option to close only selected cycles, or to close all cycles and end 
negotiations. You can also close a cycle and check-in agreement documents as reviewer versions on behalf of 
internal or external reviewers.

For more information on which documents are "tracked" during a Send for Review, refer to Tracking 
and Managing Review Cycles.
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There are two main ways to track and manage review cycles in X-Author: Track Review Status and Check-In. Both are 
described in detail in the following sections.

Track Review Status
Tracking review status in X-Author works based on document context. That is, the Track Review Status action is only 
available if the currently opened document has been sent for review, and is, therefore, part of a Review Cycle. The 
open document can be generated or checked out–the only prerequisite is that it must have already been sent for 
review.

To track review cycle status for the current document:
Click Track Review Status from the Review section of the X-Author Contracts tab. The Review Cycle status 
window is displayed.
The Review Cycle Status screen displays the most current Review Cycle, comprised of individual cycles 
representing each recipient/document combination which is still out for review. The main purpose of this 
screen is to give the contract negotiator a tool to view a snapshot of the review process at any point in time 
and to give the negotiator the means to close cycles if it is deemed necessary.
To switch between Review Cycles, use the drop-down menu above the table on the far right of the screen. 
Each Send Cycle represents a separate Send for Review action taken by the negotiator. Additional Send 
Cycles beyond the first are often created when one or more documents are sent out for a subsequent round of 
reviews. If the document(s) have only been sent for review a single time, there will be only one Send Cycle.

NOTE

The role of "negotiator" is not set by X-Author Contracts and should not be considered a restriction for 
tracking review cycles. Any user who has permission to edit the agreement record and agreement 
documents associated with the record can potentially track and manage a Send for Review. You can 
manage this in Salesforce by applying proper security settings and sharing rules for users connecting to your 
org through X-Author Contracts.
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To close only certain cycles, click the check box next to each cycle you want to close and click Close 
Selected Cycles. Cycle Time Status for these cycles changes to "Closed"–the documents will no longer be 
tracked for the selected recipient(s).
 To close ALL cycles, click the check box at the top of the table to select all and click Close Selected Cycles. 
All cycles that are included in this Send Cycle are now closed. Click Cancel to exit back to your Word 
document. You can now continue to work with the agreement or click Send for Review to begin a new Review 
Cycle with new recipients.

Manage Review Cycles at Check-In
For any given document that has been sent for review, there are three possible outcomes which result in the 
document being checked in to Apttus Contract Management:

an internal reviewer attaches the document to an email in Outlook and selects the option to check in the 
document (see Responding to a Send for Review request from Outlook)
an internal or external reviewer attaches the document to an email sent to the contract negotiator. The 
negotiator checks in the document as that reviewer's version (revision) on their behalf.

Closing Cycles from Track Review Status
When a negotiator closes one or more cycles, this only means that tracking of the individual recipient/
document combination is closed. This does not necessarily mean that contract negotiation or the review has 
come to an end. All it means is that one or more cycles will no longer be tracked by the system. Internal 
reviewers can still check in any of these documents from Outlook as part of the review process, and 
document versions can still be checked out, redlined, and checked back in until the agreement is finalized. 
Tracking of Review Cycles in this manner gives visibility to the negotiator and the ability to close cycles in a 
timely fashion. If you want to close cycles and check in a new document version, refer to the steps in the 
next section instead.





X-Author Contracts on Salesforce Winter 2019 User Guide

241 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

•

1.
2.
3.

4.

an internal or external reviewer attaches the document to an email sent to the contract negotiator. The 
negotiator checks in the document as a negotiator (minor) version.

Once one or more contract documents have been sent as replies by reviewers, the negotiator can check them in 
using X-Author.

To manage review cycles and check in a reviewed document:
Save the document attached in email by the reviewer to your local drive (or other offline location).
Open the document in Word and log in to X-Author Contracts.
Review feedback and changes in the document and click Check-In. The Check-In Document screen is 
displayed.

Select a check box under Review Cycle Recipient / Closure and appropriate Check-In options (if available) 
and click Finish to complete Check-In of the document. Consult the following table to decide which Review 
Cycle options work best for your situation.
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Action Recipient Description Closed Cycle Document 
Version

Recipient 
unknown; check-
in as Negotiator

Unknown, 
external 
reviewer.

Choose this option if you 
have received the document 
but are not certain which 
reviewer sent the reply. Or 
choose this option if you 
received the document from 
an external reviewer but 
would like to check in as 
Negotiator.

None. Negotiator 
(minor). e.g., 
"1.1.0"
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Action Recipient Description Closed Cycle Document 
Version

someone@exam
ple.com

Internal or 
external 
reviewer.

Choose this option if you 
intend to check in the 
document on behalf of a 
reviewer. This option is best 
for any of the following 
situations:

- An internal reviewer has 
been absent for an extended 
period of time or is not 
planning to check-in as a 
reviewer.

- An internal reviewer was 
unable to use Outlook to 
check-in the document.

- An external reviewer has 
reviewed the document and 
sent it as an attachment 
back to the negotiator.

Cycle for the 
specific reviewer/
document 
combination.

Reviewer 
(revision). e.g., 
"1.0.1"

Check-In options 
are disabled when 
a specific reviewer 
is chosen under 
Review Cycle 
Recipient / 
Closure. All check-
ins on behalf of 
reviewers will be 
checked in as 
Redlined versions 
in the same 
document format.
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Action Recipient Description Closed Cycle Document 
Version

Close all open 
cycles

Any Choose this option to 
check-in the document as a 
negotiator and close all 
open cycles. This option 
may be best if you need to 
initiate a new send for 
review with the same or 
additional recipients, you no 
longer need any further 
reviewer versions, or if you 
do not have time to wait for 
the remaining reviewers to 
respond.

All cycles. Negotiator 
(minor). e.g., 
"1.1.0"

Cycle Status at Agreement Activation

When an agreement is activated, all open Review Cycles are automatically closed. Reviewers will no longer be able 
to check-in documents using Outlook and negotiators can no longer manage existing cycles (Merge Event Details 
and Document Version information is still accessible on the agreement record).

Tracking Reviews on the Agreement Record
You can track individual Review Cycles through the Merge Event Details object (child object of Merge Event) on the 
agreement record. To view information on Out for Review and Complete Review Cycles, drill down to the Merge 
Event Details through the Review action link, located in the Merge Event related list. You can also review Document 
Version information for any document that is part of a Review Cycle.

Pre-requisites
To view merge events on actions taken on your agreement document ensure that Publish Merge Events field is 
selected in the Comply System Properties in Contract Management. 

For more details on how to set Publish Merge Events setting, refer to Comply System Properties in Contract 
Management Administrator Guide.

If you do not see the Review Cycle options on the Check-In Document screen it means that you do not have 
a cycle-tracked document open in Word. A document that has been sent for review is assigned certain 
properties that identify it as part of a review cycle. Make sure you have the correct version of a tracked 
document open when intending to manage cycles at check-in.
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Example: Version Aware Agreement Document
Prior to Send for Review, the Merge Event related list might display the following merge events already taken 
on the agreement:

Next, you initiate a review of the main agreement document from X-Author Contracts, sending it to 2 
recipients. After sending, you refresh the agreement record and view the Merge Event list.

You can track status for all Review Cycles by clicking on the Review event link. The Merge Event Detail screen 
is displayed.

If you have more than one open Send cycle, click on the Review link containing the recipient/
document combinations (sub-cycles) you want to track.





X-Author Contracts on Salesforce Winter 2019 User Guide

246 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

4.
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The Merge Event Detail page displays information about the Review. Status indicates it is currently in-
progress. The Merge Event Details list contains a separate record for each individual review cycle (unique 
combination of recipient and document). Each review cycle displays the Reviewer Email and the Review Start 
Time.
Click the version number under Sent Version Detail to view the Document Version Details for the version of the 
agreement document under review. The Document Version Detail is displayed.

You can view information for the document being reviewed. The version 1.1.0 indicates that it is the first 
Negotiator (minor) version, checked in by you before being sent for review. 
One of the reviewers replies to your review request and you check-in the document on behalf of the reviewer. 
You return to the agreement record to track the review.
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7.
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The agreement has been checked in as a new Reviewer (revision) version 1.1.1. 
Click the Review link to view the update review cycle.

A Review End Time has been added, recorded when you checked in the document on behalf of the reviewer. 
Click Received Version Detail to view version information for the checked-in document.

You choose to close all remaining cycles at the next document check-in, rather than check the document in on 
behalf of the second reviewer. This creates a new Negotiator (minor) version of the document. The Merge 
Events related list is updated to reflect the Review as complete now that all review cycles are closed.

Click the Review link to drill down into Merge Event Details. Review End Time and Version Details information 
is displayed for all review cycles. View Document Versions and download attachments as needed.
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Sending Agreements for Parallel Review
You can send your agreement document for review to multiple persons simultaneously using Send for Review. Unlike 
the normal review process, the flow for parallel review is non-linear. This means that you don't have to wait for each 
reviewer to review and submit the document before the next reviewer can start reviewing. Multiple reviewers can 
simultaneously review and check-in the document, thus saving time. After each reviewer checks in the agreement 
document, the review comments are merged with the previous version of the document. You can search and add 
reviewers using your Salesforce Org's users, contact details, or email addresses, from X-Author Contracts. You 
cannot send a document for review more than once within the same review cycle.

To use the parallel review feature you must enable the parallel review setting from Comply System Properties in 
Contract Management. If the setting in not enabled, you can still use the existing review process using the Outlook 
email client.

Prerequisites

You must have at least one agreement document version generated or imported (Offline document) for the 
agreement record.

You must have set the Enable Document Versioning property to True in the comply system property of your 
Contract Management org.
You must have Version Aware field enabled on the agreement record.
You must have set the Parallel Review property to True in the comply system property of your Contract 
Management. For more details on how to configure the parallel review setting, refer to Comply System 
Properties topic in Contract Management on Salesforce Administrator Guide.
You must select the latest version of the document. If the selected agreement is an older version, you cannot 
send it for review.

Supporting documents cannot be sent for parallel review.
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To send an agreement document for review
Open your generated document in X-Author Contracts for Word or open Microsoft Word and navigate to the 
X-Author Contracts tab.
Click Check-Out > Currently Opened Document. 
OR
Alternatively, click Check-Out and follow the normal process for checking out a document from Contract 
Management. 
Click Send for Review from the Review section to request a review. This opens the Assign Reviewers page.

In the Assign Reviewers page, enter the following field values.

Field 
Name

Description

Reviewer 
Type

Select the Reviewer Type from the picklist: User, Email, and Contact.

Value of 
Reviewer 
Type

The value of this field depends on the Reviewer Type selected.
For User: Enter the user's name and click Search and select the user from the 
drop-down. You can also, click Search for the list of users and then select the 
user from the drop-down.
For Contact: Enter the contact name or email address and click Search. 
Select the contact from the drop-down. You can also, click Search for the list 
of contacts and then select the contact from the drop-down.
For Email: Type the email address.
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13.
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Field 
Name

Description

Name This field is only enabled if the review type selected is email. Enter a name for the reviewer.

Click Add to add the reviewer to the list.
In the Compose Message section, enter the Subject of the review email. This is a text field and you can use 
dynamic variable names to use the field values from the agreement record. For example, if you want to use the 
dynamic value of the document name field, you can write it as %DocumentName%.
Enter the body of the email in the Message field. You can edit the default text and compose your email 
message.
Click Next to grant the reviewers access to smart elements.
Reviewer Access Selection: This page allows you to set edit access to the smart elements for the reviewers. 
This page shows the smart elements present in your document in separate tabs for fields, clauses, and repeat-
table. You must select or clear a checkbox to allow or prevent a reviewer from accessing a particular smart 
element. This step is skipped if your document does not have any smart elements or if your document has 
Insert Comments or Read-only protection mode.

Click Next to preview reconciliation for smart clauses. This step is skipped if your document does not contain 
any modified smart clauses.
Click Next to preview reconciliation for smart fields. This step is skipped if your document does not contain 
any modified smart fields.
Click Next to preview reconciliation for repeat tables and repeat sections. This step is skipped if your 
document does not contain any modified repeat tables.
Click Finish to check-in the document and complete the review process.

Each reviewer receives a review request email with the agreement document in the attachment.

Checking in a Reviewed Document
As a reviewer, you can check-in your reviewed document from X-Author Contracts. When you open a reviewed 
document and click Check-In, the system identifies that the document is part of a review cycle. If you do not have X-
Author Contracts, you can email the reviewed document to the Contract Administrator and the administrator can 
check-in the reviewed document on your behalf. Checking in the in-review document ends the review cycle for you.

To check-in an in-review document
Download the agreement document from the review email attachment.



X-Author Contracts on Salesforce Winter 2019 User Guide

251 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

2.

3.

•

•

•

•
•
•

•
•
•
•

•

•

•

Open the document in Microsoft Word. You'll see a prompt to confirm that checking in will end the review for 
you, click OK to continue.
in X-Author Contracts, click Check-in and click OK in the confirmation prompt.

After the reviewed document is successfully checked in, the review cycle ends for the reviewer. The Activity History 
related list for the agreement document is updated with 'Review Ended'.

Tracking Parallel Review Status
Using Track Review Status you can track the review status of your documents that have been sent for parallel review. 
Track Review Status is a button on X-Author Contracts ribbon in Microsoft Word. Using this feature you can see the 
real-time review status in X-Author Contracts. The review status shows status changes for actions taken from both 
Contract Management application and X-Author Contracts application.

Prerequisites

To use this feature you must have Parallel Review setting enabled from Contract Management Comply System 
Properties.
You must have document versioning enabled for your Salesforce org from Contract Management.

When you click Track Review Status, you can see:

Review Cycle: This field shows the current review cycle name and the current review status with the details as 
described in the following list. One document can have multiple review cycles.

Initiated By: name of the user who initiated the current review cycle.
Initiated On: Start date of the review cycle.
Review Cycle End Date

For each review cycle you can see the following details:
Reviewer Email:  Email addresses of the reviewers.
Review Start date and Review End Date.
Review Status: Each cycle can have one of the following review statuses:

In Progress: When a document is sent for review it has 'In Progress' status. A review cycle stays 
in In Progress status until all the reviewers have responded to the review request.
Completed: When all the reviewers have reviewed and then checked in the document and the 
review cycle is ended, the review status updates to Completed. Then only the agreement can be 
processed for the next stage. 
Cancelled: When any one of the reviewers cancels the review cycle, the review status updates 
to cancelled. A cancelled review cycle cannot progress. You must start a new review cycle.

•

•

Guidelines for checking in the reviewed document

Currently, when you open the document for review directly from the email client, it opens in the read-
only mode and is not editable. As a workaround, you must first save the document in the email to your 
local machine and then open it in Microsoft Word. You can then review the document and check it in 
with your changes.
When you check-in a document after reviewing it, you may observe some delay in closing your review 
cycle. Contract Management may face some delay in updating the review status of your document in 
Document Versions Details related list, based on the size and volume of the document being 
reviewed. As a result, you may be able to check-in the same document multiple times. This is a 
product limitation and as a workaround, you can wait for some time to see the updated review status 
in Contract Management.
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Salesforce Chatter Integration
X-Author Contracts add-in integrates Salesforce Chatter within a Word document. You have the ability to either see 
the chatter feeds for the currently opened agreement document or view other user feeds. You can also share the 
highlighted content or agreement document via chatter. X-Author Contracts displays Chatter in a native Word task 
pane, providing the ability to have a side-by-side view of the agreement document and Chatter feed.

Prerequisite

You must have the latest X-Author Chatter package installed in your Salesforce org.
You must have an instance of System Properties created under X-Author Chatter package's Custom Settings. 
For more information on how to create X-Author System Properties, refer to Configuring System 
Properties topic of X-Author Chatter on Salesforce Integration Guide (Winter 2018 version or later).

To collaborate in Word using Chatter
Click Chatter from the X-Author Contracts tab. 
Chatter opens in its own window within Word and you may need to resize the document for optimal viewing.
Select who you want to collaborate with in your Chatter feed by clicking one of the icons:

Option Description

Your audience will be everyone in your organization with a Chatter account.

Your audience will be everyone who is following the object that the document is 
associated with. This option is only available when the document is associated 
with a Salesforce object, such as an Account or an Opportunity.

Your audience will be all the members of the group you select.

Your audience will be the single individual you select.

Make changes to the document using Word and then choose what content you want to collaborate on.

Option Description

None Enter a comment to solicit feedback, while not presenting any of the 
document in the feed.

Selected Content Select the content in the document you want to share in the feed. 
Only text will be included in the feed. If your content includes an 
image or other kinds of media, it will be represented with a '/' and 
table cell content is taken out of the table and included on individual 
lines.
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Option Description

Entire Document The whole document is attached to the Chatter feed entry and 
standard Chatter actions can be taken on the file.

Both Combination of Selected Content and Entire Document.

Click Share and the Chatter feed entry is added.
Click Refresh to ensure your feed is up to date and that you receive feedback from your colleagues.

If the highlighted content contains smart fields then, Author automatically detects the smart fields and 
includes the previous value and current change to each of the smart fields.
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Appendices

In This Section

X-Author Contracts Options
X-Author Contracts allows you to set your own preferences for working with the product. User preferences are stored 
locally on each client machine. You can access the options by clicking one of the Dialog Launchers from the Word 
ribbon. Options are split into following tabs: General, Template, Version, Chatter and Language.

The following list includes important information about the Options settings.

In the X-Author Contracts Options settings dialog box, selecting the check box for Template > Store 
Template / Clause Content as Text will insert text regardless of choosing this setting. This setting currently 
does not work for FX2 Templates.
In the X-Author Contracts Options settings dialog box, selecting the check box for Version > Use enhanced 
redlining capability will not work. This setting currently does not work for FX2 Templates.

General Tab
This tab is used for configuring proxy settings.

For more details, see To Enable X-Author Contracts Proxy Authentication.

Template Tab
The Template tab enables you to set preferences for the authoring of templates.

Show Mergefield errors when updating templates: When this option is deselected, any merge fields that generate 
errors while saving or updating a template are suppressed. Normally you would want to have this option selected so 
that the template designer is made aware of any merge field errors that occur when saving to the template.

Store Template/ Clause Content as Text: When this option is checked, the content of the template or clause will be 
updated to the Text Content field in the template record when you check-in a template or create a new one. This 
option should be selected, as the text that is displayed when you click the link for a template in Playbook comes from 
Text Content for that template record.

Default Image Size: This sets the default Height and Width for images placed in templates via RTF fields.
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Version Tab
The version tab enables you to capture preferences while saving agreement versions.

Use enhanced redlining capability: Select this if you want the Author to use enhanced redlining. Normally when you 
select a block of text and replace it with text pasted in from the clause library, the previous selection is marked as a 
deletion and the text pasted in as an insertion even though only a few words might have changed. Enhanced redlining 
is a feature that redlines what actually changed instead of marking all of the old text as a deletion and all of the new 
text as an insertion.

Chatter Tab
If you have installed chatter plugin, you can set chatter related preferences from this tab.
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Feed Refresh Duration: Select the chatter feed refresh duration from the picklist. If you want to refresh the feed 
manually, select Manual, otherwise select from the available time duration.

Language Tab
This tab is used for setting the language.

Choose Language: Select the language from the picklist that you want to set as default.

Troubleshooting Microsoft Word Integration Issues
This section provides solutions to frequently occurring Microsoft Word errors when using the X-Author Contracts 
Plugin.

I am getting an install error or login error, what should I do?

If system prerequisites are not met or validation checks fail, then one of the following messages may be displayed.

Message Reason Resolution

Admin privileges for installation

You need to be an Administrator to 
install X-Author...log out and log in 
as a System Administrator and run 
this setup.

The user trying to install X-Author 
does not have administrative 
privileges for the computer.

The user should log off of the 
computer and someone with 
Windows Administrator 
permissions should log in and 
restart the installation process.

An error has occurred in the script on this page

Invalid character.

- or -

The value of the property 'loader' is 
null or undefined, not a Function 
object.

URL: https://login.salesforce.com/...

The error is caused by Salesforce UI 
page issues.

Clear all of your Internet Explorer 
temporary files and cache.

Microsoft Office 2010 or above is required

Microsoft Word 2010 or later 
version is a prerequisite for installing 
this version of X-Author.

No version of Microsoft Word is 
detected on the target computer by 
the installer. The installation process 
stops at this stage.

A user with Windows Administrator 
permission must install the required 
version of Microsoft Word on the 
computer.

An instance of Microsoft Word is running

https://login.salesforce.com/
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Message Reason Resolution

An instance of Microsoft Word is 
currently running. Please save your 
work, and close the application 
before you proceed with this 
installation.

An instance of Microsoft Word is 
currently running while X-Author is 
being installed or uninstalled.

Close all instances of Microsoft 
Word and restart the halted 
process.

Error while uninstalling the pre-existing version of X-Author

There was a problem while 
uninstalling the pre-existing version 
of Apttus Author. Please uninstall the 
pre-existing version manually and try 
this setup again.

There is an error while trying to 
uninstall the pre-existing version, 
which may have occurred because 
the user clicked NO when the dialog 
was displayed.

User should click Yes when the 
UAC dialog is displayed. This 
would allow the pre-existing version 
of X-Author to be uninstalled.

I have installed X-Author Contracts but the add-in is missing in the Microsoft Word ribbon.

The X-Author Contracts and X-Author Templates ribbon tabs should always be available after you have successfully 
installed the Add-In. If there is an issue with their display, you must manually register the Add-In. If the tabs are still 
missing, check the following options.

To manage disabled add-ins
Open Microsoft Word and go to File > Options > Add-Ins.
Go to Manage> COM Add-ins and click Go.

In the COM Add-ins dialog, select Apttus X-Author Contracts Addin and select the checkbox to enable it.
Click OK.

Restart Microsoft Word, you should now see your add-in.

Another reason the X-Author Contracts Add-In may not work is if the Send to Bluetooth Add-In is enabled. If it is 
displayed in your Word ribbon, you must disable it.



X-Author Contracts on Salesforce Winter 2019 User Guide

259 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

1.
2.
3.
4.

To disable Send to Bluetooth Add-in
Open Microsoft Word and go to File > Options > Add-Ins.
Go to Manage> COM Add-ins and click Go.
Clear Send to Bluetooth checkbox and click OK.
Restart Microsoft Word.

My X-Author Contracts components are not installed.

While the installation of required components for X-Author should occur automatically if there is a question as to 
whether they have been installed successfully you can check the following registry settings. 

Note that one of the reasons the components could not be installed - or the X-Author installation may fail completely - 
is that your organization's IT policies may block access to Apttus servers used as part of the installation process. To 
confirm this, go to either http://pia.apttus.com and http://runtime.apttus.com. If you cannot access these sites you 
need to have them added to your organization's trusted sites.

Operating System Level Registry Entry

Microsoft .NET Framework 4.0 or higher

32 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ VSTO 
Runtime Setup \ v4R

64 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ VSTO 
Runtime Setup \ v4R

Microsoft Visual Studio 2010 Tools for Office Runtime

32 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ VSTO 
Runtime Setup

64 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Wow6432Node \ 
Microsoft \ VSTO Runtime Setup

Microsoft Office 2010 Primary Interop Assemblies

32 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Classes \ Installer \ 
Features \ 00004109501100000000000000F01FEC

64 Bit HKEY_LOCAL_MACHINE \ SOFTWARE \ Classes \ Installer \ 
Features \ 00004109501100000000000000F01FEC

http://pia.apttus.com/
http://runtime.apttus.com/
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1.
2.
3.

The forms and pages in my X-Author Contracts application appear clumsy and the components appear overlapped.

This issue may sometimes occur if you have not configured the correct DPI settings on your system. X-Author 
Contracts can be used with either 100% or 125% Windows text size, as long as you have the correct DPI 
settings. 100% text size requires 96 DPI and 125% text size requires 120 DPI.

To access this setting, go to the Windows Start menu and select Control Panel > Appearance and Personalization > 
Display > Make text and other items larger or smaller.

When I generate an agreement using a pre-FX2 template, I see 'Unknown switch' printed in my document.

While using pre-FX2 format template, you may face error while generating the agreement document. The reason for 
this error in the generated document is a merge field issue { REF _Ref238023765 \r \h \* MERGEFORMAT }.

Solution: Replace { REF _Ref238023765 \r \h \* MERGEFORMAT } with { REF _Ref238023765 \r \h }.

I want to install X-Author Contracts but my organizations's IT policies do not allow installing .exe files. I need a .msi 
installer file.

If you need an MSI package to install X-Author Contracts on your systems, refer to Extract MSI article in Codetwo 
Knowledge Base website.

I am encountering "disable X-Author Contracts add-in" error on Microsoft Word. How do I resolve it?

Sometimes Microsoft Word displays "disable X-Author Contracts add-in" error message as shown under.

Do not click Yes in this prompt as it will disable the X-Author Contracts add-in. If you have already clicked Yes and 
want to enable the X-Author Contracts add-in, refer to To manage disabled add-in topic.

When I click Check-in, Check-out, or try to open Playbook the pages do not load or load incorrectly.

If you have recently updated your Microsoft Office application or Microsoft Windows, some of the X-Author pages 
may not render properly. You can solve this problem by configuring the optimize compatibility setting in Microsoft 
Office. To configure this setting follow the steps given below:

Go to Microsoft Word > File > Options.
In Microsoft Word Options page, select General from the left-hand side navigation menu.
Under User Interface options, select Optimize for compatibility and click OK. You may need to restart 
Microsoft Word for the setting changes to take effect.

https://www.codetwo.com/kb/msi-from-exe/
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I have enabled Salesforce Files in Contract Management, but I cannot check-in my agreement in X-Author Contracts.

If you are using Salesforce Files system in your Contract Management org, you may encounter an error when you 
check-in your agreement in X-Author Contracts. This occurs if adequate user-based settings are not configured in X-
Author Contracts. To solve this problem, enable Salesforce CRM Content User setting for your users in your 
Salesforce org. This setting is present on the User Details page.

For more details on File System settings, refer to Comply System Properties topic in Contract Management on 
Salesforce Administrator Guide.

Uninstalling X-Author
Once installed you can uninstall X-Author either by using the installer executable or Windows uninstall programs.
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•

1.

2.
3.
4.

Prerequisites

All Microsoft Office applications should be closed.

To uninstall X-Author
Double-click the ApttusInstaller.exe, it will recognize X-Author is already installed and give you the option to 
uninstall.
Select Start and then select Control Panel.
Select Uninstall Program to display the programs list.
Right-click X-Author Contracts and click Uninstall.

X-Author is removed from your machine.

Enabling Proxy Authentication
If your work environment is behind a firewall and you need to configure proxy authentication to connect to Salesforce, 
you must complete the following.

X-Author Contracts proxy settings leverage Microsoft's LAN Settings to resolve proxy server settings automatically, 
each time you connect to X-Author Contracts. While this makes handling the majority of X-Author Contracts 
connections easier, you can still manually configure settings from the X-Author Contracts Options dialog box.

Selecting Use system proxy tells X-Author to use Microsoft's LAN Settings for resolving proxy connections. X-Author 
Contracts uses whichever Internet Explorer LAN option is configured, such as Use automatic configuration script or 
Proxy server settings.

Prerequisites
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•

1.
2.
3.

4.

You must be logged in X-Author Contracts.

To enable X-Author Contracts for proxy authentication
Open Microsoft Word and log in to X-Author Contracts.
From one of the X-Author Contracts tabs, click the Dialog Launcher icon   to display the Options dialog.
Select the General tab and then select one of the following:

Option Description

No proxy Select this is you do not use a proxy connection.

Use 
system 
proxy

This is the default option. This uses a Microsoft Internet Options setting (Internet Options > 
Connections > LAN Settings > Automatically detect settings) to determine if you are behind a 
proxy server. If so, it will automatically resolve the connection so that you can successfully login 
to X-Author and connect to your Salesforce org.

Manual 
proxy 
configura
tion

If you know the specific proxy you will be using, use this option. When you select this it enables 
the Proxy address to use and Port fields, along with the Authenticated checkbox, which 
requires a username and password as well.

Click Apply and then Close.

Your system proxy settings are now associated with X-Author Contracts and will take effect the next time you log in.

Time Zone Mapping
X-Author maps Salesforce time zones to Microsoft Windows time zones to ensure you can install and use X-Author 
Contracts as expected. If the Salesforce time zone does not map to a Microsoft equivalent, you must change it to one 
that does.

Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT+13:00 Phoenix Islands 
Time

Pacific/Enderbury Tonga Standard 
Time

(UTC+13:00) Nuku'alofa

GMT+13:00 Tonga Time Pacific/Tongatapu Tonga Standard 
Time

(UTC+13:00) Nuku'alofa

GMT+12:45 Chatham 
Standard Time

Pacific/Chatham    

GMT+12:00 Magadan Time Asia/Kamchatka Magadan Standard 
Time

(UTC+12:00) Magadan



X-Author Contracts on Salesforce Winter 2019 User Guide

264 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT+12:00 New Zealand 
Standard Time

Pacific/Auckland New Zealand 
Standard Time

(UTC+12:00) Auckland, 
Wellington

GMT+12:00 Fiji Time Pacific/Fiji Fiji Standard Time (UTC+12:00) Fiji

GMT+11:30 Norfolk Islands 
Time

Pacific/Norfolk    

GMT+11:00 Solomon 
Islands Time

Pacific/Guadalcanal Central Pacific 
Standard Time

(UTC+11:00) Solomon Is., New 
Caledonia

GMT+10:30 Lord Howe 
Standard Time

Australia/
Lord_Howe

   

GMT+10:00 Australian 
Eastern Standard Time

Australia/Brisbane E. Australia 
Standard Time

(UTC+10:00) Brisbane

GMT+10:00 Australian 
Eastern Standard Time

Australia/Sydney AUS Eastern 
Standard Time

(UTC+10:00) Canberra, 
Melbourne, Sydney

GMT+09:30 Australian 
Central Standard Time

Australia/Adelaide Cen. Australia 
Standard Time

(UTC+09:30) Adelaide

GMT+09:30 Australian 
Central Standard Time

Australia/Darwin AUS Central 
Standard Time

(UTC+09:30) Darwin

GMT+09:00 Korean 
Standard Time

Asia/Seoul Korea Standard 
Time

(UTC+09:00) Seoul

GMT+09:00 Japan Standard 
Time

Asia/Tokyo Tokyo Standard 
Time

(UTC+09:00) Osaka, Sapporo, 
Tokyo

GMT+08:00 Hong Kong 
Time

Asia/Hong_Kong China Standard 
Time

(UTC+08:00) Beijing, Chongqing, 
Hong Kong, Urumqi

GMT+08:00 Malaysia Time Asia/Kuala_Lumpur Singapore Standard 
Time

(UTC+08:00) Kuala Lumpur, 
Singapore

GMT+08:00 Singapore 
Standard Time

Asia/Singapore Singapore Standard 
Time

(UTC+08:00) Kuala Lumpur, 
Singapore

GMT+08:00 Philippine Time Asia/Manila North Asia East 
Standard Time

(UTC+09:00) Irkutsk
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Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT+08:00 China Standard 
Time

Asia/Shanghai China Standard 
Time

(UTC+08:00) Beijing, Chongqing, 
Hong Kong, Urumqi

GMT+08:00 Taipei Standard 
Time

Asia/Taipei Taipei Standard 
Time

(UTC+08:00) Taipei

GMT+08:00 Australian 
Western Standard Time

Australia/Perth W. Australia 
Standard Time

(UTC+08:00) Perth

GMT+07:00 Indochina Time Asia/Bangkok SE Asia Standard 
Time

(UTC+07:00) Bangkok, Hanoi, 
Jakarta

GMT+07:00 Western 
Indonesia Time

Asia/Jakarta SE Asia Standard 
Time

(UTC+07:00) Bangkok, Hanoi, 
Jakarta

GMT+07:00 Indochina Time Asia/Saigon SE Asia Standard 
Time

(UTC+07:00) Bangkok, Hanoi, 
Jakarta

GMT+06:30 Myanmar Time Asia/Rangoon Myanmar Standard 
Time

(UTC+06:30) Yangon (Rangoon)

GMT+06:00 Bangladesh 
Time

Asia/Dacca Bangladesh 
Standard Time

(UTC+06:00) Dhaka

GMT+06:00 Yekaterinburg 
Time

Asia/Yekaterinburg Ekaterinburg 
Standard Time

(UTC+06:00) Ekaterinburg

GMT+05:45 Nepal Time Asia/Katmandu Nepal Standard 
Time

(UTC+05:45) Kathmandu

GMT+05:30 India Standard 
Time

Asia/Calcutta India Standard Time (UTC+05:30) Chennai, Kolkata, 
Mumbai, New Delhi

GMT+05:30 India Standard 
Time

Asia/Colombo Sri Lanka Standard 
Time

(UTC+05:30) Sri Jayawardenepura

GMT+05:00 Pakistan Time Asia/Karachi Pakistan Standard 
Time

(UTC+05:00) Islamabad, Karachi

GMT+05:00 Uzbekistan Time Asia/Tashkent West Asia Standard 
Time

(UTC+05:00) Tashkent

GMT+04:30 Afghanistan 
Time

Asia/Kabul Afghanistan 
Standard Time

(UTC+04:30) Kabul

GMT+04:30 Iran Daylight 
Time

Asia/Tehran Iran Standard Time (UTC+03:30) Tehran
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Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT+04:00 Gulf Standard 
Time

Asia/Dubai Arabian Standard 
Time

(UTC+04:00) Abu Dhabi, Muscat

GMT+04:00 Georgia Time Asia/Tbilisi Georgian Standard 
Time

(UTC+04:00) Tbilisi

GMT+04:00 Moscow 
Standard Time

Europe/Moscow Russian Standard 
Time

(UTC+04:00) Moscow, St. 
Petersburg, Volgograd

GMT+03:00 East Africa Time Africa/Nairobi E. Africa Standard 
Time

(UTC+03:00) Nairobi

GMT+03:00 Arabian 
Standard Time

Asia/Baghdad Arabic Standard 
Time

(UTC+03:00) Baghdad

GMT+03:00 Israel Daylight 
Time

Asia/Jerusalem Israel Standard Time (UTC+02:00) Jerusalem

GMT+03:00 Arabian 
Standard Time

Asia/Kuwait Arab Standard Time (UTC+03:00) Kuwait, Riyadh

GMT+03:00 Arabian 
Standard Time

Asia/Riyadh Arab Standard Time (UTC+03:00) Kuwait, Riyadh

GMT+03:00 Eastern 
European Summer Time

Europe/Athens E. Europe Standard 
Time

(UTC+02:00) E. Europe

GMT+03:00 Eastern 
European Summer Time

Europe/Bucharest E. Europe Standard 
Time

(UTC+02:00) E. Europe

GMT+03:00 Eastern 
European Summer Time

Europe/Helsinki FLE Standard Time (UTC+02:00) Helsinki, Kyiv, Riga, 
Sofia, Tallinn, Vilnius

GMT+03:00 Eastern 
European Summer Time

Europe/Istanbul Turkey Standard 
Time

(UTC+02:00) Istanbul

GMT+03:00 Further-Eastern 
European Time

Europe/Minsk Kaliningrad Standard 
Time

(UTC+03:00) Kaliningrad, Minsk

GMT+02:00 Eastern 
European Time

Africa/Cairo Egypt Standard 
Time

(UTC+02:00) Cairo

GMT+02:00 South Africa 
Standard Time

Africa/Johannesburg South Africa 
Standard Time

(UTC+02:00) Harare, Pretoria
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Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT+02:00 Central 
European Summer Time

Europe/Amsterdam W. Europe Standard 
Time

(UTC+01:00) Amsterdam, Berlin, 
Bern, Rome, Stockholm, Vienna

GMT+02:00 Central 
European Summer Time

Europe/Berlin W. Europe Standard 
Time

(UTC+01:00) Amsterdam, Berlin, 
Bern, Rome, Stockholm, Vienna

GMT+02:00 Central 
European Summer Time

Europe/Brussels Romance Standard 
Time

(UTC+01:00) Brussels, 
Copenhagen, Madrid, Paris

GMT+02:00 Central 
European Summer Time

Europe/Paris Romance Standard 
Time

(UTC+01:00) Brussels, 
Copenhagen, Madrid, Paris

GMT+02:00 Central 
European Summer Time

Europe/Prague Central Europe 
Standard Time

(UTC+01:00) Belgrade, Bratislava, 
Budapest, Ljubljana, Prague

GMT+02:00 Central 
European Summer Time

Europe/Rome W. Europe Standard 
Time

(UTC+01:00) Amsterdam, Berlin, 
Bern, Rome, Stockholm, Vienna

GMT+01:00 Central 
European Time

Africa/Algiers    

GMT+01:00 Irish Summer 
Time

Europe/Dublin GMT Standard Time (UTC) Dublin, Edinburgh, Lisbon, 
London

GMT+01:00 Western 
European Summer Time

Europe/Lisbon GMT Standard Time (UTC) Dublin, Edinburgh, Lisbon, 
London

GMT+01:00 British Summer 
Time

Europe/London GMT Standard Time (UTC) Dublin, Edinburgh, Lisbon, 
London

GMT+00:00 Greenwich MeanTime (GMT GMT Standard Time (UTC) Dublin, Edinburgh, Lisbon, 
London

GMT-01:00 Cape Verde 
Time

Atlantic/
Cape_Verde

Cape Verde 
Standard Time

(UTC-01:00) Cape Verde Is.

GMT-02:00 South Georgia 
Time

Atlantic/
South_Georgia

Mid-Atlantic 
Standard Time

(UTC-02:00) Mid-Atlantic

GMT-02:30 Newfoundland 
Daylight Time

America/St_Johns Newfoundland 
Standard Time

(UTC-03:30) Newfoundland

GMT-03:00 Argentina Time America/
Buenos_Aires

Argentina Standard 
Time

(UTC-03:00) Buenos Aires

GMT-03:00 Atlantic Daylight 
Time

America/Halifax Atlantic Standard 
Time

(UTC-04:00) Atlantic Time 
(Canada)
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Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT-03:00 Brasilia Time America/Sao_Paulo E. South America 
Standard Time

(UTC-03:00) Brasilia

GMT-03:00 Atlantic Daylight 
Time

Atlantic/Bermuda Atlantic Standard 
Time

(UTC-04:00) Atlantic Time 
(Canada)

GMT-04:00 Eastern Daylight 
Time

America/
Indianapolis

Eastern Standard 
Time

(UTC-05:00) Eastern Time (US & 
Canada)

GMT-04:00 Eastern Daylight 
Time

America/New_York Eastern Standard 
Time

(UTC-05:00) Eastern Time (US & 
Canada)

GMT-04:00 Atlantic 
Standard Time

America/
Puerto_Rico

SA Western 
Standard Time

(UTC-04:00) Georgetown, La Paz, 
Manaus, San Juan

GMT-04:00 Chile Time America/Santiago Pacific SA Standard 
Time

(UTC-04:00) Santiago

GMT-04:30 Venezuela Time America/Caracas Venezuela Standard 
Time

(UTC-04:30) Caracas

GMT-05:00 Colombia Time America/Bogota SA Pacific Standard 
Time

(UTC-05:00) Bogota, Lima, Quito

GMT-05:00 Central Daylight 
Time

America/Chicago Central America 
Standard Time

(UTC-06:00) Central America

GMT-05:00 Peru Time America/Lima SA Pacific Standard 
Time

(UTC-05:00) Bogota, Lima, Quito

GMT-05:00 Central Daylight 
Time

America/
Mexico_City

Central America 
Standard Time

(UTC-06:00) Central America

GMT-05:00 Eastern 
Standard Time

America/Panama US Eastern 
Standard Time

(UTC-05:00) Indiana (East)

GMT-06:00 Mountain 
Daylight Time

America/Denver US Mountain 
Standard Time

(UTC-07:00) Arizona

GMT-06:00 Central Standard 
Time

America/
El_Salvador

Central America 
Standard Time

(UTC-06:00) Central America

GMT-07:00 Pacific Daylight 
Time

America/
Los_Angeles

Pacific Standard 
Time

(UTC-08:00) Pacific Time (US & 
Canada)
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Salesforce Microsoft Windows

  Salesforce Time 
Zone Key

Windows Time 
Zone Key

 

GMT-07:00 Mountain 
Standard Time

America/Phoenix US Mountain 
Standard Time

(UTC-07:00) Arizona

GMT-07:00 Pacific Daylight 
Time

America/Tijuana Pacific Standard 
Time

(UTC-08:00) Pacific Time (US & 
Canada)

GMT-08:00 Alaska Daylight 
Time

America/Anchorage Alaskan Standard 
Time

(UTC-09:00) Alaska

GMT-10:00 Hawaii-Aleutian 
Standard Time

Pacific/Honolulu Hawaiian Standard 
Time

(UTC-10:00) Hawaii

GMT-11:00 Niue Time Pacific/Niue Samoa Standard 
Time

(UTC+13:00) Samoa

GMT-11:00 Samoa Standard 
Time

Pacific/Pago_Pago Samoa Standard 
Time

(UTC+13:00) Samoa

List of Apttus Supported Locales and Associated Formatting
This page lists all locales supported by Apttus for the purposes of defining locale format in your templates. The 
following table presents for each Locale value, the corresponding set of formats of the Currency fields and Number/
Percent fields, and defaults for precision values and date formats. 

Locale Currency 
Format

Number/
Percent 
Format 

Default 
Currency 
Precision

Default 
Number/
Percent 
Precision

Default Date 
Format

English (US) X,XXX.XX X,XXX.XX 2 0 M/dd/yyyy

English (UK) X,XXX.XX X,XXX.XX 2 0 dd/mm/yyyy

English 
(Canada)

X,XXX.XX X,XXX.XX 2 0 dd/mm/yyyy

English 
(Ireland)

X,XXX.XX X,XXX.XX 2 0 dd/mm/yyyy

Italian X.XXX,XX X.XXX,XX 5 0 dd/mm/yyyy
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Locale Currency 
Format

Number/
Percent 
Format 

Default 
Currency 
Precision

Default 
Number/
Percent 
Precision

Default Date 
Format

German X.XXX,XX X.XXX,XX 5 0 dd.mm.yyyy

Chinese X,XXX.XX X,XXX.XX 2 0 yyyy-M-dd

Japanese X,XXX.XX X,XXX.XX 2 0 yyyy/mm/dd

Korean X,XXX.XX X,XXX.XX 2 0 yyyy. M. dd

Thai X,XXX.XX X,XXX.XX 2 0 dd/M/yyyy **(+543 
to the year value)

Norwegian X XXX,XX X XXX,XX 0 0 dd.mm.yyyy

Swedish X.XXX,XX X XXX,XX 0 0 yyyy-mm-dd

Russian X XXX,XX X XXX,XX 0 0 dd.mm.yyyy

Portuguese X.XXX,XX X.XXX,XX 5 0 dd/mm/yyyy

Polish X XXX,XX X XXX,XX 5 0 dd.mm.yyyy

Greek 
(Greece)

X.XXX,XX X.XXX,XX 5 0 dd/M/yyyy

Spanish X.XXX,XX X.XXX,XX 2 0 dd/mm/yyyy 

Formatting standard of negative values for Number and Percent data type fields is same across all locale-dependent 
formats and it is defined as:

Negative values are preceded by minus sign, immediately followed by the value formatted according to the locale 
setting. E.g., -1,000.0
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Currency ISO Codes and Symbol
In X-Author Contracts, Currency ISO codes and Symbols for the supported currencies are not controlled by Locale 
value. Whenever a user will select 'ISO Code' or 'Symbol' as the value of 'Currency Format' property of a template or 
field level attribute, the system will prefix the corresponding value at runtime.

For Multi-Currency Orgs- Currency values in the generated documents are values of the business object record, 
currency. The following table represents the ISO Codes/ Symbols associated with the currency of the business 
object record:

Currency of the Business Object 
Record

Currency ISO Code Currency Symbol

USD USD $

GBP  GBP  £ 

CAD CAD $

EUR EUR €

CNY CNY ¥

JPY JPY ¥

KRW KRW ₩

THB THB ฿

NOK NOK kr

SEK SEK kr

RUB RUB ₽

BRL BRL R$

PLN PLN zł
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For Single Currency Org- In the single currency org, resolved currency values can be populated with just one symbol 
or ISO code, dependent on the Currency Locale setting of the org. The following table lists the ISO Codes/Symbols 
associated with the org-wide setting:

Currency Locale Setting of the Org Currency ISO Code Currency Symbol

English (United States)- USD USD $

English (United Kingdom)- GBP GBP £

English (Canada)- CAD CAD $

English (Ireland)- EUR EUR €

Italian (Italy)- EUR EUR €

German (Germany)- EUR EUR €

Chinese (China)- CNY CNY ¥

Japanese (Japan)- JPY JPY ¥

Korean (South Korea)- KRW KRW ₩

Thai (Thailand)- THB THB ฿

Norwegian (Norway)- NOK NOK kr

Swedish (Sweden)- SEK SEK kr

Russian (Russia)- RUB RUB ₽

Portuguese (Brazil)- BRL BRL R$

Polish (Poland)- PLN PLN zł

Greek (Greece)- EUR EUR €

Spanish (Spain)- EUR EUR €

Formatting Standard of Currency Values
The formatting standard for positive and negative currency values is the same across all types of business objects, 
and across all locale-dependent formats of the values. 
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Formatting of Positive Currency Value

Use Case: If a user enters the currency value of 100, the following table shows how the currency value shall be 
displayed according to the currency format selected.

Currency Format Formatting Description Formatting Example of 
Positive Currency Value

Symbol  For symbol currency format, Value will be 
displayed as Symbol prefix immediately 
followed by the value.

£100.00

ISO Code For ISO Code currency format, Positive 
currency value will be resolved into the 
documents with ISO code prefix followed by 
space and then value.

EUR 100.00

Formatting of Negative Currency Value

Use Case: If a user enters the currency value of 100, the following table shows how the currency value shall be 
displayed according to the currency format selected.

Currency Format Formatting Description Formatting Example of 
Negative Currency Value

Symbol For symbol currency format, Value will be 
displayed as Symbol prefix immediately followed 
by the value surrounded by parenthesis.

£(100.00)

ISO Code For ISO Code currency format, negative 
currency value will be resolved into the 
documents with ISO code prefix followed by 
space and then value surrounded by 
parenthesis.

EUR (100.00)

Converting Pre-FX2 Templates to FX2 Format
The purpose of this appendix is to provide you with manual instructions for converting your Pre-FX2 format (Merge 
format) agreement templates to the new FX2 format. There is no automated solution to convert your templates at this 
time.

This guide is designed in a manner which allows you to tackle the conversion process one step at a time by 
addressing the different elements of an agreement template. The following elements are required when converting a 
template to the new FX2 format:
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•
•
•
•
•

All clause references must be replaced by FX2 format clauses.
All merge fields must be replaced by FX2 format fields.
All Pre-FX2 sections and tables must be replaced with FX2 format sections and tables.
Smartness must be reapplied to fields and clauses as required.
Conditional content must be reviewed, removed and defined for FX2 format.

Using a Bottom-Up Approach to Conversion
Because agreement template design often involves a lot of conditionality and clauses nested within clauses, it is 
recommended to approach the conversion process using a "bottom-up" method. In many cases, you are not only 
converting a single agreement template to the new format, but several clause templates as well. Your Pre-FX2 format 
agreement template may contain clause references which refer to clause templates in your system. These clause 
templates may then have more clause references, and so on, until you reach a clause template which does not 
contain any references. These final nested clause references may still contain merge fields, tables and sections, 
which also need to be converted. Consider the following representative diagram of a typical agreement template 
structure.

This conversion guide provides the minimum guidance necessary to complete template conversion to the 
FX2 format. Please follow links in the document to guide content for information on working with FX2 
template features.
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1.
2.

a.
b.
c.
d.

3.
4.
5.

1.

2.

All clauses marked in red must be converted to FX2 format first, then the templates (clause or agreement) which 
contain them can be converted, and so on until you reach the main agreement template. Because of this, a bottom-up 
approach is required in most cases. You need to assess your agreement template and make all changes furthest out 
from the template before making changes to references inside the agreement template document itself.

FX2 Format Conversion Steps
Follow the steps below to successfully convert your Pre-FX2 format templates to the new FX2 format.

Prepare Your Agreement Template for Conversion.
Convert Clause References in the agreement template.

Convert Merge Fields in the clause template to FX2 format.
Convert Clause References in the clause template to FX2 format.
Convert Tables and Sections in the clause template to FX2 format.
Convert Conditional Tables in the clause template (as needed).

Convert Merge Fields in the agreement template to FX2 format.
Convert Tables and Sections in the agreement template to FX2 format.
Convert Conditional Tables (as needed).

Prepare Your Pre-FX2 Template for Conversion
Two methods are provided for preparing your agreement template document for conversion to the new FX2 format.
 Method 1 is recommended for most cases, as it allows you to rebuild the template "from scratch." Method 2 is 
slightly more advanced, and should be used in cases where Method 1 may not be ideal.

Method 1: Copy the Text of Your Template to a New Document
This method allows you to begin the conversion process by building your agreement template "from scratch." This 
method gives your business or legal departments an opportunity to review the document in its entirety and mark up 
any recent changes and/or conditionality which needs to be incorporated into the template prior to conversion.

To begin, open Microsoft Word and Connect to X-Author. You must be connected to an org with Apttus 
Contract Management 8.0 or later installed (a version which supports FX2 format).
 Click New from the X-Author Templates ribbon. The Template Attributes dialog is displayed.

The instructions provided in this section also apply to any clause templates referred to from your agreement 
template.
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3.

4.
5.

6.
7.

Choose FX2 Format, the appropriate template type (Agreement or Clause) and Business Object (Agreement). 
Click OK.
Open your Pre-FX2 format template in a separate window. 
Select-all text in your Pre-FX2 template (including merge fields, clause references, tables, etc.) and Copy it 
into the new blank template document. It is recommended to paste as text and apply formatting in subsequent 
steps.

 Re-apply formatting to your template, including font size, face and paragraph styles as required.
Click Check-in from the X-Author Templates ribbon to complete the check-in of your new FX2 format template.
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1.
a.
b.
c.

2.
3.
4.

Method 2: Remove Pre-FX2 Template Properties and Create New FX-2 Template
You may choose to use this method if your template contains a lot of visuals or other properties built in which don't 
transfer well using the copy-paste method described above. Rather than creating a new document from scratch, you 
will convert the existing template document directly. Because your Pre-FX2 template document has properties 
associated with Salesforce objects, field and clause references that identify it as being in a particular format. These 
properties must be stripped to convert the template to FX-2 format.

To begin, check out your agreement template in X-Author:
Click Connect to log in to the correct org.
Click Check-Out.
Search for your template and click Open to check out the document.
 

Click File to go to the Microsoft Word Info page (select the Info section if it is not already displayed).
Click on the Properties drop-down located in the far-right column of the page.
Choose Advanced Properties > Custom. The list of document properties is displayed.
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5.

6.
7.

Delete all values under Properties and click Ok.

Click on the X-Author Templates tab to return to your template. 
Click New under the Templates section to use your existing template to create a new FX2 format template.

Stripping your Pre-FX2 template of its properties will not affect the template in your environment as 
long as you do not check it back in after stripping the properties.
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8.
9.

10.
11.

Choose Yes to make your template FX2 format, confirm Type and Business Object and click OK.
Click Check-in under the Templates section to check in your new FX2 format template.

Enter a name for your template, an Agreement type to associate it with, and all remaining fields.
Click Check-In to complete the check-in of your new FX2 format template.



X-Author Contracts on Salesforce Winter 2019 User Guide

280 Copyright ©2011-2020 Apttus Corporation. All rights reserved.

1.

Convert Clause References to FX2 Format
FX2 format does not include any clause references. Instead, clauses are inserted as inline text inside "segments." 

You must convert all clause references into FX2 format clauses. Always convert nested clause references first (clause 
references within clauses). See the diagram on the overview page for details.

Converting clause reference that contain conditions is a bit more complex–the procedure for converting conditional 
clause references is covered later on this page.

To convert clause references to FX2 format
You must have at least one clause reference in the agreement or clause template you are working with AND the 
agreement or clause template must have already been checked in (you cannot insert clauses from Playbook unless 
your template has been previously saved).

Highlight the clause reference you want to replace. Note the name of the clause in the merge code.

If your agreement happens to be 100% text, this is the bare minimum you need to convert your agreement to 
FX-2 Format. If your agreement contains Apttus fields, clauses, sections or tables, move to the next section 
in this document to continue the conversion process.



•

•

•

Consider three important steps prior to converting any clause reference:

If there are any existing fields, tables or sections inside the clause, you must first convert those fields, 
tables or sections as described in Convert Merge Fields to FX2 Format and Convert Tables and 
Sections before you check in the clause template.
If the clause itself contains any clause references, you must convert those clauses first. Check out 
nested clause references, convert them as described on this page and check them in, converting any 
fields contained inside the nested clauses as well.
Remember when you are inserting clauses from Playbook, you must first check-in the destination 
template (agreement or clause).
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2.
3.

4.

Click Check-out. You will be checking out the existing clause template for the clause you highlighted.
Click Show Filter and change the filter to Type=Clause. Search for the clause template name in the Checkout 
dialog. 

Click Open to open the clause template.
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5.

6.

7.
8.
9.

10.

11.

Use one of two methods to prepare your clause template for conversion (by copying and pasting Pre-FX2 
clause contents into a new document or stripping properties from the current template) See Prepare Your Pre-
FX2 Template for Conversion for instructions.
Check if there are any clause references in the checked out template. If there are, repeat Steps 1-5 for the 
referenced clause.
Click Check-in to check in the new clause so you can replace your Pre-FX2 clause reference in your template.
Choose a new name for your clause in the Check-in Template dialog. (e.g. "1 Governing Law - CA Migrated"). 
Click Check-in. The new FX2 format clause can now be used in your template.

Return to your agreement template. Make sure the clause reference you want to replace is still highlighted. 
Click on Playbook.
Search for the new clause you created and click Insert to replace the clause reference with a new segment 
containing your FX2 clause contents.

Note that only FX2 clauses which match the business object of your template will be available when 
you search in Playbook.
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12.

1.

2.

Repeat steps 1 – 12 for all clause references in your template.

To convert a conditional clause
The process for converting a conditional clause is nearly identical to converting a clause reference without conditions. 
To properly convert a conditional clause reference, you must replace the clause with an FX2 version and reapply any 
conditions the previous clause used.

Follow 1 – 11 from the previous section to create a new FX2 version of your clause. Do not highlight the 
existing conditional clause reference.
On a new line directly under the conditional clause reference, Insert the new clause into your template from 
Playbook.
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3.

•
•

•

4.

5.
6.

Make note of the conditions built into the existing clause reference. In a clause reference there are three basic 
parts that comprise the condition:

Between the IF and the first set of quotes is the condition (e.g. "Total Contract Value > 1")
Content between the first set of quotes is generated if the condition resolves to TRUE. (e.g. Clause 
Reference inserted into document).
Content between the second set of quotes is generated if the condition resolves to FALSE.

To understand how to interpret complex clause conditionality from Pre-FX2, please refer to Using Conditional 
Clauses and Text.

Make your FX2 clause conditional using the instructions provided in Set Segment Menu in X-Author 
Templates.
Delete the merge code for the Pre-FX2 conditional clause reference.
Repeat steps 1 – 5 for all conditional clauses in your agreement template.

Convert Merge Fields to FX2 Format
You must convert Pre-FX2 fields into FX2 format fields. The process is slightly different for smart fields versus regular 
fields.

FX2 format does not support the FALSE or "Else" calculation for conditional clauses. Separate 
conditional clauses must be created to cover all conditions.



You will know a field is smart if the Merge code contains the "INTELLIGENT" string.
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1.
2.

3.

To convert fields to FX2 format
You must have at least one merge field in your template document or clause template.

Check-out your new FX2 template if it is not checked out already.
Highlight the entire merge field (brackets and all text between). Note the field name defined by the "label=" 
parameter in the code. When you replace the merge field with an FX2 field you will need to choose this field 
name.

Click Insert Fields in the Intelligent Document section of the X-Author Templates ribbon.
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4.

5.

6.

Search for the same field as defined by the merge code (you made note of this label earlier). Highlight the field 
in the list.
Click Finish. The inserted field replaces the merge code you highlighted in the document.

Repeat steps 2 – 5 for all non-smart merge fields.
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7.

8.

1.

To convert an INTELLIGENT merge field into an FX2 smart field, follow the same instructions as above then 
refer to Inserting Smart Fields into a Template to make the field smart.
Repeat steps 7 – 8 for all smart merge fields in the document.

Convert Tables and Sections
Tables and Sections in your agreement document must also be converted to FX2 format. 

To convert a Table to FX2 Format
In the example we are using below, a Products Table has been inserted as part of a Pre-FX2 clause. The clause has 
been checked out and its properties have been stripped. As you can see in the following image, second-level merge 
fields have been inserted into the table as merge code.

 To replace the same table in FX2, we need to insert the same fields as a repeating table. Note the individual fields 
between the "MERGEFIELD start" and "MERGEFIELD end" tags. These are the fields you will be inserting.

To begin, place your cursor below the Pre-FX2 table and click Insert Fields.

Often Tables and Sections will be stored as clauses, rather than existing directly in templates. In these 
circumstances, you should Check Out the clause ahead of time and prepare your clause template for 
conversion as described in Prepare Your Pre-FX2 Template for Conversion. You can then follow the 
procedures on this page to convert to FX2 format.
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2.

3.
4.
5.

Locate the fields you want to populate the table. Hold Ctrl to multi-select all fields, being sure to select them in 
the order you want them displayed in the table (left-to-right). 

Select the checkbox under Options to Insert as a table.
Click Finish to insert the new table into your document or clause template.
Mark fields as smart by following the instructions provided in Inserting Smart Fields in a Template.
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6.

1.

Delete the Pre-FX2 table.

To convert a Section to FX2 Format
Sections, like tables are designed to hold fields with a second-level (child) relationship to the parent object and often 
third-level (grandchild) object fields stored as tables within the section. Because a section is designed to repeat, 
multiple instances of the same fields are populated when the document is generated. Like tables and fields, sections 
exist in a template differently in FX2 format.

Place your cursor in the document where you would like to insert the new section and click Insert Field.

Also remember that if the section is stored separately from the agreement template as a clause, you must 
first prepare the clause template for conversion using the procedure described in Prepare Your Pre-FX2 
Template for Conversion.
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2.
3.

4.

Choose any second-level field and select the checkbox under Options to Insert as a section.
Click Finish to insert the new section into your template.

Click on the Field header at the top of the section. Use the right arrow on your keyboard to highlight the
 Repeat header and click Enter on your keyboard twice to expand the section.
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5.

6.

7.

Remove the field if necessary by clicking on the field and Delete on your keyboard (make sure you have 
selected the Field and not the Repeat section!). You can now copy-and-paste any static text content between 
of your Pre-FX2 section into the new section (Pre-FX2 section is between the "MERGEFIELD...section_start" 
and "MERGEFIELD...section_end" tags).   
Use the instructions provided in Inserting Fields in a Template to insert any second and third-level fields into 
the section, including tables. The following image shows an example of the original Pre-FX2 section containing 
a table and a replacement FX2 section containing the same table in FX2 format.

Delete the Pre-FX2 section.
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8.

1.

2.
3.

If you have successfully converted all fields, clauses, table and sections, you are finished! Check in your 
converted FX2 format template. If you have more to convert, revisit any of the sections in this guide to 
complete the process. For help with converting sections containing filters/conditions for tables, please refer 
to Convert Conditional Tables.

Converting Conditional Tables
Conditional tables are an element that were introduced with the FX2 format. Previously, Apttus tables (Generated 
using insert mergefields in Pre-FX2) could only have one filter (condition) applied to them. As a workaround, you may 
have created a Word generated table inside of a repeating section so that multiple filters could be applied to the 
table. In FX2, Apttus generated tables can handle multiple filters. Apttus tables are easier to maintain and it is 
considered a best practice to use them over Word generated tables nested inside of a repeating section, where 
possible.

To understand how to interpret complex clause conditionality from Pre-FX2, please refer to Using Conditional 
Clauses and Text.

To convert Conditional Tables to FX2 format
Follow the instructions to Convert Tables to FX2 format. Make sure your new tables contain all fields you want 
to populate under any and all given conditions.
Open the Control Panel under X-Author Templates.
Right-click on the table that you want to make conditional and choose Edit condition.
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4.

5.

6.

In FX2 format, you can define one or more conditions for each column in a table. Choose the column from the 
drop-down list of fields to make conditionally shown and create an expression to show the column when the 
expression resolves to true.

Repeat the process for additional columns by choosing Add Row and add filter logic as needed. Click Next to 
proceed.
On the next screen, create one or more expressions to make table rows conditional as needed. 

Note: You can also edit the condition of a table by clicking on the box next to Conditional Expression 
in the Properties panel and selecting a choice from the drop-down list that appears.
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7.
8.
9.

Click Finish.
Delete any Pre-FX2 tables from your template.
Check-in your template tom complete the conversion process.
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